Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.1 to 7.52 on UNIX: IBM Db2 for Linux, UNIX, and Windows

Database: IBM Db2 for Linux, UNIX, and Windows
Operating System: UNIX/Linux
# Content

## 1 About this Document

1.1 Naming Conventions .......................................................... 14  
1.2 Constraints ................................................................. 15  
1.3 Before You Start ............................................................ 16  
1.4 SAP Notes for the Installation ......................................... 17  
1.5 New Features .............................................................. 19  

## 2 Installation Options Covered by this Guide

2.1 Standard System ............................................................ 29  
2.2 Distributed System ......................................................... 30  
2.3 High-Availability System .................................................. 31  
2.4 Additional Application Server Instance ............................... 33  
2.5 Splitting off an ABAP Central Services Instance from an Existing Primary Application Server Instance ........................................... 36  
2.6 ASCS Instance with Integrated SAP Web Dispatcher ................. 37  
2.7 ASCS Instance with Integrated Gateway ............................... 39  
2.8 SAP Host Agent as a Separate Installation ............................ 40  

## 3 Planning

3.1 Planning Checklist .......................................................... 43  
3.2 Changed File System Structure and Profiles for SAP Systems Based on SAP NetWeaver 7.1 and Higher .................................................. 44  
3.3 Installation Using a Stack Configuration File ......................... 45  
3.4 Hardware and Software Requirements ................................. 47  

Running the Prerequisites Check in Standalone Mode (Optional) .................................................. 48  
Requirements for the SAP System Hosts .................................. 49  
3.5 Planning User and Access Management ............................... 61  
3.6 Basic Installation Parameters ............................................ 63  

SAP System Parameters ...................................................... 64  
SAP System Database Parameters ......................................... 74  
Additional Parameters when Installing SAP Process Integration 7.5 or SAP Solution Manager 7.2 .................................................. 79  
Additional Parameters When Using a Stack Configuration File (Optional) .................................. 80  
Parameters for Additional Components to be Included in the ASCS Instance (Optional) .................... 82  
3.7 Setup of Database Layout .................................................. 83  

Required File Systems for IBM Db2 for Linux, UNIX, and Windows .................................................. 83  
Users and Groups ............................................................. 87  
Directory Structure of the Db2 Client Connectivity ....................... 88
Connecting the System to SAP Solution Manager........................................174
Applying the Latest Kernel and Support Package Stacks..............................176
Performing Post-Installation Steps for the ABAP Application Server..............177
Systems Based on SAP NetWeaver AS for ABAP 7.52 only: Switching to Standalone Enqueue Server 2 and Enqueue Replicator 2..................................................180
SAP Solution Manager 7.2, SAP Process Integration 7.5 only: Enabling HTTPS Communication for ABAP.................................................................181
Installing Additional Languages and Performing Language Transport...........182
SAP Kernel 7.40 and Higher: IP Multicast Configuration and Wake-Up Mechanism..............................................................183
PI 7.5 Only: Configuring the Process Integration System After the Installation.....184
Configuring the User Management...............................................................185
Ensuring User Security..............................................................................186
Performing the Client Copy........................................................................190
SAP Systems Based on SAP NetWeaver 7.4 and Higher: Changing Keys for the Secure Storage .................................................................191
Enabling the Database for Monitoring..........................................................193
Enabling Recoverability of the IBM Db2 for Linux, UNIX, and Windows Database.........................................................................................194
Performing a Full Installation Backup............................................................195
Checking the Database Parameters for IBM Db2 for Linux, UNIX, and Windows.................................................................197
Logging on to the SAP Web Dispatcher Management Console....................198
SAP Web Dispatcher Configuration (Optional)...............................................200
Gateway Configuration (Optional)................................................................201
Integration of LDAP Directory Services.......................................................203
Installation of Multiple Components in One Database..................................208
MCOD Tablespaces, File Systems, and Connect Users....................................210
Creating a User for LDAP Directory Access................................................212
Exporting and Mounting Directories via NFS................................................213
Exporting and Mounting Directories via NFS for AIX....................................213
Exporting and Mounting Directories via NFS for HP-UX................................214
Exporting and Mounting Directories via NFS for Linux................................215
Exporting and Mounting Directories via NFS for Oracle Solaris....................217
Heterogeneous SAP System Installation.......................................................218
Installing the SAP Host Agent Separately....................................................219
Creating Tablespaces Manually (Optional)..................................................222
Adding Database Partitions to a Database Instance.....................................223
Splitting Off an ABAP Central Services Instance from an Existing Primary Application Server Instance..........................................................225
Installing a Near-Line Storage Database for an SAP Business Warehouse......228
Starting and Stopping SAP System Instances.............................................229
Starting and Stopping SAP System Instances Using the SAP Management Console.................................................................229
Content
Starting and Stopping SAP System Instances Using Commands. ................................................ 233
7.13 Minimizing the Database Size After the Installation. ......................................................... 235
7.14 Deleting an SAP System or Single Instances. ................................................................. 237
7.15 Deleting a Database Instance, the Database Software, or a Database Schema Manually. .... 240
  Deleting the Database and the Db2 Instance Manually. ..................................................... 240
  Deleting the Db2 Software Installation Manually. ............................................................ 242
  Deleting a Database Schema Manually. ............................................................................ 242
A Appendix. ...................................................................................................................... 245
  A.1 Online Information from SAP. ...................................................................................... 245
  A.2 Online Information from IBM. ...................................................................................... 245
  A.3 Disclaimer: Links to IBM Documentation. ................................................................. 246
Document History

i Note
Before you start reading, make sure you have the latest version of this installation guide, which is available at https://support.sap.com/sitoolset ➔ System Provisioning ➔ Install a System using Software Provisioning Manager ➔ Installation Option of Software Provisioning Manager 1.0 SP <Current Number> 3.

The following table provides an overview of the most important document changes:

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.0</td>
<td>2018-09-17</td>
<td>Updated version for software provisioning manager 1.0 SP24 (SL Toolset 1.0 SP24)</td>
</tr>
<tr>
<td>2.9</td>
<td>2018-05-07</td>
<td>Updated version for software provisioning manager 1.0 SP23 (SL Toolset 1.0 SP23)</td>
</tr>
</tbody>
</table>

- **New Features:**
  - New Installer Option
    
    Download Media for a Maintenance Plan, documented in: New Features, Downloading the Media for a Maintenance Planner Transaction
  - Validity Check for SUM*.SAR Archive, documented in: New Features, Additional Parameters When Using a Stack Configuration File (Optional)

- Information “enqueue server” versus “enqueue server 2”, “enqueue replication server” versus “enqueue replication server 2” added: High-Availability System, System Based on SAP NetWeaver AS for ABAP 7.52 only: Switching to Enqueue Server 2 and Enqueue Replication Server 2
Updated version for software provisioning manager 1.0 SP22 (SL Toolset 1.0 SP22)

- New Features:
  - Signature check for installation archives, documented in: New Features, Downloading SAP Kernel Archives (Archive-Based Installation) Archive-Based Installation for Diagnostics Agent, Downloading the SAP Kernel Archives Required for the Dual-Stack Split (Without Operating System and Database Migration), Downloading the SAP Kernel Archives Required for Operating System and Database Migration
  - Installer Log Files Improvements, documented in: New Features, Useful Information about the Installer, Troubleshooting with the Installer
  - Secure ABAP message server connection, documented in: New Features, SAP System Parameters
  - Enabling IPv6, documented in: New Features, Prerequisites for Running the Installer

- New Features section restructured: As of SP22, a dedicated subsection for each new SP has been created. New features below SP22 remain in a common table.

- The Java SDT GUI - which was in the SP21 version still available in parallel to the SL Common GUI - has been deprecated with SP22. As of SP22, SL Common GUI is the only available installer GUI:
  - The following sections which were explicitly related to Java SDT GUI were completely removed from this documenta-
Performing a Remote Installation Remote Processing of the Installer (Java SDT GUI only), Starting the Java SDT GUI Separately, Running the Installer in Accessibility Mode (general accessibility information was moved to Useful Information About the Installer).

- The Java SDT GUI-specific information was removed from the common installer sections: Running the Installer, Useful Information About the Installer, Interrupted Processing of the Installer, Troubleshooting with the Installer, Deleting an SAP System or Single Instances

- New section Using the Step State Editor (SAP Support Experts Only) was added to section Additional Information About the Installer
Updated version for software provisioning manager 1.0 SP21 (SL Toolset 1.0 SP21)

- New Features:
  - Media Signature Check, documented in: New Features, Running the Installer, Preparing the Installation Media.
  - This feature implies that section Creating Kernel Archives from an Existing SAP System has been deleted from this documentation because the related option in the installer had to be removed.
  - Download Media for a Maintenance Plan, documented in: New Features, Downloading Media for a Maintenance Plan
  - SAP Host Agent Upgrade, documented in: New Features, SAP System Parameters, Downloading SAP Kernel Archives (Archive-Based Installation)
  - Load tools are now available as LOADTOOLS.SAR in the Software Provisioning Manager archive, documented in: New Features, Downloading and Extracting the Software Provisioning Manager Archive
  - Simplified additional application server instance installation, documented in: New Features, Preparing the Installation Media, Downloading SAP Kernel Archives (Archive-Based Installation)
<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.6</td>
<td>2017-05-22</td>
<td>Updated version for software provisioning manager 1.0 SP20 (SL Toolset 1.0 SP20)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New Features:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ New SAPUI5-based graphical user interface (GUI) “SL Common GUI”, documented in:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Prerequisites for Running the Installer, Running the Installer, Useful Information About</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the Installer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Option for choosing to install an integrated SAP Gateway during the ASCS instance</td>
</tr>
<tr>
<td></td>
<td></td>
<td>installation, documented in: Installation Options Covered by this Guide, SAP System</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Parameters, Parameters for Additional Components to be Included in the ASCS Instance,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Post-Installation Checklist, SAP Gateway Configuration</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ Cleanup of operating system users, documented in: SAP System Parameters, Creating</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Operating System Users and Groups</td>
</tr>
<tr>
<td>2.5.1</td>
<td>2017-03-02</td>
<td>Updated version</td>
</tr>
<tr>
<td>2.5</td>
<td>2017-02-07</td>
<td>Updated version for software provisioning manager 1.0 SP19 (SL Toolset 1.0 SP19)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• New Features:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Verification of the integrity of data units in Software Provisioning Manager, documented</td>
</tr>
<tr>
<td></td>
<td></td>
<td>in: New Features, Downloading the Software Provisioning Manager Archive</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Archive-based Language Installation, documented in: Additional Parameters When Using a Stack</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Configuration File</td>
</tr>
<tr>
<td>Version</td>
<td>Date</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>2.4</td>
<td>2016-10-10</td>
<td>Updated version for software provisioning manager 1.0 SP18 (SL Toolset 1.0 SP18)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- New Features:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Option to choose installing an integrated SAP Web Dispatcher during the ASCS instance installation, documented in: <a href="#">ASCS Instance with Integrated SAP Web Dispatcher</a>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Using RMOSSWPM*.SAR instead of SWPM*.SAR for outdated OS versions not supported by SAP kernel 7.40 and higher, documented in: <a href="#">Introduction</a>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- New dialogs for tablespace pools for IBM Db2 for Linux, UNIX, and Windows</td>
</tr>
<tr>
<td>2.3</td>
<td>2016-06-06</td>
<td>Updated version</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- New Features:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;Archive-Based Installation&quot;, documented in:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ <a href="#">New Features</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td>○ <a href="#">Preparing the Installation Media</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Downloading Specific Installation Archives (Archive-Based Installation)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Database-specific new features: Re-designed dialogs for tablespace storage management and layout (sapdata and saptmp directories) For more information, see <a href="#">New Features</a>.</td>
</tr>
<tr>
<td>2.2</td>
<td>2016-02-15</td>
<td>Updated version</td>
</tr>
<tr>
<td>2.1</td>
<td>2015-10-12</td>
<td>Updated version</td>
</tr>
<tr>
<td>2.0</td>
<td>2015-09-14</td>
<td>Updated version</td>
</tr>
</tbody>
</table>
Instead of a separate installation guide for each UNIX-based operating system, we now deliver a single installation guide for all UNIX-based operating systems. Sections that are only relevant for one or more specific operating systems are highlighted accordingly.
1 About this Document

This installation guide describes how to install an SAP system based on the application server ABAP of SAP NetWeaver 7.1 to 7.52 using the installation tool Software Provisioning Manager 1.0 SP24 (“installer” for short), which is part of SL Toolset 1.0 SP24.

**i Note**

As an alternative to using Software Provisioning Manager, you can install your system with a completely automated end-to-end framework available using SAP Landscape Management. For more information, see SAP Note 1709155 and https://help.sap.com/lama.

This guide is valid for the operating systems AIX, HP-UX, Linux, and Solaris, and covers the SAP system products and releases listed in SAP Note 1680045.

For information about supported operating system and database platforms for the SAP product you want to install, see the Product Availability Matrix at http://support.sap.com/pam.

**Caution**

Make sure you have read Before You Start [page 16] before you continue with this installation guide.

- **Naming Conventions [page 14]**
  This section lists the naming conventions that are currently apply for Software Provisioning Manager 1.0 (the “installer”) and terms used in this documentation.

- **Constraints [page 15]**
  This section lists the naming constraints that are currently valid for Software Provisioning Manager 1.0 (the “installer”) and this documentation.

- **Before You Start [page 16]**
  Make sure that you have read the release-specific “Master Guide” for your SAP Business Suite application, SAP NetWeaver application, or SAP Solution Manager system before you continue with this installation guide.

- **SAP Notes for the Installation [page 17]**
  This section lists the most important SAP Notes relevant for an installation using Software Provisioning Manager.

- **New Features [page 19]**
  This section provides an overview of the new features in Software Provisioning Manager 1.0 (the “installer” for short).
1.1 Naming Conventions

This section lists the naming conventions that are currently apply for Software Provisioning Manager 1.0 (the “installer”) and terms used in this documentation.

- Software Provisioning Manager 1.0 is the successor of the product- and release-specific delivery of provisioning tools, such as “SAPinst”.
  Before you perform an installation from scratch or a target system installation in the context of a system copy, we strongly recommend that you always download the latest version of the Software Provisioning Manager 1.0 which is part of the Software Logistics Toolset 1.0 (“SL Toolset” for short). For more information, see Preparing the Installation Media [page 118].
  This way, you automatically get the latest version with the latest fixes of the tool and supported processes. For more information about Software Provisioning Manager 1.0 as well as products and releases supported by it, see SAP Note 1680045 and https://wiki.scn.sap.com/wiki/display/SL/Software+Provisioning+Manager+1.0.
  “SAPinst” has been renamed to “Software Provisioning Manager” (“installer” for short) in this documentation, but the terms “SAPinst” and “sapinst” are still used:
  ○ The name of the technical framework of Software Provisioning Manager. For more information about the SAPinst Framework, see SAP Note 2393060.
  ○ Texts and screen elements in the Software Provisioning Manager GUI
  ○ Names of executables, for example sapinst
  ○ Names of command line parameters, for example SAPINST_STACK_XML
  ○ Names of operating system user groups, such as the additional group sapinst
- “usage type”, “technical usage”, and “product instance”
  As of Software Provisioning Manager 1.0 SP07 (SL Toolset 1.0 SP12), the term “product instance” replaces the terms “usage type” and “technical usage” for SAP systems based on SAP NetWeaver 7.3 including enhancement package 1 and higher. For more information, see SAP Note 1970349. Note that there is no terminology change for older releases and all mentioned terms can be used as synonyms. As this guide is a generic document, the currently used terms remain but only “product instance” is used from now on when referring to SAP NetWeaver 7.3 EHP1 and higher. For more information, see New Features [page 19].
- “installer” refers to “Software Provisioning Manager”.
- “SAP system” refers to SAP system based on the application server of SAP NetWeaver Mobile / Banking 7.1 / 7.1 including Enhancement Package 1 / SAP NetWeaver 7.3 / 7.3 including Enhancement Package 1 / Application Server ABAP 7.4 / SAP NetWeaver 7.4 / SAP NetWeaver 7.5 / SAP NetWeaver Application Server for ABAP 7.51 innovation package / SAP NetWeaver Application Server for ABAP 7.52.
- “ABAP system” refers to SAP system based on the application server ABAP of SAP NetWeaver Mobile / Banking 7.1 / 7.1 including Enhancement Package 1 / SAP NetWeaver 7.3 / 7.3 including Enhancement Package 1 / Application Server ABAP 7.4 / SAP NetWeaver 7.4 / SAP NetWeaver 7.4 / 7.4 SR1.
- “Diagnostics Agent” refers to the SAP Solution Manager Diagnostics Agent which is the remote component of End-to-End Root Cause Analysis. It allows having a connection between SAP Solution Manager and managed systems, and then to collect information from the managed systems for reporting purposes.
- IBM Product Terminology
The following abbreviations are used in this guide:

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Refers to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Db2 V9.7</td>
<td>Version 9.7 for IBM Db2 for Linux, UNIX, and Windows</td>
</tr>
<tr>
<td>Db2 10.1</td>
<td>Version 10.1 for IBM Db2 for Linux, UNIX, and Windows</td>
</tr>
<tr>
<td>Db2 10.5</td>
<td>Version 10.5 for IBM Db2 for Linux, UNIX, and Windows</td>
</tr>
<tr>
<td>Db2 11.1</td>
<td>Version 11.1 for IBM Db2 for Linux, UNIX, and Windows</td>
</tr>
</tbody>
</table>

1.2 Constraints

This section lists the naming constraints that are currently valid for Software Provisioning Manager 1.0 (the “installer”) and this documentation.

- The Dual Stack option, which integrates an AS ABAP and AS Java in a single system (common System ID <SAPSID>, common startup framework, common database), is no longer supported in SAP systems based on SAP NetWeaver 7.5. So if you want to install a new SAP NetWeaver 7.5 Process Integration (PI) system which is based on SAP NetWeaver 7.5, do not use the documentation Installation Guide - SAP Systems Based on the Application Server ABAP+Java of SAP NetWeaver on <OS>: <DB>. Instead, use the Installation Guide - SAP Systems Based on the Application Server ABAP of SAP NetWeaver on <OS>: <DB> to install the ABAP stack with its own <SAPSID> and the Installation Guide - SAP Systems Based on the Application Server Java of SAP NetWeaver on <OS>: <DB> to install the Java stack with its own <SAPSID>. For more information, see the implementation sequence in the Master Guide - SAP NetWeaver 7.5 at http://help.sap.com/netweaver<Release> Installation and Upgrade.

- Not all SAP NetWeaver releases or SAP Business Suite applications that are available in Software Provisioning Manager 1.0 and are described in this installation guide have already been released. Always check SAP Note 1680045 to ensure that the installation options you want to perform are already supported. For information about supported operating system and database platforms, see the Product Availability Matrix at http://support.sap.com/pam.

- Note that a complete system installation from scratch is not available for every product. For some products - such as SAP NetWeaver 7.4 - a complete new system installation from scratch is only provided for the highest support release. If there are one or more support releases, then a complete system installation is only available for the highest of these support releases. As for the lower support releases, only options for system copy and additional application server instances are provided.

- Your operating system platform must be 64-bit.

- The startsap and stopsap commands have been deprecated. For more information and for information on alternatives, see Starting and Stopping SAP System Instances Using Commands [page 233].

- Client 066 is no longer available in newly installed SAP systems based on SAP NetWeaver 7.5 or higher. For more information, see SAP Note 1749142.
1.3 Before You Start

Make sure that you have read the release-specific “Master Guide” for your SAP Business Suite application, SAP NetWeaver application, or SAP Solution Manager system before you continue with this installation guide.

The “Master Guide” is the central document leading you through the overall implementation process for your SAP system installation. It contains crucial information about the overall implementation sequence, that is activities you have to perform before and after the installation process described in this installation guide.

You can find a printed version of this guide in your installation package or you can download the latest version from https://help.sap.com.

The following table lists the “Master Guide” of the SAP system application for which you can use this installation guide, along with the available quick link or path to the appropriate download location:

<table>
<thead>
<tr>
<th>Document</th>
<th>Internet Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Guide SAP Supply Chain Management 7.0 (Including SAP Enhancement Package &lt;Number&gt; Powered by SAP NetWeaver)</td>
<td><a href="http://help.sap.com/scm">http://help.sap.com/scm</a></td>
</tr>
<tr>
<td>Master Guide (Including Upgrade Information) - SAP Customer Relationship Management 7.0 (Including SAP Enhancement Package &lt;Number&gt;)</td>
<td><a href="http://help.sap.com/crm">http://help.sap.com/crm</a></td>
</tr>
<tr>
<td>Master Guide (Including Upgrade Information) - SAP Supplier Relationship Management 7.0 (Including SAP Enhancement Package &lt;Number&gt;)</td>
<td><a href="http://help.sap.com/srm">http://help.sap.com/srm</a></td>
</tr>
</tbody>
</table>
1.4 SAP Notes for the Installation

This section lists the most important SAP Notes relevant for an installation using Software Provisioning Manager.

You must read the following SAP Notes before you start the installation. These SAP Notes contain the most recent information on the installation, as well as corrections to the installation documentation.

Make sure that you have the up-to-date version of each SAP Note, which you can find at https://support.sap.com/notes.

SAP Notes for the Installation

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1680045</td>
<td>Release Note for Software Provisioning Manager 1.0</td>
<td>Software Provisioning Manager 1.0 with installation and system copy for SAP NetWeaver-based systems</td>
</tr>
<tr>
<td>2378874</td>
<td>Install SAP Solutions on Linux on IBM Power Systems (little endian)</td>
<td>Information about how to install SAP solutions on Linux on IBM Power Systems (little endian)</td>
</tr>
<tr>
<td>1707361</td>
<td>Inst. Systems Based on SAP NetWeaver 7.1 and Higher: UNIX IBM Db2</td>
<td>Db2-specific information about the SAP system installation and corrections to this documentation (IBM Db2 for Linux, UNIX, and Windows)</td>
</tr>
<tr>
<td>SAP Note Number</td>
<td>Title</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>101809</td>
<td>DB6: Supported Versions and Fix Pack Levels</td>
<td>Provides information about the currently released database and Fix Pack combinations</td>
</tr>
<tr>
<td>702175</td>
<td>DB6: Support of Db2 DPF and Db2 pureScale</td>
<td>Platform-specific additional information about the support of multiple partitions with IBM Db2 for Linux, UNIX, and Windows and about Db2 pureScale</td>
</tr>
<tr>
<td>73606</td>
<td>Supported Languages and Code Pages</td>
<td>Information on possible languages and language combinations in SAP systems</td>
</tr>
<tr>
<td>1972803</td>
<td>SAP on AIX: Recommendations</td>
<td>This SAP Note contains recommendations and clarifications for many topics relevant for SAP on AIX.</td>
</tr>
<tr>
<td>1075118</td>
<td>SAP on HP-UX: FAQ</td>
<td>This SAP Note contains information that is specific to the SAP system installation on HP-UX</td>
</tr>
<tr>
<td>2369190</td>
<td>SAP Software on Linux: General information</td>
<td>This SAP Note contains Linux-specific information about the SAP system installation</td>
</tr>
<tr>
<td>1669648</td>
<td>SAP on Oracle Solaris 11</td>
<td>This SAP Note contains information and references to SAP Notes relevant for Solaris 11</td>
</tr>
<tr>
<td>1067221</td>
<td>Composite SAP Note for heterogeneous installation</td>
<td>This SAP Note and its related SAP Notes describe the released operating system and database combinations for heterogeneous SAP systems landscapes.</td>
</tr>
<tr>
<td>7892207</td>
<td>Support Package levels for SAP NetWeaver installations/upgrades</td>
<td>Information about the ABAP Support Package levels and kernel patch levels contained in the current SAP NetWeaver release</td>
</tr>
<tr>
<td>8197222</td>
<td>Support Package levels for SRM installations/upgrades</td>
<td>Information about the ABAP Support Package levels and kernel patch levels contained in the current SAP SRM release</td>
</tr>
<tr>
<td>774615</td>
<td>Support Package levels of ERP/ECC installations/upgrades</td>
<td>Information about the ABAP Support Package levels and kernel patch levels contained in the current SAP ERP release</td>
</tr>
<tr>
<td>8374313</td>
<td>Support Package levels for CRM installations/upgrades</td>
<td>Information about the ABAP Support Package levels and kernel patch levels contained in the current SAP CRM release</td>
</tr>
<tr>
<td>850038</td>
<td>Support Package levels for SCM/APO installations/upgrades</td>
<td>Information about the ABAP Support Package levels and kernel patch levels contained in the current SAP SCM release</td>
</tr>
</tbody>
</table>
1.5 New Features

This section provides an overview of the new features in Software Provisioning Manager 1.0 (the “installer” for short).


<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Installer Option Download Software Packages for Maintenance Planner Transaction</td>
<td>If you perform an installation using a stack configuration file, you can now download media according to a Maintenance Plan. For more information, see Installation Using a Stack Configuration File [page 45], Downloading Software Packages for a Maintenance Planner Transaction [page 128], and <a href="https://blogs.sap.com/2018/06/01/software-provisioning-manager-new-option-for-standalone-download-service/">https://blogs.sap.com/2018/06/01/software-provisioning-manager-new-option-for-standalone-download-service/</a>.</td>
<td>Software Provisioning Manager 1.0 SP23 (SL Toolset 1.0 SP23)</td>
</tr>
<tr>
<td>Validity Check for SUM*.SAR Archive</td>
<td>If you perform an installation using a stack configuration file and choose to extract the SUM*.SAR archive, the validity of this archive is now checked by the installer. For more information, see Extract the SUM*.SAR Archive in Additional Parameters When Using a Stack Configuration File (Optional) [page 80].</td>
<td>Software Provisioning Manager 1.0 SP23 (SL Toolset 1.0 SP23)</td>
</tr>
<tr>
<td>Secure ABAP Message Server Connection</td>
<td>The installer now uses secure connections to the ABAP message server of the SAP system being installed. For more information, see the ABAP Message Server Port entry within the Ports table in SAP System Parameters [page 64].</td>
<td>Software Provisioning Manager 1.0 SP22 (SL Toolset 1.0 SP22)</td>
</tr>
<tr>
<td>Installer Log Files Improvements</td>
<td>Installer log files are now available immediately after the installer has started, that is before a product has been selected on the Welcome screen. For more information, see Useful Information about the Installer [page 154] and Troubleshooting with the Installer [page 160].</td>
<td>Software Provisioning Manager 1.0 SP22 (SL Toolset 1.0 SP22)</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Availability</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Signature Check of Installation Archives</td>
<td>The signature of installation archives is checked automatically by the installer during the Define Parameters phase while processing the Software Package Browser screens. As of now the installer only accepts archives whose signature has been checked. For more information, see Downloading SAP Kernel Archives (Archive-Based Installation) [page 125].</td>
<td>Software Provisioning Manager 1.0 SP22 (SL Toolset 1.0 SP22)</td>
</tr>
<tr>
<td>LOADTOOLS.SAR archive in Software Provisioning Manager enabled for NUC</td>
<td>The load tools in SWPM10SP&lt;Support_Package_Number&gt;_&lt;Version_Number&gt;_SAR are now also enabled for an installation using non-Unicode (NUC) SAP kernel version 7.40 or higher. For more information, see Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 123].</td>
<td>Software Provisioning Manager 1.0 SP22 (SL Toolset 1.0 SP22)</td>
</tr>
<tr>
<td>Enabling IPv6</td>
<td>You can now set up a new SAP system or SAP system instance using Internet Protocol Version 6 (IPv6).</td>
<td>Software Provisioning Manager 1.0 SP22 (SL Toolset 1.0 SP22)</td>
</tr>
<tr>
<td>Media Signature Check</td>
<td>The signature of media is checked automatically by the installer during the Define Parameters phase while processing the Media Browser screens. As of now the installer only accepts media whose signature has been checked. See also the description of this new security feature in SAP Note 2393060. For more information, see Preparing the Installation Media [page 118] and Running the Installer [page 147].</td>
<td>Software Provisioning Manager 1.0 SP21 (SL Toolset 1.0 SP21)</td>
</tr>
<tr>
<td>SAP Host Agent Upgrade During the Installation (Optional)</td>
<td>During the Define Parameters phase of the installation, the installer prompts you whether you want to upgrade an existing version of the SAP Host Agent on the installation host. If there is no SAP Host Agent on the installation host, it is installed automatically without prompt. For more information, see the General Parameters table in SAP System Parameters [page 64].</td>
<td>Software Provisioning Manager 1.0 SP21 (SL Toolset 1.0 SP21)</td>
</tr>
<tr>
<td>Simplified Additional Application Server Instance Installation</td>
<td>During an additional application server installation, SAP kernel archives are only prompted if they cannot be retrieved from the primary application server instance of the existing SAP system. For more information, see Preparing the Installation Media [page 118].</td>
<td>Software Provisioning Manager 1.0 SP21 (SL Toolset 1.0 SP21)</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Availability</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>LOADTOOLS.SAR archive in Software Provisioning Manager</td>
<td>An up-to-date version of the load tools - such as R3load, R3szchk, R3ldctl, SAPuptool - which were available so far only in the SAPEXEDB.SAR archive of the kernel media, has now been made available in the Software Provisioning Manager archive. For an installation using Unicode kernel version 7.40 or higher, the load tools from the SWPM10SP&lt;Support_Package_Number&gt;_&lt;Version_Number&gt;.SAR are used automatically. For more information, see Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 123]</td>
<td>Software Provisioning Manager 1.0 SP21 (SL Toolset 1.0 SP21)</td>
</tr>
<tr>
<td>SL Common GUI with SAPINST 7.49</td>
<td>With the new installer framework version SAPINST 7.49, you can now use the new SAPUI5-based graphical user interface (GUI) “SL Common GUI”. For more information, see Useful Information about the Installer [page 154], Running the Installer [page 147].</td>
<td>Software Provisioning Manager 1.0 SP20 (SL Toolset 1.0 SP20)</td>
</tr>
<tr>
<td>Cleanup of Operating System Users</td>
<td>You can now specify during the Define Parameters phase that the operating system users are to be removed from group sapinst after the execution of the installer has completed. For more information, see Operating System Users in SAP System Parameters [page 64].</td>
<td>Software Provisioning Manager 1.0 SP20 (SL Toolset 1.0 SP20)</td>
</tr>
<tr>
<td>Option to install an SAP Gateway in an ASCS instance</td>
<td>You can now install an SAP Gateway in an ASCS instance. You can choose this option while running the ASCS instance installation. For more information, see ASCS Instance with Integrated Gateway [page 39]</td>
<td>Software Provisioning Manager 1.0 SP20 (SL Toolset 1.0 SP20)</td>
</tr>
<tr>
<td>Verification of Integrity of Data Units in Software Provisioning Manager</td>
<td>The integrity of data units extracted from the Software Provisioning Manager archive is verified. For more information, see Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 123]. In addition, check SAP Note 1680045 whether additional information is available.</td>
<td>Software Provisioning Manager 1.0 SP19 (SL Toolset 1.0 SP19)</td>
</tr>
<tr>
<td>Support of Linux on IBM Power Systems (little endian)</td>
<td>Software Provisioning Manager supports as of now Linux on IBM Power Systems (little endian) as operating system platform for SAP systems based on SAP NetWeaver 7.5 and higher. For more information, see SAP Note 2378874.</td>
<td>Software Provisioning Manager 1.0 SP19 (SL Toolset 1.0 SP19)</td>
</tr>
<tr>
<td>Archive-based Language Installation</td>
<td>If you perform an installation using a stack configuration file, you can now add language archives to the download basket and use them for language installation. This feature is currently restricted to the latest products only. For more information, see Additional Parameters When Using a Stack Configuration File (Optional) [page 80]</td>
<td>Software Provisioning Manager 1.0 SP19 (SL Toolset 1.0 SP19)</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Availability</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Option to install an SAP Web Dispatcher in an ASCS instance</td>
<td>You can now install an SAP Web Dispatcher in an ASCS instance. You can choose this option while running the ASCS instance installation. For more information, see ASCS Instance with Integrated SAP Web Dispatcher [page 37]</td>
<td>Software Provisioning Manager 1.0 SP18 (SL Toolset 1.0 SP18)</td>
</tr>
<tr>
<td>Tablespace pool</td>
<td>During installation and system copy, a standard tablespace pool is created for data, index, and long tablespaces. For more information, see SAP System Database Parameters [page 74], Db2 Tablespaces [page 89], and SAP Note 2267446.</td>
<td>Software Provisioning Manager 1.0 SP18 (SL Toolset 1.0 SP18)</td>
</tr>
<tr>
<td>Script createTablespaces.sql changed</td>
<td>The script <code>createTablespaces.sql</code>, which was already available previously for creating tablespaces manually, was updated to incorporate the creation of a standard tablespace pool for SAP systems. For more information about <code>createTablespaces.sql</code>, see Creating Tablespaces Manually (Optional) [page 222]. For more information about tablespace pools, see Db2 Tablespaces [page 89].</td>
<td>Software Provisioning Manager 1.0 SP18 (SL Toolset 1.0 SP18)</td>
</tr>
<tr>
<td>Automatic storage</td>
<td>As of SAP NetWeaver 7.51, IBM Db2 for Linux, UNIX, and Windows databases are always installed with automatic storage for SAP systems. Deselecting automatic storage is no longer possible in the installer dialog.</td>
<td>Software Provisioning Manager 1.0 SP18 (SL Toolset 1.0 SP18)</td>
</tr>
<tr>
<td>Archive-Based Installation</td>
<td>You can now download the required installation archives instead of the complete SAP kernel installation media. For more information, see section Downloading Specific Installation Archives (Archive-Based Installation) in Preparing the Installation Media [page 118].</td>
<td>Software Provisioning Manager 1.0 SP17 (SL Toolset 1.0 SP17)</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Availability</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td>--------------</td>
</tr>
</tbody>
</table>
| Dialogs for table-space directories and storage group paths redesigned | The installer now provides completely re-designed dialogs for tablespaces, where you can specify the following:  
- Creation of tablespaces during installation  
- Automatic storage management for tablespaces  
- Directories for table data, index data, and temporary data in tablespaces (sapdata and saptmp directories)  
You can now also specify if you want additional parent directories sapdata and saptmp, under which all subdirectories for table data, index data, and temporary data are located.  
Previously, saptmp directories were only available as of IBM Db2 10.1 for storage group paths for temporary data if automatic storage management was selected. As of Software Provisioning Manager 1.0 SP17, saptmp directories are also available for lower Db2 versions if you do not use automatic storage. For IBM Db2 10.1 and higher, they are now always available, regardless of whether you have chosen automatic storage or not.  
For more information, see Required File Systems for IBM Db2 for Linux, UNIX, and Windows [page 83]. | Software Provisioning Manager 1.0 SP17 (SL Toolset 1.0 SP17) |
| Diagnostics Agent | The Diagnostics Agent is no longer installed automatically with the SAP system. The Install Diagnostics Agent check box on the Install Diagnostics Agent screen is no longer available.  
You now have to install the Diagnostics Agent always separately. We recommend that you install it prior to the installation of your SAP system(s).  
For more information, see the Diagnostics Agent Installation Strategy attached to SAP Note 1365123, to SAP Note 1833501, and to SAP Note 1858920 and the attached Diagnostics Agent Setup Guide. | Software Provisioning Manager 1.0 SP10 (SL Toolset 1.0 SP16) |
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
</table>
| System Provisioning for SAP NetWeaver 7.5 and SAP NetWeaver 7.5-based Products | All system provisioning tasks (installation, system copy, system rename) are available for the new SAP NetWeaver 7.5 release. The Dual Stack option, which integrates an AS ABAP and AS Java in a single system (common System ID `<SAPSID>`, common startup framework, common database), is no longer supported in SAP systems based on SAP NetWeaver 7.5.  
● After upgrading to SAP NetWeaver 7.5 PI, you first have to split the still existing dual stack-system before you can use SAP NetWeaver 7.5 PI productively. For more information, see the Upgrade Master Guide - SAP NetWeaver 7.5 at: [http://help.sap.com/nw75](http://help.sap.com/nw75).  
Installation and Upgrade  
● SAP NetWeaver 7.5 is Unicode only  
● The primary application server instance directory has been renamed from `/usr/sap/<SAPSID>/DVEBMGS<Instance_Number>` to `/usr/sap/<SAPSID>/D<Instance_Number>`. For more information, see SAP Directories [page 108].  
● Declustering and depooling of tables during the installation is enabled by default. For more information, see SAP Note 1892354. | Software Provisioning Manager 1.0 SP09 (SL Toolset 1.0 SP15) |
| System Provisioning for SAP Solution Manager 7.2 | All system provisioning tasks (installation, system copy, system rename) are available for the new SAP Solution Manager 7.2 release. Compared to previous SAP Solution Manager releases, SAP Solution Manager 7.2 is no longer provided as a classical dual-stack system (ABAP system with Java Add-in), but consists of a separate ABAP and Java stack. | Software Provisioning Manager 1.0 SP09 (SL Toolset 1.0 SP15) |
**Feature**

Creating Kernel Archives from existing SAP System

**Description**

You can reuse the binaries of a dedicated SAP system for a new SAP system installation or target system installation in the context of a system copy by creating *.SAR archives based on the *.lst files from the executable (exe) directories of the source SAP system.

**Availability**

Software Provisioning Manager 1.0 SP09 (SL Toolset 1.0 SP14)

---

**i Note**

This feature is only available for Unicode systems.

---

**Caution**

This feature has been deprecated with Software Provisioning Manager 1.0 SP21 (SL Toolset 1.0 SP21) and the related option has been removed from the Welcome screen. This deprecation has been accomplished to ensure compliancy with the new feature “Media Signature Check” of Software Provisioning Manager 1.0 SP21 (SL Toolset 1.0 SP21) described above in this table.

---

**Feature**

Storage group paths for temporary tablespaces

**Description**

As of IBM Db2 version 10.1, the installer automatically creates the storage group SAPTMPGRP for temporary tablespaces if automatic storage management is selected. This ensures that permanent tablespaces for table data and indexes are kept separate from temporary tablespaces (see also SAP Note 1895425). By default, the installer creates four storage group paths for the storage group SAPTMPGRP.

For more information, see SAP System Database Parameters [page 74].

**Availability**

Software Provisioning Manager 1.0 SP08 (SL Toolset 1.0 SP13)

---

**Feature**

Usage Type Library Deprecation for SAP Systems Based on SAP NetWeaver 7.3 EHP1 and Higher

**Description**

Software Provisioning Manager 1.0 no longer uses the “Usage Types” definitions in its business logic for SAP systems based on SAP NetWeaver 7.3 EHP1 and higher. This is done to unify modeling and terminology across all SAP tools used during the planning, installation and maintenance activities. The “Product Instance” definition replaces “Usage Types” regarding product modeling. For more information, see SAP Notes 1970349 and 1877731.

**Availability**

Software Provisioning Manager 1.0 SP07 (SL Toolset 1.0 SP12)

---

**Feature**

Installation Using a Stack Configuration File

**Description**

You can start the installer using a stack configuration file generated by the Maintenance Planner. The configuration parameters in this file can then be used by the installer to improve the integration with SUM and to simplify the process of installation for a new system on target software level.

For more information, see Installation Using a Stack Configuration File (Optional) [page 45].

**Availability**

Software Provisioning Manager 1.0 SP07 (SL Toolset 1.0 SP12)
### Feature | Description | Availability
--- | --- | ---
Adaptive Installation | You can assign virtual host names to SAP system instances during the input phase of the installation directly on the screens where you define the instance parameters. For more information, see [SAP System Parameters](page 64). | Software Provisioning Manager 1.0 SP07 (SL Toolset 1.0 SP12)
Feedback Evaluation Form | SAP SE’s aim is to provide fast and efficient procedures. To evaluate the procedure you just carried out, we need information generated by the tool during process execution and your experience with the tool itself. A new evaluation form contains a simple questionnaire and XML data generated during the procedure. Port 4239 is used for displaying the feedback evaluation form. For more information, see [Prerequisites for Running the Installer](page 143). | Software Provisioning Manager 1.0 SP07 (SL Toolset 1.0 SP12)
Option Verify Signed Media | The digital signature ensures that the signatory of a digital document can be identified unambiguously and signatory’s name is documented together with the signed document, the date, and the time. For more information, see SAP Note 1979965. | Software Provisioning Manager 1.0 SP06 (SL Toolset 1.0 SP11)
Valid only for SAP NetWeaver 7.4 SR1: Declustering and depooling of ABAP tables | Declustering and depooling of tables during the installation is now supported. It is relevant if you want to take advantage of optimizations for SAP Business Suite. For more information, see SAP Note 1892354. | Software Provisioning Manager 1.0 SP05 (SL Toolset 1.0 SP10)
### Database-Specific Features
<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
</table>
| Tablespace pools | During installation and system copy, tablespace pools are created for data, index, and long tablespaces. For more information, see [SAP System Database Parameters](page 74). | Software Provisioning Manager 1.0 SP18 (SL Toolset 1.0 SP18)
| Script createTablespaces.sql changed | The script `createTablespaces.sql`, which was already available previously for creating tablespaces manually, was updated to incorporate the creation of a standard tablespace pool for SAP systems. For more information about `createTablespaces.sql`, see [Creating Tablespaces Manually (Optional)](page 222). For more information about tablespace pools, see [Db2 Tablespaces](page 89). | Software Provisioning Manager 1.0 SP18 (SL Toolset 1.0 SP18)
<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic storage</td>
<td>As of SAP NetWeaver 7.51, IBM DB2 for Linux, UNIX, and Windows databases are always installed with automatic storage for SAP systems. Deselecting automatic storage is no longer possible in the installer dialog.</td>
<td>Software Provisioning Manager 1.0 SP18 (SL Toolset 1.0 SP18)</td>
</tr>
</tbody>
</table>
| Dialogs for tablespace directories and storage group paths redesigned | The installer now provides completely redesigned dialogs for tablespaces, where you can specify the following:  
  - Creation of tablespaces during installation  
  - Automatic storage management for tablespaces  
  - Directories for table data, index data, and temporary data in tablespaces (sapdata and saptmp directories)  
  You can now also specify if you want additional parent directories sapdata and saptmp, under which all subdirectories for table data, index data, and temporary data are located.  
  Previously, saptmp directories were only available as of DB2 10.1 for storage group paths for temporary data if automatic storage management was selected. As of Software Provisioning Manager 1.0 SP17, saptmp directories are also available for lower DB2 versions if you do not use automatic storage. For DB2 10.1 and higher, they are now always available, regardless of whether you have chosen automatic storage or not.  
  For more information, see Required File Systems for IBM Db2 for Linux, UNIX, and Windows [page 83]. | Software Provisioning Manager 1.0 SP17 (SL Toolset 1.0 SP17)              |
<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage group paths for temporary tablespaces</td>
<td>As of IBM DB2 version 10.1, the installer automatically creates the storage group SAPTMPGRP for temporary tablespaces if automatic storage management is selected. This ensures that permanent tablespaces for table data and indexes are kept separate from temporary tablespaces (see also SAP Note 1895425). By default, the installer creates four storage group paths for the storage group SAPTMPGRP. For more information, see SAP System Database Parameters [page 74].</td>
<td>Software Provisioning Manager 1.0 SP08 (SL Toolset 1.0 SP13)</td>
</tr>
</tbody>
</table>
2 Installation Options Covered by this Guide

This section shows the installation options covered by this installation guide. You have to decide what exactly you want to install because the steps you have to perform vary according to the installation option you choose.

**i Note**

This installation guide does not describe how to install an SAP system running on IBM Db2 for Linux, UNIX, and Windows with the IBM Db2 pureScale Feature. If you want to install an SAP system with the IBM Db2 pureScale Feature, follow the instructions of the installation guide *Running an SAP System on IBM Db2 with the pureScale Feature* (see Online Information from SAP [page 245]).

After you have decided on the installation option that you want to use, continue with Planning [page 43].

- Standard System [page 29]
- Distributed System [page 30]
- High-Availability System [page 31]
- Additional Application Server Instance [page 33]
- Splitting off an ABAP Central Services Instance from an Existing Primary Application Server Instance [page 36]
- ASCS Instance with Integrated SAP Web Dispatcher [page 37]
- ASCS Instance with Integrated Gateway [page 39]
- SAP Host Agent as a Separate Installation [page 40]

### 2.1 Standard System

You can install a **standard** system on a **single** host.

In a standard system, all main instances run on a single host.

There are the following instances:

- **ABAP Central services instance (ASCS instance)**
  - Contains the ABAP message server and the Standalone Enqueue Server
  - Optionally, you can install the ASCS instance with an integrated SAP Web Dispatcher. For more information, see ASCS Instance with Integrated SAP Web Dispatcher [page 37].
  - Optionally, you can install the ASCS instance with an integrated gateway. For more information, see ASCS Instance with Integrated Gateway [page 39].
- **Database instance (DB)**
- **Primary application server instance (PAS instance)**
2.2 Distributed System

An SAP system consists of SAP instances. An SAP instance is a group of processes that are started and stopped at the same time.

In a distributed system, every instance can run on a separate host:

- **ABAP Central services instance (ASCS instance)**
  Contains the ABAP message server and the Standalone Enqueue Server
  - Optionally, you can install the ASCS instance with an integrated SAP Web Dispatcher. For more information, see ASCS Instance with Integrated SAP Web Dispatcher [page 37].
  - Optionally, you can install the ASCS instance with an integrated gateway. For more information, see ASCS Instance with Integrated Gateway [page 39].

- **Database instance (DB)**
  The ABAP stack uses its own database schema in the database.

- **Primary application server instance (PAS)**

The graphics below assume that you use the global directories of the ASCS instance as global file system. That means that the host with the ASCS instance is the SAP global host. However, you can also separately install the global directories on any host of your SAP system landscape.

You can also use the SAP transport host or the host with the global file system (SAP global host) as your primary application server instance host.

Optionally, you can install one or more additional application server instances. For more information, see Installation of an Additional Application Server Instance [page 33].
2.3 High-Availability System

An SAP system consists of SAP instances. An SAP instance is a group of processes that are started and stopped at the same time.

In a high-availability system, every instance can run on a separate host.

There are the following instances:

- ABAP central services instance (ASCS instance)
  Contains the ABAP message server and the Standalone Enqueue Server

**Note**

ASCS instance with “Standalone Enqueue Server” versus ASCS instance with new “Standalone Enqueue Server 2”: Software Provisioning Manager 1.0 installs the “Standalone Enqueue Server” by default for all SAP system releases in the ASCS instance. However, if you have installed the ASCS instance for an SAP system based on SAP NetWeaver AS for ABAP 7.52, you can switch to the new “Standalone Enqueue Server 2” after the installation has completed. For more information, see https://help.sap.com/nw752abap/Application Help SAP NetWeaver Library: Function-Oriented View SAP NetWeaver Application Server for ABAP Components of SAP NetWeaver Application Server for ABAP Standalone Enqueue Server 2 High Availability with Standalone Enqueue Server 2 and Systems Based on SAP NetWeaver AS for ABAP 7.52 only: Switching to Standalone Enqueue Server 2 and Enqueue Replicator 2 [page 180].

- Optionally you can install the ASCS instance with an integrated SAP Web Dispatcher. For more information, see ASCS Instance with Integrated SAP Web Dispatcher [page 37].
Optionally you can install the ASCS instance with an integrated gateway. For more information, see ASCS Instance with Integrated Gateway [page 39].

ERS instance for the ASCS instance (mandatory)
The ERS instance contains the replication table, which is a copy of the lock table of the Standalone Enqueue Server in the ASCS instance.

**Note**

ERS instance with “Enqueue Replication Server” versus ERS instance with new “Enqueue Replicator 2”: Software Provisioning Manager 1.0 installs the ERS instance with the classic “Enqueue Replication Server” by default for all SAP system releases. However, if you have installed the ERS instance for an SAP system based on SAP NetWeaver AS for ABAP 7.52, you can switch to “Enqueue Replicator 2” after the installation has completed. For more information, see https://help.sap.com/nw752abap Application Help SAP NetWeaver Library: Function-Oriented View SAP NetWeaver Application Server for ABAP Components of SAP NetWeaver Application Server for ABAP Standalone Enqueue Server 2 and Systems Based on SAP NetWeaver AS for ABAP 7.52 only: Switching to Standalone Enqueue Server 2 and Enqueue Replicator 2 [page 180].

- Database instance (DB)
- Primary application server instance (PAS)

The graphics below each assumes that you run the ASCS instance and the ERS instance on the switchover cluster infrastructure. However, you can also run other SAP system instances that are a single point of failure (SPOF) on a switchover cluster infrastructure, for example the database instance.

We recommend that you run the ASCS instance in a switchover cluster infrastructure.

To increase high availability by creating redundancy, we recommend that you install additional application server instances on hosts different from the primary application server instance host. For more information, see Installation of an Additional Application Server Instance [page 33].

The following figure shows an example for the distribution of the SAP system instances in a high-availability system.
2.4 Additional Application Server Instance

You can install one or more additional application server instances for an existing SAP system. Additional application server instances are optional and can be installed on separate hosts.

An additional application server instance can run on:

- The host of any instance of the existing SAP system (exceptions see below)
- On a dedicated host

**Note**

If you want to install additional application server instances running on an operating system other than the primary application server instance, see *Heterogeneous SAP System Installation [page 218]*. For example, you need to do this if your primary application server instance runs on Linux for z System but the additional application server instance is to run on Windows.

**Additional Application Server Instance for a Standard System**

For example, the following figure shows a standard system with additional application server instances that run:

- On the main host of the SAP system, that is, on the host on which the primary application server instance and the database instance run
On dedicated hosts

Additional Application Server Instance for a Standard ABAP System

For more information, see Standard System [page 29].

Additional Application Server Instance for a Distributed System

The following figure shows a distributed system with additional application server instances that run:

- On the main host of the SAP system, that is, on the host on which the primary application server instance runs
- On dedicated hosts

We do not recommend installing additional application server instances on the SAP global host.
Additional Application Server Instance for a Distributed ABAP System

For more information, see Distributed System [page 30].

Additional Application Server Instance for a High-Availability System

The following figure shows a high-availability system with additional application server instances that run:

- On the host of the primary application server instance
- On dedicated hosts
2.5 Splitting off an ABAP Central Services Instance from an Existing Primary Application Server Instance

The ABAP central services instance (ASCS instance) consists of the essential ABAP enqueue and message system services only. With a separate ASCS instance, it is easier for you to later turn your SAP system into a high-availability system.

The benefit of having a separate ASCS instance is mainly in the area of high-availability. This approach concentrates the possible single points of failure of a system into a single instance and, therefore, restricts failure to a single instance.

Every newly installed SAP system based on SAP NetWeaver 7.3 and higher is automatically installed with an ASCS instance, even if you install all SAP system instances on one host (standard system).

However, if you upgraded your SAP system from a release based on a SAP NetWeaver release lower than 7.3, your SAP system might not yet have a separate ASCS instance.

The section Splitting Off an ABAP Central Services Instance from an Existing Primary Application Server Instance [page 225] describes how you can move the message server and the enqueue work process from an existing primary application server instance to a newly installed ABAP central services instance (ASCS instance).
2.6 ASCS Instance with Integrated SAP Web Dispatcher

You can install an SAP Web Dispatcher integrated in the ASCS instance. If you select this option, an SAP Web Dispatcher is installed running within the ASCS instance. No separate SAP Web Dispatcher instance and no dedicated `<SAPSID>` are created for the SAP Web Dispatcher. We recommend this if you want to use the SAP Web Dispatcher for the system to which the ASCS instance belongs.

**Note**

We only recommend this option for special scenarios. For more information, see SAP Note 908097. For an SAP Web Dispatcher installation, a standalone installation (see below) continues to be the default scenario.

The SAP Web Dispatcher is located between the Web client (browser) and your SAP system that is running the Web application.

It acts as single point of entry for incoming requests (HTTP, HTTPS), defined by the IP address, port, and URL, and forwards them in turn to the application server (AS) of the SAP system.

The SAP Web Dispatcher receives information about the SAP system that it needs for load distribution (load balancing) from the message server and application server via HTTP.
Installation of “Standalone” SAP Web Dispatcher with its own <SAPSID> and Instance

If you want to install an SAP Web Dispatcher for another system - that is not for the system for which you use the ASCS instance and with its own SAP system ID and instance number - you have to install SAP Web Dispatcher separately as described in the documentation which you can find under http://support.sap.com/sitoolset > System Provisioning > Installation Option of Software Provisioning Manager > Guide for SAP Web Dispatcher for SAP NetWeaver 7.0 or Higher.

More Information

For more information about the architecture and the functions of SAP Web Dispatcher, see the SAP Web Dispatcher documentation in the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quicklink</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>• SAP NetWeaver Mobile 7.1</td>
<td>Application Help</td>
</tr>
<tr>
<td></td>
<td>Function-Oriented View</td>
</tr>
<tr>
<td></td>
<td>Application Server</td>
</tr>
<tr>
<td></td>
<td>Server Infrastructure</td>
</tr>
<tr>
<td></td>
<td>Components of SAP NetWeaver</td>
</tr>
<tr>
<td></td>
<td>Application Server</td>
</tr>
<tr>
<td></td>
<td>SAP Web Dispatcher</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nwmobile71">http://help.sap.com/nwmobile71</a></td>
<td></td>
</tr>
<tr>
<td>• SAP NetWeaver Mobile 7.1 including</td>
<td></td>
</tr>
<tr>
<td>Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nwmobile711">http://help.sap.com/nwmobile711</a></td>
<td></td>
</tr>
<tr>
<td>• SAP NetWeaver 7.1 for Banking</td>
<td></td>
</tr>
<tr>
<td>Services from SAP 5.0 and 6.0</td>
<td>See the SAP NetWeaver Mobile Library.</td>
</tr>
<tr>
<td>• SAP NetWeaver 7.1 including</td>
<td></td>
</tr>
<tr>
<td>Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td>for Banking Services from SAP 5.0</td>
<td></td>
</tr>
<tr>
<td>and 6.0</td>
<td></td>
</tr>
</tbody>
</table>

i Note

Since the SAP NetWeaver Mobile 7.1 Library is the only available SAP Library for ABAP systems based on SAP NetWeaver 7.1, in this guide we always refer to it also for SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0.
## SAP Release and SAP Library Quicklink

- SAP NetWeaver 7.3
- SAP NetWeaver 7.3 including Enhancement Package 1
- SAP NetWeaver 7.4
- SAP NetWeaver 7.5
- SAP NetWeaver Application Server for ABAP 7.51 innovation package
  [https://help.sap.com/nw751abap](https://help.sap.com/nw751abap)
- SAP NetWeaver AS for ABAP 7.52
  [https://help.sap.com/nw752abap](https://help.sap.com/nw752abap)

### SAP Library Path (Continued)

- Application Help > Function-Oriented View > Application Server Infrastructure > Components of SAP NetWeaver Application Server > SAP Web Dispatcher

## Related Information

Parameters for Additional Components to be Included in the ASCS Instance (Optional) [page 82]

### 2.7 ASCS Instance with Integrated Gateway

You can install a gateway integrated in the ASCS instance. If you select this option, a gateway is installed within the ASCS instance.

**i Note**

No separate standalone gateway instance and no dedicated `<SAPSID>` are created for the gateway.
Gateway Integrated in the ASCS Instance

The gateway enables communication between work processes and external programs, as well as communication between work processes from different instances or SAP systems.

You can also install a standalone gateway instance. For more information, see the documentation Installation Guide – Installation of a Standalone Gateway Instance for SAP Systems Based on SAP NetWeaver <Release> at http://support.sap.com/sitoolset System Provisioning Installation Option.

Related Information

Parameters for Additional Components to be Included in the ASCS Instance (Optional) [page 82]

2.8 SAP Host Agent as a Separate Installation

Under certain circumstances you need to install SAP Host Agent separately. Apart from performing this installation manually, you can also do this using the installer.

SAP Host Agent is an agent that can accomplish several life-cycle management tasks, such as operating system monitoring, database monitoring, system instance control and provisioning. When you install a new SAP system or instance, the SAP Host Agent is in most cases installed automatically on the SAP system or instance host.
It is only required to install the SAP Host Agent separately if one of the following is true:

- There is no SAP system or instance on the host.
- The SAP system or instance running on the host has a kernel release lower than SAP kernel 7.20 and the host does not yet have an SAP Host Agent. During the installation of new SAP instances with SAP kernel 7.20 or higher, the SAP Host Agent is installed automatically (integrated installation).
- You have upgraded your SAP system to a release with a kernel release lower than SAP kernel 7.20 and the host of the upgraded system or instance does not yet have an SAP Host Agent.

Section Installing the SAP Host Agent Separately [page 219] describes how to perform the installation using Software Provisioning Manager 1.0.

### Installing the SAP Host Agent Without Using Software Provisioning Manager

You can also install SAP Host Agent by downloading the SAPHOSTAGENT.SAR archive and running the installation from the command line. For more information, see the SAP Host Agent documentation at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver Mobile 7.1</td>
<td><img src="http://help.sap.com/nwmobile71" alt="Application Help" /></td>
</tr>
<tr>
<td>SAP NetWeaver Mobile 7.1 including Enhancement Package 1</td>
<td><img src="http://help.sap.com/nwmobile71" alt="Function-Oriented View" /></td>
</tr>
<tr>
<td>SAP NetWeaver 7.1 for Banking Services from SAP</td>
<td><img src="http://help.sap.com/nwmobile71" alt="Application Help" /></td>
</tr>
<tr>
<td>SAP NetWeaver 7.1 including Enhancement Package 1 for Banking Services from SAP</td>
<td><img src="http://help.sap.com/nwmobile71" alt="Function-Oriented View" /></td>
</tr>
</tbody>
</table>

See the SAP NetWeaver Mobile Library.

**Note**

Since the SAP NetWeaver Mobile 7.1 Library is the only available SAP Library for ABAP systems based on SAP NetWeaver 7.1, in this guide we always refer to it also for SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0.
<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
</table>
| ● SAP NetWeaver 7.3  
http://help.sap.com/nw73 |
| ● SAP NetWeaver 7.3 including Enhancement Package 1  
http://help.sap.com/nw731 |
| ● SAP NetWeaver 7.4  
http://help.sap.com/nw74 |
| ● SAP NetWeaver 7.5  
http://help.sap.com/nw75 |
| ● SAP NetWeaver Application Server for ABAP 7.51 innovation package  
https://help.sap.com/nw751abap |
| ● SAP NetWeaver AS for ABAP 7.52  
https://help.sap.com/nw752abap |

Application Help ➤ Function-Oriented View: English ➤ Solution Life Cycle Management ➤ SAP Host Agent ➤ SAP Host Agent Installation ➤ Installing SAP Host Agent Manually ➤
3 Planning

3.1 Planning Checklist

This section includes the planning steps that you have to complete for the following installation options.

- Standard, distributed, or high-availability system
- Additional application server instance

Detailed information about the steps are available in the linked sections.

Prerequisites

1. You have planned your SAP system landscape according to the Master Guide available at the appropriate download location as described in Before You Start [page 16].
2. You have decided on your installation option (see Installation Options Covered by this Guide [page 29]).

Standard, Distributed, or High-Availability System

- **Note**
  In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a standard system, you can ignore references to other hosts.

1. Make yourself familiar with the changed file system structure and profiles for SAP systems based on SAP NetWeaver 7.1 and higher compared to SAP systems based on lower SAP NetWeaver releases. For more information, see Changed File System Structure and Profiles for SAP Systems Based on SAP NetWeaver 7.1 and Higher [page 44].
2. If you want to install an SAP ABAP system along with the required Support Package stack and ABAP Add-Ons in one implementation run, you need to plan the desired installation target using the maintenance planner at https://apps.support.sap.com/sap/support/mp.
   In the maintenance planner, a stack XML file with the desired Support Package stack and Add-On information is generated, which you then hand over to Software Provisioning Manager (the “installer” for short) by calling it with command line parameter SAPINST_STACK_XML=<Absolute_Path_To_Stack_XML_File>. Included constraints and defaults defined in the stack XML file are then used for the initial installation by Software Provisioning Manager and for the application of Support Package stacks and Add-Ons by the Software Update Manager (SUM).
   For more information, see Installation Using a Stack Configuration File (Optional) [page 45].
→ Recommendation

We recommend that you perform the installation using a stack configuration file for all new products such as SAP S/4HANA on Premise.

3. You check the hardware and software requirements [page 47] on every installation host.
4. You plan how to set up user and access management [page 61].
5. You identify Basic SAP System Installation Parameters [page 63].
6. You carefully plan the setup of your database [page 83].
7. You decide on the transport host to use [page 96].
8. You decide whether you want to integrate LDAP Directory Services in your SAP system [page 203].
9. To install a high-availability system, you read Planning the Switchover Cluster for High Availability [page 97].
10. Optionally, you decide whether you want to install multiple components in one database (MCOD) [page 208].
11. Continue with Preparation [page 101].

Additional Application Server Instance

1. You check the hardware and software requirements [page 47] for every installation host on which you want to install one or more additional application server instances.
2. You identify Basic SAP System Installation Parameters [page 63].
3. Continue with Preparation [page 101].

3.2 Changed File System Structure and Profiles for SAP Systems Based on SAP NetWeaver 7.1 and Higher

File system structure

- For SAP system releases based on SAP NetWeaver 7.1 and higher, the directory structure was changed compared to SAP NetWeaver 7.0, in order to support heterogeneous system installations and updates more efficiently.
  For more information about how to configure upgraded SAP systems for the new directory structure, see SAP Note 1104735.

⚠ Caution

The directory structure of systems based on SAP NetWeaver 7.1 or higher is not supported on systems based on SAP NetWeaver 7.0 including Enhancement Packages.

- For a manual switch, see the details about targeted file system structure in this documentation and adjust your file system accordingly to avoid later issues for system transformation such as system copy and system rename.
Profiles

- As of SAP NetWeaver 7.3, the start profile as separate file has been removed. In earlier versions of SAP NetWeaver there was one default profile per SAP system, one start profile per Instance and one Instance profile per instance. Now the start profile contents are merged with the instance profile. With the help of the new instance profile, SAP processes are started and at the same time instance-specific parameters are read. This reduces the total number of profile files to one default profile per SAP System, and one instance profile per instance.

For more information, see the SCN blog What’s new in SAP NetWeaver 7.3 - A Basis perspective at: https://blogs.sap.com/2012/05/22/whats-new-in-sap-netweaver-73-a-basis-perspective/.

⚠️ Caution

The merged profiles are not supported for SAP NetWeaver 7.0 including Enhancement Packages because this could lead to issues for SAP system copy. If you are not sure which SAP NetWeaver product version you have, see SAP Note 1877731 for more information.

- Concatenate instance profile and start profile entries and remove the start profile from the profile directory. For more information, see SAP Note 1898687.
- Adjust the /usr/sap/sapservices profile file by replacing the start profile with the instance profiles for starting the sapstartsrv process, and then restart the SAP start service.
- Additional application server instances: Double-check the values with the profile values from the primary application server - for example for parameters DIR_CT_RUN, DIR_EXECUTABLE, DIR_SAPJVM - to avoid startup issues.

3.3 Installation Using a Stack Configuration File

The option to perform an installation using a stack configuration file (also called “up-to-date installation”) improves the process of provisioning an up-to-date SAP system by creating a unified consumption experience and a direct close collaboration between the involved tools, namely:

- Maintenance Planner, accessible at https://apps.support.sap.com/sap/support/mp
- LMDB in SAP Solution Manager
- Software Provisioning Manager (the “installer” for short)
- Software Update Manager (“SUM”)

The installer then can take over more default settings that are already predefined in the Maintenance Planner.

➡️ Recommendation

We recommend that you perform the installation using a stack configuration file for new products, such as SAP S/4HANA or SAP Solution Manager 7.2.
**Prerequisites**

- To be able to use the Maintenance Planner at [https://apps.support.sap.com/sap/support/mp](https://apps.support.sap.com/sap/support/mp), your SAP Solution Manager system must have at least one of the following release and Support Package (SP) level:
  - SAP Solution Manager 7.2
  - SAP Solution Manager 7.1 SP06 or higher
  - SAP Solution Manager 7.0 SP 23 and you must have applied the following SAP Notes:
    - 1646604
    - 1783371
    - 1743695

- You must have implemented SAP Note 1940845 in your SAP Solution Manager system.

- For additional information about involved tools and supported SAP system releases, see SAP Note 2277574.

**Features**

An installation using a stack configuration file provides the following features:

- You can use a stack configuration file generated by the Maintenance Planner at [https://apps.support.sap.com/sap/support/mp](https://apps.support.sap.com/sap/support/mp). The parameters contained in the stack configuration file can then be processed by the installer to get better integrated with SUM and to simplify the process of installation for a new system on a target software level. This makes IT administration easier by reducing the efforts in Total Cost of Ownership (TCO). For more information, see the Best Practice Guide to Planning Landscape Changes at [https://wiki.scn.sap.com/wiki/display/SL/Landscape+Management+-+the+Process](https://wiki.scn.sap.com/wiki/display/SL/Landscape+Management+-+the+Process).

- When processing a stack configuration file, the installer can take over more default settings that are already predefined in the Maintenance Planner and offers more possibilities for automation as compared to when running without it. For more information about the benefits by comparing the existing process with the new improved process, see [Up-To-Date Installation](https://blogs.sap.com/2016/10/21/up-to-date-installation-2/).

**i Note**

The procedure and the screenshots provided in the linked document are *only an example* to show how an up-to-date installation works in general for an example SAP product, and what the benefits are. This document is not intended to serve as a detailed instruction for an up-to-date-installation of any supported SAP product.

- You can use the installer to directly download the installation software from SAP by providing the Maintenance Plan to the installer while running installer option *Download Software Packages for Maintenance Planner Transaction*.

  For more information, see [Downloading Software Packages for a Maintenance Planner Transaction](page 128)
Integration

For the additional input parameters that you need to specify, see Additional Parameters When Using a Stack Configuration File (Optional). You can find the link to this section in Related Information below.

In addition, each section in this guide describing steps that are completely or at least partially automatized when using a stack configuration files is marked with an appropriate note at the beginning. These are the following sections as listed in the adjacent section Related Information:

Related Information

- Additional Parameters When Using a Stack Configuration File (Optional) [page 80]
- Preparing the Installation Media [page 118]
- Running the Installer [page 147]
- Configuring the Change and Transport System [page 172]
- Applying the Latest Kernel and Support Package Stacks [page 176]
- Installing Additional Languages and Performing Language Transport [page 182]

3.4 Hardware and Software Requirements

Ensure that your hosts meet the hardware and software requirements for your operating system and the SAP instances. Otherwise you might experience problems when working with the SAP system.

Prerequisites

- Make sure that the host name meets the requirements listed in SAP Note 611361.
- Contact your OS vendor for the latest OS patches.
- Check your keyboard definitions.
- If you want to install a printer on a host other than the primary application server instance host (for example, on a separate database instance host), check whether the printer can be accessed under UNIX.

Procedure

1. Check the Product Availability Matrix at http://support.sap.com/pam for supported operating system releases.
2. Check the hardware and software requirements using:
3. If you want to install a production system, the values provided by the Prerequisite Checker and the hardware and software requirements checklists are not sufficient. In addition, do the following:

- You contact your hardware vendor, who can analyze the load and calculate suitable hardware sizing depending on:
  - The set of applications to be deployed
  - How intensively the applications are to be used
  - The number of users

### 3.4.1 Running the Prerequisites Check in Standalone Mode (Optional)

This section describes how to run the prerequisites check in standalone mode. Running the prerequisites check in standalone mode is optional.

#### Context

When you install an SAP system, the installer automatically starts the prerequisites check and checks the hardware and software requirements in the background. As an optional step during planning, you can also run the prerequisites check in standalone mode to check the hardware and software requirements for your operating system and the SAP instances before the actual installation.

> Recommendation

We recommend that you use both the prerequisites check and the requirements tables for reference.

#### Procedure

1. Download and unpack the Software Provisioning Manager archive to a local directory as described in Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 123].
2. Make either the separate `SAPEXE<Version>.SAR` archive or the complete kernel medium available as described in Preparing the Installation Media [page 118].
3. Start the installer as described in Running the Installer [page 147].
4. On the Welcome screen, choose <SAP_Product> <Database> Preparations Prerequisites Check.

5. Follow the instructions in the installer dialogs and enter the required parameters.

   **Note**
   
   To find more information on each parameter during the Define Parameters phase, position the cursor on the required parameter input field, and choose either F1 or the HELP tab. Then the available help text is displayed in the HELP tab.

   After you have finished, the Parameter Summary screen appears. This screen summarizes all parameters that you have entered and that you want to have checked. If you want to make a change, select the relevant parameters and choose Revise.

6. To start the prerequisites check, choose Next.

### Results

The Prerequisite Checker Results screen displays the results found. If required, you can also check the results in file prerequisite_checker_results.html, which you can find in the installation directory.

### Related Information

- Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 123]
- Preparing the Installation Media [page 118]

### 3.4.2 Requirements for the SAP System Hosts

Every installation host must meet at least the requirements listed in the following tables. Most of the requirements are valid for every installation host whereas some requirements are instance-specific and are marked accordingly.

In addition to the hardware and software requirements listed here, make sure that you also consult the hardware and software requirements provided by IBM at http://www.ibm.com/support/docview.wss?uid=swg27038033.

If you are planning to install an SAP BW system with BLU Acceleration, note that there are special hardware and software requirements in addition to those listed in this section. For more information, see the Hardware and Software Requirements for BLU Acceleration chapter in the SAP BW Administration Guide (see Online Information from SAP [page 245]).

   **Note**
   
   The information here and in the following sections is not intended to replace the operating system documentation. For more information, see your operating system documentation.
Related Information

General Installation Information for Your Operating System [page 50]
Hardware Requirements [page 51]
Software Requirements [page 55]
Other Requirements [page 60]

3.4.2.1 General Installation Information for Your Operating System

Before checking the hardware and software requirements, we recommend that you make yourself familiar with some general information about installation of SAP systems on your operating system platform.

### Operating System Information

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIX</td>
<td>Before you start the installation, make sure that you have read SAP Note 1972803. In addition, we also recommend that you check the information available in the SAP on AIX space on the SAP Community Network at <a href="https://www.sap.com/community/topic/aix.html">https://www.sap.com/community/topic/aix.html</a>.</td>
</tr>
<tr>
<td>HP-UX</td>
<td>Before you start the installation, make sure that you have read SAP Note 1075118. In addition, we also recommend that you check the information available in the SAP on HP-UX Best Practices space on the SAP Community Network at <a href="https://www.sap.com/community/topic/hp-ux.html">https://www.sap.com/community/topic/hp-ux.html</a>.</td>
</tr>
<tr>
<td>Linux</td>
<td>Before you start the installation, make sure that you have read the SAP Notes for your Linux distribution listed in the central SAP Note 2369910. In addition, we also recommend that you check the information available in the SAP on Linux space on the SAP Community Network at <a href="https://www.sap.com/community/topic/linux.html">https://www.sap.com/community/topic/linux.html</a>.</td>
</tr>
<tr>
<td>Solaris</td>
<td>Before you start the installation, make sure that you have read SAP Note 1669684. In addition, we also recommend that you check the information available in the SAP on Oracle Solaris space on the SAP Community Network at <a href="https://www.sap.com/community/topic/oracle-solaris.html">https://www.sap.com/community/topic/oracle-solaris.html</a>.</td>
</tr>
</tbody>
</table>

In addition to the hardware and software requirements listed here, make sure that you also consult the hardware and software requirements provided by IBM at [http://www.ibm.com/support/docview.wss?uid=swg27038033](http://www.ibm.com/support/docview.wss?uid=swg27038033).
3.4.2.2 Hardware Requirements

Every installation host must meet at least the hardware requirements listed in the following tables. Most of the requirements are valid for every installation host whereas some requirements are instance-specific and are marked accordingly.

Note
If you are planning to install an SAP BW system with BLU Acceleration, note that BLU Acceleration has higher demands on hardware than the hardware requirements listed in this section. Therefore, make sure that you read the Hardware and Software Requirements for BLU Acceleration chapter in the SAP BW Administration Guide (see Online Information from SAP [page 245]).

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware requirements</td>
<td>Your hardware must be 64-bit capable.</td>
</tr>
</tbody>
</table>
| Processing units       | **For application server instances and database instances**: The number of physical or virtual processing units usable by the operating system image must be equal to or greater than 2.  
                         | **For an ASCS instance running on a separate host**: One physical or virtual processing unit usable by the operating system image might be sufficient.  
                         | Examples of processing units are processor cores or hardware threads (multithreading).  
                         | In a virtualized environment, ensure that adequate processor resources are available to support the workloads of the running SAP systems.  |
| Optical media drive    | ISO 9660 compatible                                                                     |
**Requirement** | **Values and Activities**
--- | ---
Hard disk space | **General Requirements:**
○ 2 GB of temporary disk space for each required physical installation media or alternatively the downloaded SAP kernel archives that you have to copy to a local hard disk. For more information, see [Preparing the Installation Media](#) [page 118].
○ If you prefer downloading the separate SAP kernel archives instead of using the complete SAP kernel media, you require 2 GB of temporary disk space for the set of SAP kernel archives that you have to copy to a local hard disk. For more information, see [Downloading SAP Kernel Archives (Archive-Based Installation)](#) [page 125].
○ 2 GB of temporary disk space for the installation.
○ If there is no tape drive attached to your system, you need additional disk space for the files created by Db2’s database backup command and the archived database log files. Alternatively, you need access to network-based storage management products, such as Legato Networker or Tivoli Storage Manager (TSM) (for database backup/restore).
○ If an advanced disk array is available (for example, RAID), contact your hardware vendor to make sure that the data security requirements are covered by this technology.

**Instance-Specific Requirements:**
If you install several instances on one host, you have to add up the requirements accordingly.

**For more information about space requirements for the file systems and directories of the instances, see SAP Directories [page 108] and the appropriate database-specific information listed below.**

○ ABAP central services instance (ASCS):
  Minimum 2 GB
  ○ If you install the ASCS instance with an integrated SAP Web Dispatcher, for the installation as such you require at least 1 GB of hard disk space in addition. For production use of the SAP Web Dispatcher, you need to reserve at least 5 GB.
  ○ If you install the ASCS instance with an integrated SAP Gateway, you require at least 1 GB of hard disk space in addition.

○ ERS instance for the ASCS instance (if required):
  Minimum 2 GB

○ Database Instance:
  For specific disk space information required for an SAP system installation on IBM Db2, see SAP Note 1707361.

**Note**
○ For safety reasons (system failure), the file systems must be physically distributed over several disks, or RAID-technology must be used.
○ To ensure a good performance of your production system, create separate file systems for the directories listed in [Required File Systems for IBM Db2 for Linux, UNIX, and Windows](#) [page 83].

○ Primary application server instance:
  Minimum 2 GB (SAP NetWeaver BW server: Minimum 30 GB)
<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RAM</strong></td>
<td>Only valid for 'Platform': AIX</td>
</tr>
<tr>
<td>i <strong>Note</strong></td>
<td><strong>AIX:</strong> Keep in mind that the operating system itself requires about 10% of the available RAM.</td>
</tr>
<tr>
<td></td>
<td>End of 'Platform': AIX</td>
</tr>
<tr>
<td></td>
<td>The following lists the RAM requirements for each SAP instance.</td>
</tr>
<tr>
<td></td>
<td>If you install several instances on one host, you have to add up the requirements accordingly.</td>
</tr>
<tr>
<td></td>
<td>• ABAP central services instance (ASCS instance)</td>
</tr>
<tr>
<td></td>
<td>Minimum 1 GB</td>
</tr>
<tr>
<td></td>
<td>If you install the ASCS instance with an integrated SAP Web Dispatcher, see SAP Note 2007212 for memory consumption in productive use.</td>
</tr>
<tr>
<td></td>
<td>• ERS instance for the ASCS instance (if required):</td>
</tr>
<tr>
<td></td>
<td>Minimum 1 GB</td>
</tr>
<tr>
<td></td>
<td>• Database Instance:</td>
</tr>
<tr>
<td></td>
<td>Minimum 2 GB</td>
</tr>
<tr>
<td></td>
<td>• Primary application server instance:</td>
</tr>
<tr>
<td></td>
<td>Minimum 3 GB (BW server: Minimum 2 GB)</td>
</tr>
<tr>
<td></td>
<td>• Additional application server instance:</td>
</tr>
<tr>
<td></td>
<td>Minimum 3 GB</td>
</tr>
<tr>
<td></td>
<td>• SAP Host Agent:</td>
</tr>
<tr>
<td></td>
<td>Minimum 1 GB</td>
</tr>
<tr>
<td></td>
<td>Only valid for 'Platform': HP-UX</td>
</tr>
<tr>
<td><img src="https://example.com/image.png" alt="image" /></td>
<td><strong>HP-UX:</strong> Refer to SAP Note 1112627 for the commands to display the RAM size on HP-UX.</td>
</tr>
<tr>
<td><img src="https://example.com/image.png" alt="image" /></td>
<td>End of 'Platform': HP-UX</td>
</tr>
<tr>
<td><img src="https://example.com/image.png" alt="image" /></td>
<td>Only valid for 'Platform': Linux</td>
</tr>
<tr>
<td><img src="https://example.com/image.png" alt="image" /></td>
<td><strong>Linux:</strong> Refer to SAP Note 1382721 for the commands to display the RAM size on Linux.</td>
</tr>
<tr>
<td><img src="https://example.com/image.png" alt="image" /></td>
<td>End of 'Platform': Linux</td>
</tr>
<tr>
<td><strong>AIX: Paging space</strong></td>
<td>You need hard disk drives with sufficient paging space. You can calculate the required paging space as follows:</td>
</tr>
<tr>
<td></td>
<td>For the latest information about recommended paging space, see SAP Note 1121904.</td>
</tr>
<tr>
<td>Requirement</td>
<td>Values and Activities</td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>HP-UX: Swap space</td>
<td>You need hard disk drives with sufficient space for swap. You can calculate the required swap space as follows:</td>
</tr>
<tr>
<td></td>
<td>2 * RAM, at least 20 GB</td>
</tr>
<tr>
<td></td>
<td><strong>SAP NetWeaver Process Integration 7.5 or higher:</strong> 2 * RAM or 80 GB, whichever is higher</td>
</tr>
<tr>
<td></td>
<td>For more information about HP-UX swap space recommendations and about how to set up swap space, see SAP Note <a href="https://apo.sap.com">1112627</a>.</td>
</tr>
<tr>
<td>Linux: Swap space</td>
<td>You need hard disk drives with sufficient space for swap. We recommend that you use the amount of swap space as described in SAP Note <a href="https://apo.sap.com">1597355</a>. You might decide to use more or less swap space based on your individual system configuration and your own experience during daily usage of the SAP system.</td>
</tr>
<tr>
<td>Oracle Solaris: Swap space</td>
<td>You need hard disk drives with sufficient space for swap. At least 20 GB are required. For more information, see SAP Note <a href="https://apo.sap.com">570375</a>.</td>
</tr>
</tbody>
</table>

### Verifying paging space size and kernel settings using `memlimits`

To verify paging space size and kernel settings, you can execute `memlimits` as follows:

1. Make sure that the SAPCAR program is available on the installation host. If SAPCAR is not available, you can download it from [https://launchpad.support.sap.com/#/softwarecenter](https://launchpad.support.sap.com/#/softwarecenter).
2. Make the SAPEXE.SAR archive available on the installation host. Either download it as described in [Downloading SAP Kernel Archives (Archive-Based Installation)](https://apo.sap.com?page=125) or take it from the kernel media, where this archive is contained in the folder K_<Kernel_Version>_<U/N>_<<OS>>/DBINDEP.
3. To unpack the file `memlimits`, enter the following command:

   ```bash
   SAPCAR -xvfg SAPEXE.SAR memlimits
   ```

4. Start `memlimits` using the following command:

   ```bash
   ./memlimits -l 20000
   ```

   In case of error messages, increase the paging space and rerun `memlimits` until there are no more errors.
### 3.4.2.3 Software Requirements

Every installation host must meet at least the software requirements listed in the following tables. Most of the requirements are valid for every installation host whereas some requirements are instance-specific and are marked accordingly.

**Software Requirements**

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database software / client software</td>
<td>Db2 database software / Db2 client software (automatically installed by SAP's installer, the Software Provisioning Manager) For more information about supported database platforms, see the Product Availability Matrix (PAM) at <a href="http://support.sap.com/pam">http://support.sap.com/pam</a>.</td>
</tr>
<tr>
<td><strong>Caution</strong></td>
<td>- For the installation of your SAP system, <strong>only</strong> the <strong>English version</strong> of the Db2 database is supported. &lt;br&gt;- You must <strong>only</strong> use the Db2 software that is provided on the SAP installation media.</td>
</tr>
</tbody>
</table>

**AIX: Operating system version**  

Your operating system platform must be 64-bit.  

- Check the Product Availability Matrix (PAM) at [http://support.sap.com/pam](http://support.sap.com/pam) for supported operating system versions.  
- Contact your OS vendor for the latest OS patches.  
- Minimal OS requirements for the specific SAP Kernel releases are listed in SAP Note 1780629.  
- You require at least AIX 6.1 TL7 SP10 to be able to run the installer.  
<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HP-UX:</strong> Operating system version</td>
<td>Your operating system platform must be 64-bit.</td>
</tr>
<tr>
<td></td>
<td>Check the Product Availability Matrix (PAM) at <a href="http://support.sap.com/pam">http://support.sap.com/pam</a> for supported operating system versions.</td>
</tr>
<tr>
<td></td>
<td>To check the operating system version on your installation hosts, use the following command:</td>
</tr>
<tr>
<td></td>
<td><code>uname -r</code></td>
</tr>
<tr>
<td></td>
<td>See SAP Note <a href="http://support.sap.com/pam">939891</a> for information about support time frames of HP-UX.</td>
</tr>
<tr>
<td></td>
<td>The installation with IBM Db2 V9.7 and higher is only supported with HP-UX Itanium. As of IBM Db2 V9.7, the installation on the HP-UX platform PA_RISC is not supported.</td>
</tr>
<tr>
<td></td>
<td>For more information about Db2-specific software requirements, see the IBM Web page <a href="http://www.ibm.com/support/docview.wss?uid=swg27038033">System requirements for IBM Db2 for Linux, UNIX, and Windows</a>.</td>
</tr>
<tr>
<td><strong>Linux:</strong> Operating system version</td>
<td>Your operating system platform must be 64-bit.</td>
</tr>
<tr>
<td></td>
<td>Check the Product Availability Matrix (PAM) at <a href="http://support.sap.com/pam">http://support.sap.com/pam</a> for supported operating system versions.</td>
</tr>
<tr>
<td></td>
<td>Contact your OS vendor for the latest OS patches.</td>
</tr>
<tr>
<td></td>
<td>To check the operating system version on your installation hosts, use the following command:</td>
</tr>
<tr>
<td></td>
<td><code>cat /etc/*-release</code></td>
</tr>
<tr>
<td></td>
<td>For more information about Db2-specific software requirements, see the IBM Web page <a href="http://www.ibm.com/support/docview.wss?uid=swg27038033">System requirements for IBM Db2 for Linux, UNIX, and Windows</a>.</td>
</tr>
<tr>
<td><strong>Oracle Solaris:</strong> Operating system version</td>
<td>Your operating system platform must be 64-bit.</td>
</tr>
<tr>
<td></td>
<td>Check the Product Availability Matrix (PAM) at <a href="http://support.sap.com/pam">http://support.sap.com/pam</a> for supported operating system versions.</td>
</tr>
<tr>
<td></td>
<td>To check the operating system version on your installation hosts, use the following command:</td>
</tr>
<tr>
<td></td>
<td><code>/bin/uname -r</code></td>
</tr>
<tr>
<td></td>
<td>For more information about Db2-specific software requirements, see the IBM Web page <a href="http://www.ibm.com/support/docview.wss?uid=swg27038033">System requirements for IBM Db2 for Linux, UNIX, and Windows</a>.</td>
</tr>
<tr>
<td>Requirement</td>
<td>Values and Activities</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>SAP Kernel Releases and Versions</td>
<td>For more information about release and roadmap information for the kernel versions and how this relates to SAP NetWeaver support packages, including important notes on downward compatibility and release dates, see the document Understanding Kernel Releases for the SAP NetWeaver AS ABAP at <a href="https://archive.sap.com/documents/docs/DOC-54170">https://archive.sap.com/documents/docs/DOC-54170</a>. To use regular Software Provisioning Manager (SWPM\textless Version\textgreater .SAR) with SAP kernel 7.49 or higher on RHEL 6 or SLES 11 or Oracle Linux 6, you must install the required \texttt{libstdc++} RPM packages. For more information, see SAP Note 2195019.</td>
</tr>
<tr>
<td>AIX: Kernel parameters</td>
<td>To adjust AIX Virtual Memory Management settings, see SAP Note 973227.</td>
</tr>
<tr>
<td>HP-UX: Kernel parameters</td>
<td>To run an SAP system, make sure that you check and, if necessary, modify the HP-UX kernel.</td>
</tr>
<tr>
<td><strong>Caution</strong></td>
<td>We recommend that a UNIX system administrator performs all kernel modifications.</td>
</tr>
<tr>
<td>Proceed as follows:</td>
<td></td>
</tr>
<tr>
<td>1. Check SAP Note 172747 for recommendations on current HP-UX kernel parameters.</td>
<td></td>
</tr>
<tr>
<td><strong>Caution</strong></td>
<td>If a kernel value is already larger than the one suggested in the SAP Note, do not automatically reduce it to match the SAP requirement. If a kernel value is already larger than the one suggested in the SAP Note, do not automatically reduce it to match the SAP requirement. You have to analyze the exact meaning of such a parameter and, if required, to reduce the parameter value. In some cases this might improve the performance of your SAP applications.</td>
</tr>
<tr>
<td>2. If necessary, modify the kernel parameters in one of the following ways:</td>
<td></td>
</tr>
<tr>
<td>○ Manually, as described in SAP Note 172747.</td>
<td></td>
</tr>
<tr>
<td>○ Interactively, using the HP-UX System Administrator Manager (SAM) or System Management Homepage (SMH).</td>
<td></td>
</tr>
<tr>
<td>After the installation, check the kernel using the \texttt{db2osconf} utility, which provides recommendations for appropriate kernel configuration parameters. The \texttt{db2osconf} utility suggests values that are:</td>
<td></td>
</tr>
<tr>
<td>● Based on the size of your system</td>
<td></td>
</tr>
<tr>
<td>● High enough for a given system that they can accommodate most reasonable workloads</td>
<td></td>
</tr>
<tr>
<td>You can use \texttt{db2osconf} only in a Db2 64-bit environment. On HP-UX, no authorization is required. To make the changes recommended by the \texttt{db2osconf} utility, you must have root access.</td>
<td></td>
</tr>
<tr>
<td>Requirement</td>
<td>Values and Activities</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Linux:</strong> Kernel parameters</td>
<td>Check SAP Note <a href="https://www.sap.com">2369910</a> for Linux kernel versions certified by SAP.</td>
</tr>
</tbody>
</table>
To check the Linux kernel parameters for your Linux distribution, see one of the following SAP Notes:    
- RHEL4: SAP Note [722273](https://www.sap.com)  
- RHEL5: SAP Note [1048303](https://www.sap.com)  
- RHEL6: SAP Note [1496410](https://www.sap.com)  
- RHEL7: SAP Note [2002167](https://www.sap.com)  
- SLES9: SAP Note [797084](https://www.sap.com)  
- SLES10: SAP Note [958253](https://www.sap.com)  
- SLES 11: SAP Note [1310037](https://www.sap.com)  
- SLES 12: SAP Note [1984787](https://www.sap.com)  |
| **Oracle Solaris:** Kernel parameters | To run an SAP system, you must check and, if necessary, modify the Oracle Solaris kernel parameters or resource controls.                      |  
- Oracle Solaris 9: SAP Note [395438](https://www.sap.com)  
- Oracle Solaris 10: SAP Note [724713](https://www.sap.com)  
- Oracle Solaris 11: SAP Note [1797712](https://www.sap.com)  
After the installation, check the kernel using the `db2osconf` utility, which provides recommendations for appropriate kernel configuration parameters. The `db2osconf` utility suggests values that are:  
- Based on the size of your system  
- High enough for a given system that they can accommodate most reasonable workloads  
You can use `db2osconf` only in a Db2 64-bit environment. On Db2 for Oracle Solaris, you must have root access or be a member of the sys group. |
| **HP-UX:** OS patches | To check the minimum required OS patches, see SAP Note [837670](https://www.sap.com).                                                                 |  
| **Oracle Solaris:** OS patches | Check the relevant SAP Note for required Oracle Solaris patches:                                                                                     |  
- Sun Solaris 9 on SPARC: SAP Note [550585](https://www.sap.com)  
- Sun Solaris 10 on SPARC: SAP Note [832871](https://www.sap.com)  
- Oracle Solaris 10 on x64: SAP Note [908334](https://www.sap.com)  
- Oracle Solaris 11: SAP Note [1797712](https://www.sap.com)  |
<p>| <strong>AIX:</strong> National Language Support (NLS) | Make sure that National Language Support (NLS) and corresponding locales are installed.                                                              |</p>
<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
</table>
| **HP-UX: National Language Support (NLS)** | Make sure that National Language Support (NLS) and corresponding locales are installed.  
You can check this as follows:  
- Enter the following commands to check whether National Language Support (NLS) is installed:  
  `swlist -v | grep -i nls`  
The output should contain the string `NLS-AUX ...`  
- Enter the following commands to check which locales are available:  
  `locale -a`  
The following files must be available: `de_DE.iso88591`, `en_US.iso88591`. |
| **Linux: National Language Support (NLS)** | Make sure that National Language Support (NLS) and corresponding locales are installed.  
You can check this as follows:  
- Ensure that the required locales such as the following are available:  
  `de_DE`, `en_US`  
- Check SAP Note 187864 for information about corrected operating system locales and SAP blended Code Pages. |
| **Oracle Solaris: National Language Support (NLS)** | Make sure that National Language Support (NLS) and corresponding locales are installed.  
Enter the following command to check which locales are available:  
`locale -a`  
The following locale must be available: `en_US.ISO8859-1`. |
| **System language** | For the installation, you must choose English as the operating system language on all hosts that run SAP software. |
| **SAP Kernel 7.40 and Higher: IP Multicast Configuration** | Make sure that you have applied the operating system patches required for IP Multicast Configuration. For more information, see SAP Note 1931675. |
### Other Requirements

Every installation host must meet at least the requirements listed in the following tables. Most of the requirements are valid for every installation host whereas some requirements are instance-specific and are marked accordingly.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Values and Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Web Browser</td>
<td>Make sure that you have at least one of the following web browsers installed on the host where you run the installer GUI:</td>
</tr>
<tr>
<td></td>
<td>- Microsoft Internet Explorer 11 or higher</td>
</tr>
<tr>
<td></td>
<td>- Microsoft Edge</td>
</tr>
<tr>
<td></td>
<td>- Mozilla Firefox</td>
</tr>
<tr>
<td></td>
<td>- Google Chrome</td>
</tr>
<tr>
<td></td>
<td>Always use the latest version of these web browsers.</td>
</tr>
<tr>
<td></td>
<td>You need a web browser to be able to run the SL Common GUI, and to display the Evaluation Form and send it to SAP.</td>
</tr>
<tr>
<td>AIX: Additional software</td>
<td>Make sure that the following additional file sets are installed:</td>
</tr>
<tr>
<td></td>
<td>- bos.adt = Base Application Development</td>
</tr>
<tr>
<td></td>
<td>- bos.perf = performance and diagnostics tools</td>
</tr>
<tr>
<td></td>
<td>- perfagent.tools = performance monitoring tools</td>
</tr>
<tr>
<td></td>
<td>- bos.perf.libperfstat = Performance Statistics Library</td>
</tr>
<tr>
<td>Host name</td>
<td>To find out physical host names, open a command prompt and enter hostname.</td>
</tr>
<tr>
<td></td>
<td>For more information about the allowed host name length and characters allowed for SAP system instance hosts, see SAP Note 611361.</td>
</tr>
<tr>
<td></td>
<td>Only valid for ‘Platform’: HP-UX</td>
</tr>
<tr>
<td></td>
<td>For HP-UX, see SAP Note 1503149 in addition.</td>
</tr>
<tr>
<td></td>
<td>End of ‘Platform’: HP-UX</td>
</tr>
<tr>
<td></td>
<td>If you want to use virtual host names, see SAP Note 962956.</td>
</tr>
</tbody>
</table>
### Requirement | Values and Activities
--- | ---
Login shell | The installer only prompts you for this parameter if you use a login shell other than the recommended C shell (csh).
For more information, see SAP Note 202227.
Only valid for 'Platform': HP-UX
For HP-UX, see SAP Note 1038842 in addition.
End of 'Platform': HP-UX

### SAP Host Agent installation:
- Make sure that `/bin/false` can be used as a login shell.
- Only valid for 'Platform': AIX
AIX only: Add `/bin/false` to the list of valid login shells (attribute `shells`) in `/etc/security/login.cfg`.
End of 'Platform': AIX

### HP-UX: Mount and file system configuration
For recommendations about block size and mount option configuration, see SAP Note 1077887.

### Required additional shell
Make sure that the korn shell (ksh) is installed on the hosts where you install the SAP system. If you perform a system copy, make sure that the korn shell (ksh) is installed on the target system host.

### Shared file systems for decentralized systems
If application servers are installed decentralized, a "shared" file system must be installed, for example Network File System (NFS).

### AIX: C++ Runtime environment
Minimal C++ runtime requirements for the specific SAP Kernel releases are listed in SAP Note 1780629.

### Linux: C compiler
Make sure that the C compiler gcc is installed.

### 3.5 Planning User and Access Management

You have to plan how to configure user and access management for the SAP system to be installed.

Before you add a newly installed SAP system to your system landscape, you must decide which kind of user management you want to use:
- Central User Administration (CUA)
- An LDAP directory as the data source for user data
## Procedure

To specify the initial data source of the User Management Engine (UME), proceed as described in *Specifying the Initial Data Source of the User Management Engine* [page 143].

## More Information

For more information about configuring the user management of your SAP system to be installed, see the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quicklink</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0</td>
<td><img src="http://help.sap.com/nwmobile71" alt="Application Help ➤ SAP NetWeaver Library: Function-Oriented View ➤ Security ➤ Identity Management ➤ Identity Management of the Application Server ABAP" /></td>
</tr>
<tr>
<td>SAP NetWeaver 7.1 including Enhancement Package 1 for Banking Services from SAP 5.0 and 6.0</td>
<td><img src="http://help.sap.com/nwmobile71" alt="Application Help ➤ SAP NetWeaver Library: Function-Oriented View ➤ Security ➤ Identity Management ➤ Identity Management of the Application Server ABAP" /></td>
</tr>
</tbody>
</table>

---

**Note**

Since the SAP NetWeaver Mobile 7.1 Library is the only available SAP Library for ABAP systems based on SAP NetWeaver 7.1, in this guide we always refer to it also for SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0.
SAP Release and SAP Library Quicklink

- SAP NetWeaver 7.3
  http://help.sap.com/nw73
- SAP NetWeaver 7.3 including Enhancement Package 1
  http://help.sap.com/nw731
- SAP NetWeaver 7.4
  http://help.sap.com/nw74
- SAP NetWeaver 7.5
  http://help.sap.com/nw75
- SAP NetWeaver Application Server for ABAP 7.51 innovation package
  https://help.sap.com/nw751abap
- SAP NetWeaver AS for ABAP 7.52
  https://help.sap.com/nw752abap

SAP Library Path (Continued)

- Application Help
- SAP NetWeaver Library: Function-Oriented View
- Security
- Identity Management
- User and Role Administration of Application Server ABAP
- Configuration of User and Role Administration
- Directory Services
- LDAP Connector

3.6 Basic Installation Parameters

The installer prompts for input parameters during the Define Parameters phase of the installation.

You can install your SAP system either in Typical or Custom mode:

- **Typical**
  If you choose Typical, the installation is performed with default settings. This means that the installer prompts you only for a small selection of installation parameters. These parameters include at least the following:
  - SAP system ID and database connectivity parameters
  - Master password
  - SAP system profile directory – only for systems with instances on separate hosts
  - **SAP systems based on SAP NetWeaver 7.40 and higher**: Individual encryption key for the secure storage

  For more information about the installation parameters, see the corresponding tables below in this document. If you want to change any of the default settings, you can do so on the Parameter Summary screen.

- **Custom**
  If you choose Custom, you are prompted for all parameters. At the end, you can still change any of these parameters on the Parameter Summary screen.

  **Note**
  You cannot change from Custom to Typical mode or from Typical to Custom mode on the Parameter Summary screen.
If you want to install an ASCS instance with an integrated SAP Web Dispatcher [page 37], you must choose Custom. Otherwise, you are not prompted for the SAP Web Dispatcher installation parameters [page 82] during the Define Parameters phase of the ASCS instance installation.

If you want to install an ASCS instance with an integrated Gateway [page 39], you must choose Custom. Otherwise, you are not prompted for the SAP Gateway installation during the Define Parameters phase of the ASCS instance installation.

The tables in the sections below list the basic SAP system installation parameters that you need to specify before installing your SAP system. For all other installation parameters, use the tool help on the installer screens.

### Related Information

- SAP System Parameters [page 64]
- SAP System Database Parameters [page 74]
- Additional Parameters when Installing SAP Process Integration 7.5 or SAP Solution Manager 7.2 [page 79]
- Additional Parameters When Using a Stack Configuration File (Optional) [page 80]
- Parameters for Additional Components to be Included in the ASCS Instance (Optional) [page 82]

### 3.6.1 SAP System Parameters

The tables in this section lists the basic SAP system installation parameters that you need to specify before installing your SAP system. For all other installation parameters, use the tool help on the installer screens.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unicode System</td>
<td>Every new installation of an SAP system is Unicode.</td>
</tr>
<tr>
<td></td>
<td><strong>SAP systems based on SAP NetWeaver 7.1 to 7.4:</strong></td>
</tr>
<tr>
<td></td>
<td>You can only deselect this option if you perform the target system installation in the context of a system copy for a non-Unicode SAP system that has been upgraded to the current release.</td>
</tr>
<tr>
<td></td>
<td><strong>SAP systems based on SAP NetWeaver 7.5 or higher</strong> are Unicode only.</td>
</tr>
<tr>
<td></td>
<td>If you install an additional application server instance in an existing non-Unicode system (that has been upgraded to the current release), the additional application server instance is installed automatically as a non-Unicode instance. The installer checks whether a non-Unicode system exists and chooses the right executables for the system type.</td>
</tr>
</tbody>
</table>
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP System ID &lt;SAPSID&gt;</td>
<td>The SAP system ID (&lt;SAPSID&gt;) identifies the entire SAP system. The installer prompts you for the &lt;SAPSID&gt; when you execute the <strong>first</strong> installation option to install a new SAP system. If there are further installation options to be executed, the installer prompts you for the <strong>profile directory</strong>. For more information, see the description of the parameter <strong>SAP System Profile Directory</strong>.</td>
</tr>
</tbody>
</table>

**Example**

This prompt appears when you install the ASCS instance, which is the first instance to be installed in a distributed system.

**Caution**

Choose your SAP system ID carefully since renaming requires considerable effort.

Make sure that your SAP system ID:

- Is unique throughout your organization. Do not use an existing <SAPSID> when installing a new SAP system.
- Consists of exactly three alphanumeric characters
- Contains only uppercase letters
- Has a letter for the first character
- Does not include any of the reserved IDs listed in SAP Note [1979280](https://help.sap.com/docs/1979280).
- If you want to install an additional application server instance, make sure that no Gateway instance with the same SAP System ID (SAPSID) exists in your SAP system landscape.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP System Instance Numbers</td>
<td>Technical identifier for internal processes. It consists of a two-digit number from 00 to 97. The instance number must be unique on a host. That is, if more than one SAP instance is running on the same host, these instances must be assigned different numbers. If you do not enter a specific value, the instance number is set automatically to the next free and valid instance number that has not yet been assigned to the SAP system to be installed or to SAP systems that already exist on the installation host. To find out instance numbers of SAP systems that already exist on the installation host, look for subdirectories ending with <code>&lt;Instance Number&gt;</code> of local (not mounted) <code>/usr/sap/&lt;SAPSID&gt;</code> directories. For more information about the naming of SAP system instances, see SAP Directories [page 108].</td>
</tr>
</tbody>
</table>

⚠️ Caution  

**AIX only:** If you are using NIM Service Handler (NIMSH), do not use 01 or 02 for the instance number. The installer uses the instance number for the internal message server port `39<Instance Number>`. The NIM client daemon uses reserved ports 3901 and 3902.

End of 'Platform': AIX

**Only valid for 'Platform': HP-UX**

⚠️ Caution  

**HP-UX only:** Do not use:  
- 75 for the instance number because this number is already used by the operating system. For more information, see SAP Note [29972].  
- 02 as the instance number because this number is used to determine the port number for report `RSLGCOLL`, which is `14<Instance Number>` by default. However, port 1402 is already used by the OS process `rstlisten`. If you still decide to use 02 as the instance number, the instance fails to start during the installation process. You then have to manually change the port number for report `RSLGCOLL` to continue with the installation. For more information, see Running the Installer [page 147].

End of 'Platform': HP-UX
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Host Name</td>
<td>Virtual host name (network name) of the SAP&lt;SAPSID&gt; cluster group</td>
</tr>
<tr>
<td></td>
<td>You can assign a virtual host name to an SAP instance in one of the following ways:</td>
</tr>
<tr>
<td></td>
<td>● You can assign a virtual host name for the instance to be installed, by specifying it in the &lt;Instance Name&gt; Host Name field of the &lt;Instance Name&gt; Instance screen. Then this instance is installed with this virtual host name.</td>
</tr>
<tr>
<td></td>
<td>● Alternatively you can assign virtual host names also by starting the installer with the SAPINST_USE_HOSTNAME property. For more information, see Running the Installer [page 147].</td>
</tr>
<tr>
<td></td>
<td><strong>i Note</strong></td>
</tr>
<tr>
<td></td>
<td>To assign a virtual host name to a database instance, you must run the installer with the SAPINST_USE_HOSTNAME property.</td>
</tr>
<tr>
<td></td>
<td>After the installation has completed, all application servers can use this virtual host name to connect to the instance. If you do not provide the virtual host name, the instance is installed automatically using the physical host name of the host where you run the installer.</td>
</tr>
<tr>
<td></td>
<td>You must have already reserved the virtual host name (network name) and its IP address on a DNS server before you run the installer. For more information, see Using Virtual Host Names [page 117].</td>
</tr>
<tr>
<td></td>
<td><strong>i Note</strong></td>
</tr>
<tr>
<td></td>
<td>Fully qualified host names, IPv4, IPv6 are not accepted as virtual host names.</td>
</tr>
<tr>
<td>SAP Process</td>
<td>If you want to install the primary application server instance of the Java system on a host different from the host of the primary application server instance of the ABAP system, then you must specify the host of the Java primary application server instance during the Define Parameters phase of the primary application server instance installation of the ABAP system.</td>
</tr>
<tr>
<td>Integration (PI)</td>
<td>This is to set up the connection between the ABAP and the Java system.</td>
</tr>
<tr>
<td>7.5, SAP Solution</td>
<td></td>
</tr>
<tr>
<td>Manager 7.2:</td>
<td>Application Server Gateway Communication Setup</td>
</tr>
<tr>
<td>SAP System Profile</td>
<td><code>.googlecode(773,759,1000,788)</code>&lt;sapmnt&gt;/&lt;SAPSID&gt;/profile or /usr/sap/&lt;SAPSID&gt;/SYS/profile</td>
</tr>
<tr>
<td>Profile Directory</td>
<td>The installer retrieves parameters from the SAP system profile directory of an existing SAP system. SAP profiles are operating system files that contain instance configuration information.</td>
</tr>
<tr>
<td></td>
<td>The installer prompts you to enter the location of the profile directory when the installation option that you execute is not the first one belonging to your SAP system installation, for example if you are installing a distributed system or an additional application server instance to an existing SAP system. See also the description of the parameters SAP System ID and Database ID.</td>
</tr>
<tr>
<td></td>
<td>/usr/sap/&lt;SAPSID&gt;/SYS/profile is the soft link referring to /&lt;sapmnt&gt;/&lt;SAPSID&gt;/profile.</td>
</tr>
</tbody>
</table>
### Master Password

Common password for all users that are created during the installation:

- Operating system users (for example `<sapid>adm`)

**Caution**

If you did not create the operating system users manually before the installation, the installer creates them with the common master password (see Operating System Users). In this case, make sure that the master password meets the requirements of your operating system.

- ABAP users: SAP*, DDIC, and EARLYWATCH.
- Secure Store key phrase

**SAP systems based on SAP NetWeaver 7.4 and Higher:** For more information, see line *Key Phrase for Secure Store Settings* and line *Individual Encryption Key for the Secure Storage* in this table.

### Basic Password policy

The master password must meet the following requirements:

- It must be 8 to 14 characters long
- It must contain at least one letter (a-z, A-Z)
- It must contain at least one digit (0-9)
- It must not contain `\` (backslash) or `"` (double quote).

Depending on the installation option, additional restrictions may apply.

---

### Message Server Access Control List

You can specify if you want to have a message server Access Control List (ACL) created.

The ACL is created as a file in the `/sapmnt/<SAPSID>/global` directory. If it exists, it defines the hosts from which the message server accepts requests.

**Caution**

Only trigger the creation of this file if you do not plan to install any additional instances for this system. With the creation of this ACL, you overwrite existing settings and prevent instances from being installed on additional hosts. If you decide to install an additional instance later, you need to remove this file manually before the installation and create it again after the installation of the additional instance.

For more information, see the information about `ms/acl_info` in SAP Notes 1495075 and 826779.
### Parameter | Description
--- | ---
SAP systems based on SAP NetWeaver 7.4 and Higher only: Individual Encryption Key for the Secure Storage  | You can set a randomly generated individual encryption key for the secure storage in the file system and the secure storage in the database. If you skip this step, the system is installed with a default key which provides obfuscation only, but it can be changed later.

- For more information on the secure storage in the file system, see the SAP Library - depending on the SAP NetWeaver release your SAP system is based on - at:
  - [https://help.sap.com/nw751abap](https://help.sap.com/nw751abap)
  - [https://help.sap.com/nw752abap](https://help.sap.com/nw752abap)

- For more information on the secure storage in the database, see the SAP Library - depending on the SAP NetWeaver release your SAP system is based on - at:
  - [https://help.sap.com/nw751abap](https://help.sap.com/nw751abap)
  - [https://help.sap.com/nw752abap](https://help.sap.com/nw752abap)

DNS Domain Name for SAP System  | If you want to use HTTP-based URL frameworks such as Web Dynpro applications, you have to specify the DNS domain name for the SAP system.

The DNS Domain Name is used to calculate the Fully Qualified Domain Name (FQDN), which is configured in profile parameter `SAPLOCALHOSTFULL`. FQDN is the fully qualified domain name for an IP address. It consists of the host name and the domain name:

```plaintext
<Host_Name>.<Domain_Name>
```

The DNS Domain Name is needed to define the URLs for the ABAP application servers. It is appended to the server name to calculate the FQDN.

**Example**

If your application server host is called `kirk.wdf.sap.com`, the DNS Domain Name is `wdf.sap.com`.

SAP Host Agent Upgrade (Optional)  | If there already exists an SAP Host Agent on the installation host, the installer asks you if you want to upgrade it to a newer patch level version. If you want the existing version to be upgraded, you must provide the new target version of the `SAPHOSTAGENT<Version>.SAR` archive.

For more information, see [Downloading SAP Kernel Archives (Archive-Based Installation)](page 125)
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| ABAP Message Server Port             | **Caution** The message server port number must be unique on the host where the message server for the SAP system is running. If there are several message servers running on one host, the message server ports must all be unique. If you do not specify a value, the default port number is used.  

**ABAP Message Server Port**  
There is an external message server port and an internal message server port.  
The ABAP message server uses both the internal and the external message server ports. The default profile contains the configuration for both message server ports.  
The external message server port uses the parameter `rdisp/msserv` with default value `36<ABAP_Message_Server_Instance_Number>`.  
The internal message server port uses the parameter `rdisp/msserv_internal` with default value `39<ABAP_Message_Server_Instance_Number>`.  
During the installation of an SAP system from scratch or an additional application server instance to an existing SAP system, the message server is configured to only accept secure connections. The DEFAULT.PFL profile parameter `system/secure_communication` is set to ON (`system/secure_communication = ON`) if the kernel supports secure connections to the message server. For more information, see SAP Note 2040644. |
Operating System Users

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System Users and Groups</td>
<td>The installer processes the operating system users as follows:</td>
</tr>
<tr>
<td></td>
<td>• If the operating system users do not exist, the installer creates the following users:</td>
</tr>
<tr>
<td></td>
<td>○ The SAP system administrator user <code>&lt;sapsid&gt;adm</code></td>
</tr>
<tr>
<td></td>
<td>○ Database administrator users</td>
</tr>
<tr>
<td></td>
<td>The installer sets the master password for these users by default. You can overwrite and change the passwords either by using the parameter mode Custom or by changing them on the parameter summary screen.</td>
</tr>
<tr>
<td></td>
<td>• If the operating system users already exist, the installer prompts you for the existing password, except if the password of these users is the same as the master password.</td>
</tr>
<tr>
<td></td>
<td>• Make sure that the user ID and group ID of these operating system users are unique and the same on each relevant application server instance host.</td>
</tr>
<tr>
<td></td>
<td>The <code>sapinst_instdir</code> directory belongs to a group named <code>sapinst</code>. If this group is not available, it is created automatically as a local group. For security reasons, we recommend removing the operating system users from the group <code>sapinst</code> after the execution of the installer has completed.</td>
</tr>
<tr>
<td></td>
<td>During the Define Parameters phase of the installer, you can specify that the operating system users are to be removed automatically from the group <code>sapinst</code> after the execution of the installer has completed.</td>
</tr>
<tr>
<td></td>
<td>For more information about the group <code>sapinst</code>, see Creating Operating System Users and Groups [page 102].</td>
</tr>
<tr>
<td></td>
<td>For more information about the <code>sapinst_instdir</code> directory, see Useful Information about the Installer [page 154].</td>
</tr>
</tbody>
</table>

User Management Engine Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Administrator User</td>
<td>The installer creates this user in the ABAP system.</td>
</tr>
<tr>
<td></td>
<td>After the installation, this user is available both in the ABAP and in the Java system.</td>
</tr>
<tr>
<td></td>
<td>The installer sets the user name <code>J2EE_ADMIN</code> and the master password by default.</td>
</tr>
<tr>
<td></td>
<td>If required, you can choose another user name and password according to your requirements.</td>
</tr>
</tbody>
</table>

*Note*

This user is only created during the installation of the application server ABAP for an SAP NetWeaver 7.5 Process Integration (PI) system or for an SAP Solution Manager 7.2 system.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Guest User</td>
<td>This user is for employees who do not belong to a company or who have registered as company users and who are waiting for approval. Guest users belong to the default group Authenticated Users. The installer creates this user in the ABAP system. After the installation, it is available both in the ABAP and in the Java system. The installer sets the user name J2EE_GUEST and the master password by default. If required, you can choose another user name and password according to your requirements. For more information about supported UME data sources and change options, see SAP Note 718383.</td>
</tr>
<tr>
<td>Communication User</td>
<td>The installer creates this user in the ABAP system. After the installation, it is available both in the ABAP and in the Java system. This user is used for the communication between the ABAP system and the Java system. The installer sets the user name SAPJSF and the master password by default. If required, you can choose another user name and password according to your requirements. For more information about supported UME data sources and change options, see SAP Note 718383.</td>
</tr>
</tbody>
</table>
System Landscape Directory

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>SLD Destination for the System</td>
<td>The System Landscape Directory (SLD) registers the systems and the installed software of your entire system landscape.</td>
</tr>
<tr>
<td></td>
<td>You can choose between the following options:</td>
</tr>
<tr>
<td></td>
<td>● Register in existing SLD</td>
</tr>
<tr>
<td></td>
<td>Choose this option to register the SAP system you are installing in an existing SAP System Landscape Directory (SLD) by specifying the SLD connection parameters listed below in this table.</td>
</tr>
<tr>
<td></td>
<td>● No SLD destination</td>
</tr>
<tr>
<td></td>
<td>Choose this option if you do not want to register the SAP system you are installing in an existing SAP System Landscape Directory (SLD).</td>
</tr>
<tr>
<td></td>
<td>You then have to configure the SLD destination manually after the installation has finished.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Performing Post-Installation Steps for the ABAP Application Server [page 177]</td>
</tr>
<tr>
<td>SLD Host</td>
<td>The host name of the existing SLD.</td>
</tr>
<tr>
<td>SLD HTTP(S) Port</td>
<td>HTTP port of the SAP system based on AS Java on which the System Landscape Directory (SLD) resides. The following naming convention applies:</td>
</tr>
<tr>
<td></td>
<td>5&lt;Primary_Application_Server_Instance_Number&gt;00.</td>
</tr>
</tbody>
</table>

**Example**

If the primary application server instance number of the AS Java on which the System Landscape Directory (SLD) resides is 01, the SLD HTTP Port is 50100.
## 3.6.2 SAP System Database Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database ID &lt;DBSID&gt;</td>
<td>The &lt;DBSID&gt; identifies the database instance. The installer prompts you for the &lt;DBSID&gt; when you are installing the database instance. The &lt;DBSID&gt; can be the same as the &lt;SAPSID&gt;.</td>
</tr>
<tr>
<td>Caution</td>
<td>Choose your database ID carefully. Renaming is difficult and requires you to reinstall the SAP system.</td>
</tr>
<tr>
<td></td>
<td>• If you want to install a new database:</td>
</tr>
<tr>
<td></td>
<td>Make sure that your database ID:</td>
</tr>
<tr>
<td></td>
<td>◦ Is unique throughout your organization</td>
</tr>
<tr>
<td></td>
<td>◦ Consists of exactly three alphanumeric characters</td>
</tr>
<tr>
<td></td>
<td>◦ Contains only uppercase letters</td>
</tr>
<tr>
<td></td>
<td>◦ Has a letter for the first character</td>
</tr>
<tr>
<td></td>
<td>◦ Does not include any of the reserved IDs listed in SAP Note 1979280</td>
</tr>
<tr>
<td>Db2 instance owner db2&lt;dbsid&gt;</td>
<td>&lt;db2&lt;dbsid&gt; has the Db2 system administration authorities and belongs to group db&lt;dbsid&gt;adm, which has DB2 SYSADM authorities. By default, user &lt;db2&lt;dbsid&gt; is a member of group db&lt;dbsid&gt;adm.</td>
</tr>
<tr>
<td>ABAP database schema</td>
<td>This is the name of the database schema where ABAP tables are created. The default name for the ABAP database schema is sap&lt;sapsid&gt;. You can change the name of the ABAP database schema during the dialog phase of the installer, but the name must still conform to the pattern sapxxx, where xxx can be replaced by any alphanumeric characters.</td>
</tr>
<tr>
<td>ABAP database connect user</td>
<td>The default name for the ABAP connect user is sap&lt;sapsid&gt;. You can change the name of the ABAP connect user during the dialog phase of the installer, but the name must still conform to the pattern sapxxx, where xxx can be replaced by any alphanumeric characters.</td>
</tr>
<tr>
<td>ID of the db&lt;dbsid&gt;adm group</td>
<td>i Note</td>
</tr>
<tr>
<td></td>
<td>In a multi-partitioned database environment, the group ID must be the same on all database partition servers.</td>
</tr>
<tr>
<td>Parameters</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>db&lt;dbsid&gt;adm group</td>
<td>Members of this group have DB2 SYSADM authorities. By default, user db2&lt;dbsid&gt; is a member of this group.</td>
</tr>
</tbody>
</table>
| ID of the db<dbsid>ctl group | i Note  
In a multi-partitioned database environment, the group ID **must** be the same on all database partition servers. |
| db<dbsid>ctl group | Members of this group have DB2 SYSCTRL authorities. By default, <sapsid>adm is a member of this group. |
| ID of the db<dbsid>mnt group | i Note  
In a multi-partitioned database environment, the group ID **must** be the same on all database partition servers. |
| db<dbsid>mnt group | Members of this group have DB2 SYMAINT authorities. |
| ID of the db<dbsid>mon group | i Note  
In a multi-partitioned database environment, the group ID **must** be the same on all database partition servers. |
| db<dbsid>mon group | Members of this group have DB2 SYSMON authorities.  
By default, sap<sapsid> (the ABAP database connect user) is a member of this group. |
| Database communication port | The Db2 Communication Port is used for TCP/IP communication between the database server and remote Db2 clients.  
In a standard system installation and for the database instance in a distributed installation, the installer always proposes **5912** as default value.  
i Note  
The installer requests this value during the database instance installation. |
<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>First port</strong></td>
<td>The database partition servers communicate using registered services. During the installation a port range is assigned for this communication. The installer proposes default values. You must make sure that these values correspond to the values of your database partition servers. If necessary, adapt them according to your settings.</td>
</tr>
<tr>
<td><strong>Caution</strong></td>
<td>The value for first port <strong>must</strong> be the same for all database partition servers. The range between first port and last port must correspond to the maximum number of partitions on a database partition server.</td>
</tr>
<tr>
<td><strong>Last port</strong></td>
<td>The database partition servers communicate using registered services. During the installation a port range is assigned for this communication. The installer proposes default values. You must make sure that these values correspond to the values of your database partition servers. If necessary, adapt them according to your settings.</td>
</tr>
<tr>
<td><strong>Caution</strong></td>
<td>The range between first port and last port must correspond to the maximum number of partitions on a database partition server.</td>
</tr>
<tr>
<td><strong>Database partition group mapping</strong></td>
<td>The installer only asks this parameter if you are performing a heterogeneous system copy and if the following condition is met: You run the installer to install the target database in a multi-partitioned database environment using the R3Load method. You can assign the displayed node groups to a database partition.</td>
</tr>
<tr>
<td><strong>Drive for diagnostic data</strong></td>
<td>Location of the db2diag.log that contains diagnostic data required in case of, for example, a database crash.</td>
</tr>
<tr>
<td><strong>Create tablespaces during the installation procedure</strong></td>
<td>By default, the installer creates the required tablespaces for the SAP system. If the tablespace layout used by the installer does not meet your requirements, you can create the tablespaces manually by deselecting the option Create Tablespaces During the Installation Procedure on the dialog IBM Db2 for Linux and UNIX and Windows: Tablespace Storage Management. For more information, see Creating Tablespaces Manually (Optional) [page 222].</td>
</tr>
<tr>
<td><strong>Automatic storage</strong></td>
<td>By default, automatic storage is selected for the database if possible. This is the recommended option. You can deselect automatic storage on the dialog IBM Db2 for Linux and UNIX and Windows: Tablespace Storage Management. As of SAP NetWeaver 7.51, deselection of automatic storage is no longer supported. For more information about tablespaces and automatic storage, see Db2 Tablespaces [page 89].</td>
</tr>
</tbody>
</table>
## Tablespace layout: Storage locations and layout for sapdata directories

The `sapdata` directories are the storage locations for the Db2 tablespaces.

By default, the installer creates four `sapdata` directories (`sapdata1`, `sapdata2`, `sapdata3`, `sapdata4`). Change the number of directories if this is necessary in your customer environment.

By default, tablespaces are stored in `/db2/<DBSID>/sapdata<n>` (with automatic storage) or in `/db2/<SAPSID>/sapdata<n>` (without automatic storage).

You can change the default storage location in the *Tablespace Layout* dialog of the installer so that all `sapdata<n>` directories are located under an additional `sapdata` parent directory.

As of IBM Db2 10.1 and with automatic storage, the `sapdata` directories are used as the storage group paths for the Db2 default storage group `IBMSTOGROUP`. This is the storage group to which tablespaces for regular table data and indexes are assigned. In SAP systems running on IBM Db2 10.1 or higher, temporary data is stored in the storage group `SAPTMPGRP`, for which you can also define storage group paths on the *Tablespace Layout* dialog of the installer.

## Tablespace layout: Storage locations and layout for saptmp directories

As of IBM Db2 version 10.1, the installer automatically creates `saptmp` directories for temporary tablespaces. With automatic storage management selected, the storage group `SAPTMPGRP` for temporary tablespaces is also created. This ensures that permanent tablespaces for table data and indexes are kept separate from temporary tablespaces (see also SAP Note 1895425).

By default, temporary tablespaces are stored in `/db2/<DBSID>/saptmp<n>` (with automatic storage) or in `/db2/<SAPSID>/saptmp<n>` (without automatic storage).

`saptmp` directories are also used for temporary tablespaces in lower Db2 versions if you do not use automatic storage.

By default, the installer creates four `saptmp` directories. Change the number of storage group paths if this is necessary in your customer environment. You can also change the default storage location on the *Tablespace Layout* dialog of the installer so that all `saptmp<n>` directories are located under an additional `saptmp` parent directory.

## Minimize database size

You can significantly reduce the size of your database by selecting the following options in the installer during the dialog phase:

- *Use Db2’s Data Compression*
- *Use Deferred Table Creation*

⚠️ **Caution**

Before you select these options, make sure that you have read the information in *Optimization of Database Size on Disk* [page 93] and SAP Note 1151343.
<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Db2 software path</td>
<td>Specify the file system path where either an existing Db2 software installation already resides or where you want the new copy of Db2 to be installed.</td>
</tr>
<tr>
<td><strong>Recommendation</strong></td>
<td>If you want to install a new copy of Db2, we recommend that you accept the default path suggested by the installer.</td>
</tr>
<tr>
<td>Db2 pureScale Feature</td>
<td>Specify whether you want to install the software libraries required for the Db2 pureScale Feature.</td>
</tr>
<tr>
<td><strong>i Note</strong></td>
<td>If you want to use the Db2 pureScale Feature, you must purchase an IBM Db2 pureScale license (see SAP Note 1260217).</td>
</tr>
<tr>
<td></td>
<td>For more information about the installation of IBM Db2 with the pureScale Feature, see the installation guide <em>Running an SAP System on IBM Db2 with the Db2 pureScale Feature</em> (see Online Information from SAP [page 245]).</td>
</tr>
<tr>
<td>IBM General Parallel File</td>
<td>Specify whether you want to create IBM GPFS file systems using the installer. These file systems are required to install a Db2 pureScale cluster. If you want the installer to create the IBM GPFS file systems, specify the disks where the file systems will be located. If you do not use the installer to create the IBM GPFS file systems and you want to install a Db2 pureScale cluster later, you must create the IBM GPFS file systems manually. For more information about GPFS, see the installation guide <em>Running an SAP System on IBM Db2 with the Db2 pureScale Feature</em> (see Online Information from SAP [page 245]).</td>
</tr>
<tr>
<td>System (GPFS)</td>
<td></td>
</tr>
<tr>
<td>Use of SAP standard table-</td>
<td>By default, the installer creates one standard tablespace pool for your SAP system for data, indexes, and LOB objects. Tablespace pools help ensure a better distribution of data across tablespaces compared to the traditional tablespace layout. We recommend that you use tablespace pools.</td>
</tr>
<tr>
<td>space pool</td>
<td><strong>i Note</strong></td>
</tr>
<tr>
<td></td>
<td>Make sure that after the installation, you read SAP Note 2267446 to check whether your system fulfills the requirements for the use of tablespace pools.</td>
</tr>
<tr>
<td></td>
<td>For more information, see <em>Db2 Tablespaces</em> [page 89].</td>
</tr>
<tr>
<td></td>
<td>As of SAP NetWeaver 7.51, the tablespace pool for data, indexes, and LOB objects is always used and cannot be deselected anymore.</td>
</tr>
</tbody>
</table>
### Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tablespace pool size</td>
<td>The pool size must be between 10 and 99. The default size chosen by the installer is 20. The tablespace pool size determines the number of tablespaces that are generated for the pool. Tablespace pools consist of data tablespaces, index tablespaces, and long tablespaces. For example, if you choose a tablespace pool size of 20, you get a tablespace pool with 20 data tablespaces, 20 index tablespaces, and 20 long tablespaces.</td>
</tr>
</tbody>
</table>

### 3.6.3 Additional Parameters when Installing SAP Process Integration 7.5 or SAP Solution Manager 7.2

The parameters in this section are only required if you want to install SAP Process Integration 7.5 or SAP Solution Manager 7.2.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Port for ABAP</td>
<td>For a secure communication of connected SAP systems to the ABAP stack you have to define the HTTPS port that is to be configured in the application server instance profile. Further post-installation steps [page 181] are required to fully enable HTTPS communication. For more information about HTTPS enablement, see SAP Notes 1527879 and 510007. In addition you can configure an HTTP port. However, this is not recommended for productive SAP systems due to security reasons.</td>
</tr>
</tbody>
</table>

**Recommendation**

If you are about to install an SAP NetWeaver 7.5 Process Integration system and you intend to run automated configuration using the Central Technical Configuration (CTC) Wizard after the installation, it is strongly recommended that you configure the ABAP communication port for ABAP already during the installation process, because you can only run the CTC Wizard if the ABAP port is either completely configured for HTTPS or optionally for HTTP (see also PI: Configuring the Process Integration System After the Install [page 184]).
Parameter | Description
---|---
Application Server Gateway Communication Setup | If you want to install the primary application server instance of the Java system on a host different from the host of the primary application server instance of the ABAP system, then you must specify the host of the Java primary application server instance during the Define Parameters phase of the primary application server instance installation of the ABAP system.

This is to set up the connection between the ABAP and the Java system.

### 3.6.4 Additional Parameters When Using a Stack Configuration File (Optional)

The parameters in this section are only required if you use a stack configuration file generated from the Maintenance Planner.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| Transport Domain | The ABAP Transport Management System (TMS) must be configured before ABAP correction packages can be applied. You can also run the configuration or even reconfigure the TMS after the installation has finished.

To be able to transport changes between the SAP systems in your system landscape, you need to configure the Transport Management System (TMS) for all SAP systems in your system landscape and configure one transport domain controller. To start the TMS in your ABAP system for later reconfiguration, call transaction STMS. At least one transport landscape with this system as transport domain controller is required before you can apply corrections, support packages, or upgrades to the SAP system.

The name of the Transport Domain must not contain blank characters. You cannot change the name afterwards without reconfiguring the transport domain controller and thereby the entire Transport Domain.

By default use DOMAIN_<SAPSID> for the Transport Domain of a single transport landscape with this system as transport domain controller. |
<p>| Directory with Transport Files | Location of the ABAP transport files that are to be included after the ABAP load during the installation. All transport files in this directory are imported with the transport control program (tp). |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location of SPAM/SAINT Update Archive</td>
<td>A SPAM/SAINT update contains updates and improvements to the Support Package Manager (SPAM) and the Add-On Installation Tool (SAINT). Provide the full path to the SPAM/SAINT update archive. SPAM/SAINT is delivered with the ABAP load. SAP recommends that you always use the latest version of SPAM/SAINT before applying Support Packages.</td>
</tr>
</tbody>
</table>
| Decide whether you want to prepare for the Software Update Manager run at the end of the installation | With the Software Update Manager 1.0 (SUM), you can apply support packages stacks at the end of the installation.  
- Do not start SUM automatically  
- Start SUM automatically at the end of the installation  
Choose to start SUM automatically, if you want to have the SUM STARTUP script called in the default <Update Directory>/SUM/ directory at the end of the installation. |
| Extract the SUM*.SAR Archive                  | If you choose to extract the SUM*.SAR archive, the provided archive is validated and extracted to the default update directory: UNIX and IBM: /usr/sap/<SAPSID>/ |
| SUM HTTP port                                 | If you are running several SAP system updates on the same host, you have to use different port numbers for each update. You can adjust the default SUM HTTP port by entering the required port number in the SUM HTTP Port field. When doing so you set the SUM GUI Port number to (<=HTTP port number+2>). Dependencies See also the Software Update Manager documentation at: http://support.sap.com/sltoolset  
System Maintenance  
Software Update Manager (SUM) 1.0 SPS<Number>  
Guides for SUM 1.0 SP<Number> |
| SUM Batch Input File                          | You can specify a batch file with some default values for the update. SUM then starts with parameter batchfile=<XML file with input parameters>.  
Enter the full path to the existing batch file.  
Placeholders like @PARAMETER_VALUE@ inside the file are replaced by values known from the installation. |
| Install Additional SAP System Languages       | A set of default languages is delivered with the ABAP load. From the language media delivered with your product version or - if already provided by the Maintenance Planner for the respective product - using language archives, you can select additional languages that you want to have installed during SAP system installation.  
If you want to install additional languages, you must provide the directory with the additional language packages for the ABAP installation load, for example with subdirectories like DATA_UNITS/ES.

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.1 to 7.52 on UNIX: IBM Db2 for Linux, UNIX, and Windows  
Planning  
PUBLIC
For more information, see Installation Using a Stack Configuration File (Optional) [page 45].

Related Information

Installation Using a Stack Configuration File [page 45]

3.6.5 Parameters for Additional Components to be Included in the ASCS Instance (Optional)

You only need to specify the following parameters during the ASCS instance installation if you perform an integrated installation of additional components.

**Note**

You must choose Custom parameter mode. Otherwise you are not prompted for the parameters related to these additional components during the Define Parameters phase.

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install a gateway integrated in the ASCS instance</td>
<td>When processing the screens for the ASCS instance installation, you are prompted to mark this checkbox on the screen Additional Components to be Included in the ASCS Instance.</td>
</tr>
<tr>
<td>Install an SAP Web Dispatcher integrated in the ASCS instance</td>
<td>When processing the screens for the ASCS instance installation, you are prompted to mark this checkbox on the screen Additional Components to be Included in the ASCS Instance. If you mark the checkbox for SAP Web Dispatcher, you are prompted for the additional parameters required for the SAP Web Dispatcher installation on the subsequent screens:</td>
</tr>
<tr>
<td>Message Server Host</td>
<td>The name of the host on which the message server is located (profile parameter rdisp/mhost)</td>
</tr>
<tr>
<td>Message Server HTTP Port</td>
<td>HTTP port of the message server (profile parameter ms/server_port_&lt;xx&gt;)</td>
</tr>
<tr>
<td>Password for the Internet Communication Management (ICM) user</td>
<td>In order to use the web administration interface for the Internet Communication Manager (ICM) and SAP Web Dispatcher, an administration user webadm is created by the installer. You have to assign a password for this user.</td>
</tr>
</tbody>
</table>
Related Information

ASCS Instance with Integrated SAP Web Dispatcher [page 37]
ASCS Instance with Integrated Gateway [page 39]

3.7 Setup of Database Layout

**Note**

The following sections apply especially to the installation of a production system.

When you plan your SAP system installation, it is essential to consider the setup of your database layout with regard to the distribution of, for example, SAP directories or database file systems to disks. The distribution depends on your specific environment and you must take factors into consideration, such as storage consumption of the software components involved, safety requirements and expected workload.

Make sure that you read the following sections before starting the SAP system installation:

- Required File Systems for IBM Db2 for Linux, UNIX, and Windows [page 83]
- Users and Groups [page 87]
- Directory Structure of the Db2 Client Connectivity [page 88]
- Db2 Tablespaces [page 89]
- Optimization of Database Size on Disk [page 93]
- Data Safety and Performance Recommendations [page 94]

3.7.1 Required File Systems for IBM Db2 for Linux, UNIX, and Windows

This section lists the file systems that are required by Db2 as well as the permissions that you have to set.

<table>
<thead>
<tr>
<th>Caution</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIX, Linux, and Oracle Solaris only: If you plan to set up a high availability database cluster (SA MP) that is based on a shared disk, all the file systems listed in the table below must be located on the shared disk.</td>
</tr>
</tbody>
</table>

Only valid for 'Platform': AIX, Linux, Oracle Solaris
For more information, look up the document *IBM Db2 High Availability Solution: IBM Tivoli System Automation for Multiplatforms* in Online Information from SAP [page 245].

End of 'Platform': AIX, Linux, Oracle Solaris

## Required File Systems

### Required File Systems

**i Note**

Production systems only:

During the installation of your SAP system, you can specify the number of directories that contain table data, indexes, and temporary data (sapdata and saptmp directories). However, to ensure that your SAP system performs well in a production environment, you have to define and control the distribution of the database directories to physical disks. You do this by creating and mounting separate file systems manually for the directories listed in the following table.

<table>
<thead>
<tr>
<th>File System/Logical Volume</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/db2/db2&lt;dbsid&gt;</td>
<td>Home directory of user db2&lt;dbsid&gt; and contains the Db2 instance data for &lt;DBSID&gt; and the Db2 software. Size: at least 1 GB</td>
</tr>
<tr>
<td>/db2/&lt;DBSID&gt;/</td>
<td>Size: at least 1 GB</td>
</tr>
<tr>
<td>/db2/&lt;DBSID&gt;/log_dir</td>
<td>Contains at least the online database log files. Size: at least 5 GB</td>
</tr>
<tr>
<td>/db2/&lt;DBSID&gt;/db2dump</td>
<td>Contains Db2 diagnostic log files, Db2 dump files, and further service engineer information. Size: 5 GB</td>
</tr>
</tbody>
</table>
**File System/Logical Volume**

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage location for tablespaces with container type database managed space (DMS) FILE or tablespaces with Db2's automatic storage.</td>
</tr>
<tr>
<td>By default, the installer creates four directories (sapdata1, sapdata2, sapdata3, sapdata4). If you require more or fewer sapdata directories, you can change the number of directories on the Tablespace Layout dialog of the installer. If you add additional sapdata directories during the dialog phase of the installer, the corresponding tablespace containers are equally distributed.</td>
</tr>
<tr>
<td>On the Tablespace Layout dialog of the installer, you can also decide whether you want all directories stored under one parent directory sapdata.</td>
</tr>
<tr>
<td>For more information about the required size of the sapdata directories, see the installation note 1707361 for IBM Db2 for Linux, UNIX, and Windows.</td>
</tr>
<tr>
<td>In a production system, you must make sure that the sapdata directories are located in different file systems. Otherwise, system performance can decrease. For more information, see Data Safety and Performance Considerations for Database Directories [page 94].</td>
</tr>
</tbody>
</table>

- With Db2's automatic storage: `/db2/<DBSID>/sapdata<n>` or `/db2/<DBSID>/sapdata/sapdata<n>`
- No automatic storage: `/db2/<SAPSID>/sapdata<n>` or `/db2/<SAPSID>/sapdata/sapdata<n>`

**Only valid for 'Platform': AIX, HP-UX**

On AIX and HP-UX, use large enabled file systems. For more information about large enabled file systems, see your operating system documentation.

**End of 'Platform': AIX, HP-UX**
### File System/Logical Volume

- **With Db2’s automatic storage:**
  - `/db2/<DBSID>/saptmp<n>` or `/db2/<DBSID>/saptmp/saptmp<n>` (for IBM Db2 10.1 and higher)
  - `/db2/<DBSID>/sapdata<n>` or `/db2/<DBSID>/sapdata/sapdata<n>` (for IBM Db2 up to and including V9.7)

- **No automatic storage:**
  - `/db2/<SAPSID>/saptmp<n>` or `/db2/<SAPSID>/saptmp/saptmp<n>`

### Description

Storage path for temporary tablespaces.

For IBM Db2 versions lower than 10.1, saptmp directories are used for temporary tablespaces, but only if you do not use automatic storage management.

As of IBM Db2 10.1, saptmp directories are always used for temporary tablespaces (regardless of whether you use automatic storage or not). If automatic storage is used, the temporary tablespaces are assigned by default to the storage group SAPTMPGRP.

By default, the installer creates four directories (`saptmp1`, `saptmp2`, `saptmp3`, `saptmp4`). If you require more or fewer directories, you can change the number of directories on the **Tablespace Layout** dialog of the installer.

On the **Tablespace Layout** dialog of the installer, you can also decide whether you want all directories stored under one parent directory (`saptmp` or `sapdata`).

### File System Permissions

The file systems and logical volumes must have the permissions and owner shown in the following table and they must be created and mounted before starting the installer. The installer then sets the required permissions and owners.

<table>
<thead>
<tr>
<th>i Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can create the owners and groups manually if they do not exist yet. Otherwise, the installer creates them automatically. For more information, see Creating Operating System Users Manually [page 102].</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>File System/Logical Volume</th>
<th>Permissions</th>
<th>Owner</th>
<th>Group</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>/db2/&lt;DBSID&gt;</code></td>
<td>755</td>
<td>db2&lt;dbsid&gt;</td>
<td>db&lt;dbsid&gt;adm</td>
</tr>
<tr>
<td><code>/db2/&lt;DBSID&gt;/log_dir</code></td>
<td>755</td>
<td>db2&lt;dbsid&gt;</td>
<td>db&lt;dbsid&gt;adm</td>
</tr>
<tr>
<td><code>/db2/&lt;DBSID&gt;/db2dump</code></td>
<td>755</td>
<td>db2&lt;dbsid&gt;</td>
<td>db&lt;dbsid&gt;adm</td>
</tr>
</tbody>
</table>
### File System/Logical Volume

<table>
<thead>
<tr>
<th>File System/Logical Volume</th>
<th>Permissions</th>
<th>Owner</th>
<th>Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>With IBM Db2’s automatic storage management:</td>
<td>750</td>
<td>db2&lt;dbsid&gt;</td>
<td>db&lt;dbsid&gt;adm</td>
</tr>
<tr>
<td>/db2/&lt;DBSID&gt;/sapdata&lt;n&gt;</td>
<td>or /db2/&lt;DBSID&gt;/sapdata/sapdata&lt;n&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No automatic storage management:</td>
<td>750</td>
<td>db2&lt;dbsid&gt;</td>
<td>db&lt;dbsid&gt;adm</td>
</tr>
<tr>
<td>/db2/&lt;SAPSID&gt;/sapdata&lt;n&gt;</td>
<td>or /db2/&lt;SAPSID&gt;/sapdata/sapdata&lt;n&gt;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

As of IBM Db2 10.1 (or with lower IBM Db2 versions without automatic storage management):

/db2/<DBSID>/saptmp<n> or /db2/<DBSID>/saptmp/saptmp<n>

### Related Information

SAP Directories [page 108]

### 3.7.2 Users and Groups

The installer creates the following users and groups as shown in the following table:

<table>
<thead>
<tr>
<th>User</th>
<th>Home Directory</th>
<th>Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>db2&lt;dbsid&gt;</td>
<td>/db2/db2&lt;dbsid&gt;</td>
<td>db&lt;dbsid&gt;adm</td>
</tr>
<tr>
<td>&lt;sapsid&gt;adm</td>
<td>Can be chosen</td>
<td>sapsys (primary group),</td>
</tr>
<tr>
<td></td>
<td></td>
<td>db&lt;dbsid&gt;ctl (secondary)</td>
</tr>
<tr>
<td>Default ABAP connect user:</td>
<td>Can be chosen</td>
<td>db&lt;dbsid&gt;mon (primary group)</td>
</tr>
<tr>
<td>sap&lt;sapsid&gt;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You may change this user during the installation.

**i Note**

You can specify the name of the ABAP connect user (sap<sapsid>) independently from the SAP schema name during the dialog phase of the installer.
We recommend, however, that you keep the names of the connect user and the database schema identical in standard use cases. If you are performing a system copy using database means, Db2 is not able to change the schema name and you can then choose a connect user name that is different from the schema name.

As of IBM Db2 V9.7, the installer automatically creates roles that restrict the privileges of the users on the database. For more information, see **Ensuring User Security [page 186]**.

### 3.7.3 Directory Structure of the Db2 Client Connectivity

**Use**

The Db2 client connectivity (also known as Db2 Thin Client) has a directory structure as shown in the following graphic:

#### Directory Structure of the Database Client

*(Including the JDBC Driver)*

- global/db6/  
  - db2cli.ini  
  - jdbc/  
    - db2jcc4.jar  
    - jdbcdriver.lst  
  - db2dump/  
  - <OS>/db6_clidriver/

where `<OS>` is:  
- AIX_64  
- HP_11_64, HP_9000  
- LINUX_64, LINUXPC_64_64, LINUX64_64  
- SUNOS_64

#### Directory Structure of the Database Client

**Db2 Thin Client**

During the installation of the database instance, the Db2 CLI driver is installed in the global directory of your SAP system (`global/db6/<OS>/db6_clidriver/`). The Db2 CLI driver is installed for the same operating system as the database instance.
i Note

If you are installing an application server (primary or additional application server instance) on the same operating system as the database instance, the already existing Db2 CLI driver in directory global/db6/<OS>/db6_clidriver is used.

If you install an application server on an operating system that is new to your SAP system landscape, an additional Db2 CLI driver for this new operating system is also installed in the global directory, for example, global/db6/<OS_application_server>/db6_clidriver.

Each time you start the application server, the Db2 CLI driver is copied from the global/db6 directory to the local exe directory, and the active SAP system uses these copies of the Db2 CLI driver in the local exe directory. Thus, by exchanging the driver software in the global/db6 directory, you are able to update the Db2 CLI driver while the SAP system is up and running. Each time you restart the application server, the Db2 CLI driver is again copied to the local exe directory, and always the latest version is used.

⚠️ Caution

However, be aware that if you start SAP standalone tools (for example, tp or R3trans) from the command line, these tools use the Db2 CLI driver in the global/db6 directory and not the one in the local exe directory.

If you have updated the Db2 CLI driver in the global directory but not yet restarted the application server, the versions of the Db2 CLI driver in the global/db6 and in the local exe directory can differ.

The configuration and connectivity information of the Db2 CLI driver is stored in file db2lci.ini in the global directory of your SAP system and it is shared among all additional application servers. File db2lci.ini is created during the installation of the database server.

More Information

For more information about how to update the Db2 CLI driver or the JDBC driver during the Fix Pack installation, see SAP Note 1365982.

3.7.4 Db2 Tablespaces

Tablespace Types

During the dialog phase of the installation, the installer offers to create the following tablespace types:

- Data and index tablespaces managed by Db2’s automatic storage management (AutoStorage)
  During the installation, the installer assigns the sapdata directories to the database, which automatically distributes all tablespace types over the sapdata directories or file systems. In addition, the database automatically adjusts the tablespace sizes as long as there is enough free space left in the sapdata directories or file systems.
If one of the sapdata directories becomes full, new stripe sets are automatically created in the remaining sapdata directories. Since the Db2 database automatically creates and administers the tablespace containers, the overall administration effort for the database decreases considerably using tablespaces managed by automatic storage management.

**Recommendation**

We recommend that you use automatic storage management for data and index tablespaces.

As of SAP NetWeaver 7.51, you must use automatic storage. The possibility to deselect automatic storage during the dialog phase of the installer is no longer supported.

- **DMS File tablespaces in *autoresize* mode**
  The installer creates all DMS tablespaces with FILE containers in *autoresize* mode as well as one tablespace container for each tablespace in every sapdata directory or file system. Db2 automatically extends the size of all DMS FILE tablespaces in *autoresize* mode as long as there is space left in the sapdata directories or file systems.
  With DMS FILE tablespaces in *autoresize* mode, you are more flexible to distribute heavily used tablespaces to dedicated storage devices at a later point in time.

  **Note**
  As of IBM Db2 10.1, do not use DMS tablespaces because they are deprecated.

- **Other tablespace types**
  If you want to use other tablespace types, for example SMS or DMS DEVICE (raw devices), you have to create them manually. In this case, deselect the option *Create Tablespaces During the Installation Procedure* during the dialog phase of the installation and proceed as described in *Creating Tablespaces Manually* [page 222].

At a later point in time, you can switch between DMS FILE and DMS DEVICE tablespaces using Db2’s redirected restore tool. In addition, you can enable and disable autoresize mode for databases that are not set up with automatic storage management.

To move tablespaces of a Db2 release lower than IBM Db2 V9.7 from automatic storage management to other storage modes or the other way round, you have to perform a homogenous system copy. For more information, see the appropriate system copy guide at [http://support.sap.com/sitoolset > System Provisioning > System Copy Option](http://support.sap.com/sitoolset > System Provisioning > System Copy Option). As of IBM Db2 V9.7, you can move tablespaces from DMS to automatic storage management.

**Container Type FILE**

If you are using **tablespaces managed by Db2’s automatic storage management**, Db2 creates and administers the tablespace containers for you.
If you are using DMS FILE tablespaces in autoresize mode, each tablespace of your SAP installation has at least one container. A container is a file that holds pages belonging to a tablespace. Since you might want to add containers as your database grows in size, you should adhere to the following naming scheme:

The first container of a tablespace is given the name of the tablespace plus the ending container001. Therefore, <SAPSID>#BTABD has at least the container <SAPSID>#BTABD.container001. The next container is called <SAPSID>#BTABD.container002, and so on.

### Container Sizes

Equal container sizes ensure the proper balancing of container access and therefore better performance, if the containers reside on different disks. The installer creates all containers of a tablespace with the same size.

### Tablespace Sizes Without Autoresize

By default, the tablespaces are created with autoresize mode. If you are using tablespaces without the autoresize mode, you must extend the tablespaces manually. If you do not increase your tablespace sizes in time, the following error occurs:

Error occurred during DB access SQLException SQLCODE: -289

### Temporary Tablespaces

To prevent you from running out of storage space for temporary data, we recommend that you place your temporary tablespaces on separate storage as follows:

- **IBM Db2 version 10.1 and higher**: By default, the installer creates separate storage locations for data and index tablespaces on the one hand and for temporary tablespaces on the other. If automatic storage is selected, the installer additionally automatically creates the storage group SAPTMPGRP for temporary tablespaces.
- **Db2 versions up to and including 9.7**: Do not use automatic storage for your temporary tablespaces. Instead, use SMS temporary tablespaces. Ensure that you provide multiple containers to your SMS temporary tablespaces. You must use SMS temporary tablespaces for performance reasons. Do not use DMS temporary tablespaces.

### Tablespace Pools

Tablespace pools help ensure a better distribution of data across tablespaces compared to the traditional tablespace layout. A tablespace pool is a set of tablespaces that allows the system to assign a table flexibly to one of the tablespaces in the set. When you assign a table to a tablespace pool, the application server ABAP creates the table in one of the tablespaces of the tablespace pool using a distribution algorithm based on the table name. By these means, a more evenly balanced distribution of tables across tablespaces is achieved.
As a default, the installer creates a standard SAP tablespace pool `<SAPSID>#DATA{20}` for your SAP system during installation. In the custom installation mode, you can deselect the automatic creation of the tablespace pool if needed.

We recommend that you use tablespace pools because unbalanced tablespaces are disadvantageous for the following reasons:

- Db2 has a limit on the number of objects that can be created in a tablespace. If a very high number of tables reside in a tablespace, you are likely to exceed the object limit at some point in time, for example, during an SAP upgrade or SAP update, or when you create your own tables.
- The overall runtime of a Db2 backup is determined by the backup duration of the largest tablespace. Therefore, backup runtime improves if the tables are distributed over multiple tablespaces of smaller size instead of over fewer tablespaces of a larger size.

As of SAP NetWeaver 7.51, the standard tablespace pool for data, indexes, and LOB objects is always automatically created and its creation cannot be deselected any longer during the dialog mode of the installer.

Each tablespace pool consists of as many data, index, and long tablespaces as indicated by the pool size. For example, a tablespace pool of size 10 consists of 10 data tablespaces, 10 index tablespaces, and 10 long tablespaces. The default tablespace pool size is 20. In the custom installation mode, you can change the default tablespace pool size if needed.

**i Note**

After the installation, make sure you read SAP Note 2267446 to check whether your system fulfills the requirements for the use of tablespace pools and take the relevant steps, if necessary, as described in the SAP Note.

### Tables in an MCOD Environment

If you want to install additional SAP components into the same database, make sure that you consider the information under MCOD Tablespaces and File Systems [page 210].

### More Information

Important information and prerequisites for the use of tablespace pools: SAP Note 2267446

SAP Note 1895425

Creating Tablespaces Manually [page 222]
3.7.5 Optimization of Database Size on Disk

Use

With the increasing cost for managed storage, database sizes become more and more a concern. You can significantly reduce the size of your database by selecting the following options during the dialog phase of the installer:

- Use Db2’s Data Compression
- Use Deferred Table Creation

Features

Db2’s Data Compression

When you select the Use Db2’s Data Compression checkbox, you activate the following:

- Tables are compressed using Db2’s (static) row compression during installation (up to IBM Db2 10.1) and using adaptive compression as of IBM Db2 10.5.
- Indexes are compressed using Db2’s index compression during installation (as of IBM Db2 9.7).
- The global compression option is set to YES, that is, static row compression is enabled for tables that are created after the installation (for IBM Db2 up to and including version 10.1). As of IBM Db2 10.5, adaptive compression is used.

**Note**

If you want to use static row compression, adaptive compression, and index compression, make sure that you have a valid license for this function. If you have purchased your Db2 license from SAP (an SAP OEM license), these compression types are already part of your license agreement.

Static or Classic Row Compression

Db2’s classic row compression transparently compresses table data in your database, using a dictionary-based compression algorithm. Using row compression typically reduces the size of tables by 60 to 80%. As a result, the size of the database decreases by approximately 30 to 55%.

Db2’s (classic) row compression is also referred to as “static (row) compression”, as opposed to “adaptive compression” available as of IBM Db2 10.1 (see below).

For more information about row compression, see the Database Administration Guide for SAP on IBM Db2 for Linux, UNIX, and Windows.

Adaptive Compression

As of IBM Db2 10.1, table data can be compressed using adaptive compression. This compression technique comprises the classic row compression and a compression algorithm that works on page level. For more information about adaptive compression, see Adaptive Compression in the IBM Db2 10.1 Knowledge Center at http://publib.boulder.ibm.com/infocenter/db2luw/v10r1/topic/com.ibm.db2.luw.admin.dbobj.doc/doc/c0059054.html.
For more information about enabling adaptive compression, see the *Database Administration Guide for SAP on IBM Db2 for Linux, UNIX, and Windows*.

**Index Compression**

As of IBM Db2 V9.7, indexes can also be compressed. To minimize the size of the index on disk, the Db2 database manager can use various index compression techniques, for example, RID list compression or prefix compression.

Index compression is not supported on catalog indexes and MDC block indexes.

For more information about index compression, see SAP Note 1351160.

**Global Compression Option**

Activating the global compression option ensures that when tables are newly added to the database during the operation of the SAP system, these tables are automatically compressed. The default compression type for IBM Db2 up to and including 10.1 is static row compression. As of IBM Db2 10.5, the default is adaptive compression.

**Deferred Table Creation**

⚠️ **Caution**

- Before you use this function, make sure that you read SAP Note 1151343.

The SAP function *deferred table creation* delays the creation of empty database tables until the first row is inserted. That is, until the first row is inserted, the table is substituted by a virtual table (which effectively is a special database view). As soon as the first row is inserted, the SAP kernel transparently replaces the virtual table with a database table. Depending on the number of tables that remain empty over your system lifetime, the use of deferred table creation can reduce the size of your database by several GB.

**More Information**

- Minimizing the Database Size after the Installation (Optional) [page 235]
- *Database Administration Guide for SAP on IBM Db2 for Linux, UNIX, and Windows* (see Online Information from SAP [page 245])

### 3.7.6 Data Safety and Performance Considerations for Production Systems

During the installation of a production SAP system, you should control the distribution of database directories or file systems to physical disks. On Windows operating systems, you assign drive letters to the system components when running the installation tool. On UNIX operating systems, this is done when you create file systems before you start the installation tool. The way you distribute your database components to disks can significantly affect system throughput and data security, and must therefore be carefully planned.

⚠️ **Note**

When you work out the assignment of components to disks, you first need to obtain an overview of the main components and their corresponding directories. Make sure that you have an overview of the
Data Safety and Performance Considerations

When you plan your SAP system installation, you must consider the following:

- In an emergency situation you must be able to perform a rollforward recovery of your database in a production system.
  
  In a production system, the Db2 database must run in log retention mode. Otherwise, log files cannot be applied to the database rollforward operations. You can set the database to log retention mode by changing database configuration parameters at the very end of the installation process. After changing the parameters, you are automatically forced to perform an offline backup. Otherwise, you cannot reconnect to the database, which is reported with an error message.
  
  For information, see Enabling Recoverability of the Database [page 194].

- Keep the tablespace container files in directories $sapdata* and the online log directory log_dir on separate disks to be able to perform a full rollforward recovery if a database container file is damaged or lost.

- Since transaction data is lost if online log files are damaged, we recommend that the online log directory log_dir is stored on redundant storage.
  
  You can perform hardware mirroring using RAID adapters or intelligent storage systems. For performance reasons, hardware solutions for mirroring should be preferred over mirroring solutions like logical volume managers that are offered by operating systems.

- A high transaction volume can cause high I/O on the online log files. Therefore, the distribution of the online log files is a crucial factor of performance considerations. Ideally, the online log files should be located on fast physical volumes that do not have high I/O load coming from other components. This allows efficient logging activity with a minimum of overhead such as waiting for I/O. You should avoid storing the online log files on the same physical volume as the operating system paging space, or a physical volume with high I/O activity.

- By default, the SAP installation tool creates tablespaces that are managed by Db2’s automatic storage management (automatic storage tablespaces). Tablespaces with automatic storage offer maximum ease of use and low administrative cost. If you are not using tablespaces with automatic storage, you must manually control the distribution of data on disk. As of IBM Db2 10.1, use automatic storage because DMS tablespaces are deprecated. As of SAP NetWeaver 7.51, automatic storage is the standard storage management and cannot be deselected in the dialog phase of the installer.

- You can run Db2 databases with multiple page sizes in a single database. But once specified for a tablespace, the page size cannot be changed. For each page size, a separate buffer pool has to be created in your database. During a standard installation, the installer creates the database with a uniform page size of 16 KB. As a result only buffer pools with 16 KB have to be created and administered. A mixture of different page sizes in the Db2 database is not recommended.

More Information

For more information, see the Administration Guide: Performance that you can access using the link in section Online Information from IBM [page 245].
3.8 SAP System Transport Host

The transport host contains the transport directory used by the SAP transport system to store transport data and change SAP system information, such as software programs, write dictionary data, or customizing data. If you have several SAP systems it depends on your security requirements whether you want them to share a transport directory or whether you use separate directories.

When you install an SAP system, you have to decide which transport host and directory you want to use for your SAP system:

- Use the transport directory that the installer creates during the installation of the SAP system by default on the global host.
  The installer by default creates the transport directory on the global host in /usr/sap/trans.
- Use a transport directory located on a host other than the default host:
  ○ You can use an existing transport directory and host in your SAP system landscape.
  ○ You can set up a new transport directory on a different host.
In either case, you must prepare this host for use by the new SAP system. For more information, see Exporting and Mounting the Global Transport Directory [page 138].

More Information

- Required File Systems and Directories [page 107]
- See the SAP Library at:

<table>
<thead>
<tr>
<th>Release</th>
<th>SAP Library Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>○ SAP NetWeaver Mobile 7.1</td>
<td>Application Help</td>
</tr>
<tr>
<td>○ SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0 (use the SAP Library for SAP NetWeaver Mobile 7.1)</td>
<td>ABAP Technology /</td>
</tr>
<tr>
<td>○ SAP NetWeaver Mobile 7.1 including Enhancement Package 1</td>
<td>Application Server ABAP</td>
</tr>
<tr>
<td>○ SAP NetWeaver 7.1 including Enhancement Package 1 for Banking Services from SAP 5.0 and 6.0 (use the SAP Library for SAP NetWeaver Mobile 7.1 including Enhancement Package 1)</td>
<td>Change and Transport System</td>
</tr>
<tr>
<td>○ SAP NetWeaver Mobile 7.1 including Enhancement Package 1</td>
<td>Change and Transport System – Overview</td>
</tr>
<tr>
<td></td>
<td>Basics of the Change and Transport System</td>
</tr>
<tr>
<td></td>
<td>Transport Management System – Concept</td>
</tr>
</tbody>
</table>
3.9 Planning the Switchover Cluster for High Availability

This section describes basic aspects of planning the switchover cluster for a high-availability system.

You can reduce unplanned downtime for your SAP system by setting up a switchover cluster. This setup installs critical software units – known as “single points of failure” (SPOFs) – across multiple host machines in the cluster. In the event of a failure on the primary node, proprietary switchover software automatically switches the failed software unit to another hardware node in the cluster. Manual intervention is not required. Applications trying to access the failed software unit might experience a short delay but can then resume processing as normal.

Switchover clusters also have the advantage that you can deliberately initiate switchover to release a particular node for planned system maintenance. Switchover solutions can protect against hardware failure and operating system failure but not against human error, such as operator errors or faulty application software. Additional downtime might be caused by upgrading your SAP system or applying patches to it.

Without a switchover cluster, the SAP system SPOFs – central services instance, the database instance, and the central file share – are vulnerable to failure because they cannot be replicated. All of these can only exist once in a normal SAP system.

You can protect software units that are not SPOFs against failure by making them redundant, which means simply installing multiple instances. For example, you can add additional application server instances. This complements the switchover solution and is an essential part of building high availability (HA) into your SAP system.

→ Recommendation

We recommend switchover clusters to improve the availability of your SAP system.
A switchover cluster consists of:

- A hardware cluster of two or more physically separate host machines to run multiple copies of the critical software units, in an SAP system the SPOFs referred to above
- Switchover software to detect failure in a node and switch the affected software unit to the standby node, where it can continue operating
- A mechanism to enable application software to seamlessly continue working with the switched software unit – normally this is achieved by virtual addressing (although identity switchover is also possible)

**Prerequisites**

You must first discuss switchover clusters with your hardware partner because this is a complex technical area. In particular, you need to choose a proprietary switchover product that works with your operating system.

We recommend that you read the following documentation before you start:

- On the database level, IBM provides a high-availability cluster solution for AIX, Linux, and Solaris SPARC only that is called You can reduce unplanned downtime for your SAP system by setting up a switchover cluster. This setup installs critical software units – known as IBM Tivoli System Automation for Multiplatforms (SA MP). The corresponding installation guide describes how to set up a switchover cluster with SA MP based on the Db2 feature “High Availability and Disaster Recovery (HADR)” or a shared disk: IBM Db2 High Availability Solution: IBM Tivoli System Automation for Multiplatforms (see Online Information from SAP [page 245])
- The ERS instance is essential for a high-availability system and should be controlled by the cluster software. You need one ERS instance for the ASCS instance installed in your system.

**Features**

**i Note**

The diagrams in this section are only examples. Only the instances relevant to the switchover are shown. These diagrams summarize the overall setup and do not show the exact constellation for an installation based on one of the available technologies.

You need to discuss your individual HA setup with your HA partner.
The following diagram shows the essential features of a switchover setup:

Switchover cluster to protect SCS services - SPOF

ASCS Instance and ERS Instance in Different Failover Groups

Web Dispatcher

Transparent load balancing

Redundant (additional) application server instances - non-SPOF

Primary Application Server Instance

All non-SPOF services

Additional Application Server Instances 1-n

All non-SPOF services

Switchover clusters to protect database, file system - SPOF

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.1 to 7.52 on UNIX: IBM Db2 for Linux, UNIX, and Windows
The following diagram shows an example of a switchover setup in more detail:

### Constraints

This documentation concentrates on the switchover solution for the central services instance. For more information about how to protect the Network File System (NFS) software and the database instance by using switchover software or (for the database) replicated database servers, contact your HA partner.

This documentation concentrates on the switchover solution for the central services instance. For more information about how to protect the central file share and the database instance by using switchover software or (for of the database) replicated database servers, contact your HA partner.

Make sure that your hardware is powerful enough and your configuration is robust enough to handle the increased workload after a switchover. Some reduction in performance might be acceptable after an emergency. However, it is not acceptable if the system comes to a standstill because it is overloaded after switchover.
4 Preparation

4.1 Preparation Checklist

This section includes the preparation steps that you have to perform for the following installation options:

- Standard, distributed, or high-availability system
- Additional application server instance

Detailed information about the steps are available in the linked sections.

**Note**

This guide does not cover the installation of SAP systems running on IBM Db2 with the Db2 pureScale Feature. For more information about the required planning and preparatory steps, see the installation guide *Running an SAP System on IBM Db2 with the Db2 pureScale Feature* listed in Online Information from SAP [page 245].

**Standard, Distributed, or High-Availability System**

**Note**

In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a standard system, you can ignore references to other hosts.

1. You check that the required operating system users and groups [page 102] are created.
2. You set up file systems [page 107] and make sure that the required disk space is available for the directories to be created during the installation.
3. If you want to use virtual host names, you have to set the environment variable SAPINST_USE_HOSTNAME [page 117]. Alternatively you can specify a virtual host name either in the command to start the installer or - after the installer has started - in the relevant field on the respective instance screen (see Running the Installer [page 147]).

**Note**

To assign a virtual host name to a database instance, you must run the installer with the SAPINST_USE_HOSTNAME property.

4. If you want to install a high-availability system, you perform switchover preparations [page 117].
5. If you want to share the transport directory trans from another system, export [page 138] this directory to your installation hosts.
6. You install the SAP front-end software [page 118] on the desktop of the user.
7. You check that the required installation media [page 118] are available for each installation host.
8. If you decided to use a generic LDAP directory, you have to create a user for LDAP directory access [page 212].
9. You continue with Installation [page 133].

**Additional Application Server Instance**

You have to perform the following preparations on the host where you install the additional application server instances:

1. You check that the required operating system users and groups [page 102] are created.
2. You set up file systems [page 107] and make sure that the required disk space is available for the directories to be created during the installation.
3. If you want to use virtual host names, you have to set the environment variable SAPINST_USE_HOSTNAME [page 117].
   Alternatively you can specify a virtual host name either in the command to start the installer or - after the installer has started - in the relevant field on the respective instance screen (see Running the Installer [page 147]).
4. If you want to share the transport directory trans from another system, export [page 138] this directory to your installation hosts.
5. You install the SAP front-end software [page 118] on the desktop of the user.
6. You check that the required installation media [page 118] are available on each installation host.
7. You continue with Installation [page 133].

### 4.2 Creating Operating System Users and Groups

During the installation, the installer checks all required accounts (users, groups) and services on the local machine. The installer checks whether the required users and groups already exist. If not, it creates new users and groups as necessary.

The `sapinst_instdir` directory belongs to a group named `sapinst`. If this group is not available, it is created automatically as a local group.

If you do not want the installer to create operating system users, groups, and services automatically, you can optionally create them **before** the installation is started. This might be the case if you use central user management such as Network Information System (NIS).

For distributed installations, unless you are using global accounts or NIS, you must create the target users automatically using the installer or manually on the operating system, before starting the installation:

⚠️ **Caution**

The user ID (UID) and group ID (GID) of SAP users and groups must be identical for all servers belonging to an SAP system.

This does not mean that all users and groups have to be installed on all SAP servers.
The installer checks if the required services are available on the host and creates them if necessary. See the log messages about the service entries and adapt the network-wide (NIS) entries accordingly.

The installer checks the NIS users, groups, and services using NIS commands. However, the installer does not change NIS configurations.

→ Recommendation

For a distributed or a high-availability system, we recommend that you distribute account information (operating system users and groups) over the network, for example by using Network Information Service (NIS).

If you want to use global accounts that are configured on a separate host, you can do this in one of the following ways:

- You start the installer and choose Generic Installation Options > Database > Preparation > Operating System Users and Groups.
  For more information, see Running the Installer [page 147].
- You create operating system users and groups manually. Check the settings for these operating system users.

User Settings

- Only valid for ‘Platform’: Oracle Solaris

  Oracle Solaris: If your operating system is Oracle Solaris 10 or higher, follow the parameter recommendations for SAP applications in SAP Note 724713.

  End of ‘Platform’: Oracle Solaris

- Only valid for ‘Platform’: AIX

  AIX: Make sure that you have set the limits for operating system users as described in SAP Note 323816.

  End of ‘Platform’: AIX

- Only valid for ‘Platform’: HP-UX, Linux, Oracle Solaris

  HP-UX, Linux, Oracle Solaris: Make sure that you have set the limits for operating system users root, <sapsid>adm, and your database-specific operating system users (see also section “Creating Operating System Users and Groups” and “Running the Installer” in the installation guide).

⚠️ Caution

Caution: the limit mechanism supports hard and soft limits. The soft limit cannot be bigger than the hard limit. The hard limit can be set/increased by the root user like: limit -h <limit> <new_value>, for example limit -h datasize unlimited.

○ Using csh shell, the output of command limit needs to be at least as follows:

★★ Example

The following table lists example output taken from SUSE Linux Enterprise Server 11 (x86_64).
○ Using `sh` or `ksh` shell, the output of command `ulimit -a` needs to be at least as follows:

<table>
<thead>
<tr>
<th>Output sh</th>
<th>Output ksh</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>cpu time (seconds)</td>
<td>cpu time (seconds)</td>
<td>unlimited</td>
</tr>
<tr>
<td>file size (blocks)</td>
<td>file size (blocks)</td>
<td>unlimited</td>
</tr>
<tr>
<td>data seg size (kbytes)</td>
<td>data size (Kibytes)</td>
<td>unlimited</td>
</tr>
<tr>
<td>stack size (kbytes)</td>
<td>stack size (Kbytes)</td>
<td>8192 KB</td>
</tr>
<tr>
<td>core file size (kbytes)</td>
<td>core file size (Kbytes)</td>
<td>unlimited</td>
</tr>
<tr>
<td>open files</td>
<td>nofile</td>
<td>8192</td>
</tr>
<tr>
<td>max memory size (kbytes)</td>
<td>max memory size (Kibytes)</td>
<td>unlimited</td>
</tr>
</tbody>
</table>

Example

The following table lists example output taken from SUSE Linux Enterprise Server 11 (x86_64).

- All users **must** have identical environment settings. Any change to the environment – such as variables, or paths – is at your own responsibility.
- If you have multiple operating system users with user ID (UID) 0, you must assign the `sapinst` group to all of them.
- Do not delete any shell initialization scripts in the home directory of the operating system users. This applies even if you do not intend to use the shells that these scripts are for.
- If you install an SAP system with instances distributed over several hosts, make sure that the following requirements are met:
  ○ The user ID (UID) and group ID (GID) of each operating system user must be unique and the same on each instance host that belongs to the same SAP system.
- Make sure that the group ID of group **sapinst** is always different from the group ID of any other group (for example, of group **sapsys**) used during the installation. For example, if you want to install an additional application server instance for an existing SAP system, you must make sure that the group ID of group **sapinst** created on the host of the additional application server instance is different from the group ID of any other group on the primary application server instance host of the existing SAP system.

- If you use local operating system user accounts instead of central user management (for example, NIS), users `<sapsid>adm`, `<sapsid>sapadm`, and the database operating system user must have the same password on all hosts.

- If you use local operating system user accounts, make sure that you install your SAP system in **Custom** mode and specify suitable IDs for user `<sapsid>adm` and group `<sapsid>sapsys` on all hosts. The IDs have to be the same on all hosts. If you choose **Typical** mode, you are not asked to specify the user and group IDs.

- If you create operating system users manually or use already existing operating system users, make sure that the home directory for each of these users is **not** the root directory (`/`).

- Make sure that the home directory of user `<sapsid>adm` is not critical for recursive changes on permissions. When operating system users are created by the installer, the permissions on the home directories of these users are changed recursively. This can cause unpredictable errors if you define a critical home directory. For example, the home directory must **not** be `/` or `/usr/sap`.

- **Only valid for Platform**: HP-UX

  HP-UX: To prevent terminal query errors in the `<sapsid>adm` environment, comment out the line `eval 'tset -s -Q -m ':?hp'` in the `/etc/skel/.login` script. For more information, see SAP Note 1038842.

  End of 'Platform': HP-UX

### Operating System Users and Groups

The installer chooses available operating system user IDs and group IDs unless you are installing an additional application server instance. On an additional application server instance you have to enter the same IDs as on the host of the primary application server instance.

If you have multiple operating system users with user ID (UID) 0, you must assign the **sapinst** group to all of them.

You can specify the name of the ABAP connect user (**sap<sapsid>**) independently from the SAP schema name during the dialog phase of the installer.

> **Recommendation**

We recommend, however, that you keep the names of the connect user and the database schema identical in standard use cases. If you are performing a system copy using database means, Db2 is not able to change the schema name and you can then choose a connect user name that is different from the schema name.

> **Recommendation**

For security reasons, we recommend that you remove the operating system users from the group **sapinst after** the installer has completed. For more information, see **Ensuring User Security** [page 186].
We recommend that you specify this “cleanup” already during the Define Parameters phase on the Cleanup Operating System Users screen. Then, the removal of the operating system users from the group sapinst is done automatically. For more information, see Cleanup of Operating System Users in SAP System Parameters [page 64].

Users and Groups

<table>
<thead>
<tr>
<th>User</th>
<th>Primary Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Superuser of the UNIX operating system root</td>
<td>No primary group is assigned by the installer (additional group is sapinst)</td>
</tr>
<tr>
<td>SAP system administrator&lt;sapsid&gt;adm</td>
<td>sapsys(db&lt;dbsid&gt;ctl as secondary group)</td>
</tr>
<tr>
<td><strong>ABAP connect user sap&lt;sapsid&gt;</strong></td>
<td><strong>db&lt;dbsid&gt;mon</strong></td>
</tr>
</tbody>
</table>

**Note**

Only used on the database host.

<table>
<thead>
<tr>
<th>User</th>
<th>Primary Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>db2&lt;dbsid&gt;</td>
<td>db&lt;dbsid&gt;adm (sapinst as secondary group)</td>
</tr>
</tbody>
</table>

**Note**

Only used on the database host.

Groups and Members

<table>
<thead>
<tr>
<th>Groups</th>
<th>Members</th>
</tr>
</thead>
<tbody>
<tr>
<td>sapsys</td>
<td>&lt;sapsid&gt;adm</td>
</tr>
<tr>
<td>db&lt;dbsid&gt;ctl</td>
<td>&lt;sapsid&gt;adm</td>
</tr>
<tr>
<td>db&lt;dbsid&gt;adm</td>
<td>db2&lt;dbsid&gt;</td>
</tr>
<tr>
<td>db&lt;dbsid&gt;mnt</td>
<td>-</td>
</tr>
<tr>
<td>db&lt;dbsid&gt;mon</td>
<td>ABAP connect user sap&lt;sapsid&gt;</td>
</tr>
</tbody>
</table>

SAP Host Agent:
### User and Groups of the SAP Host Agent

<table>
<thead>
<tr>
<th>User</th>
<th>Primary Group</th>
<th>Additional Group</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>sapadm</td>
<td>sapsys</td>
<td>–</td>
<td>SAP Host Agent administrator</td>
</tr>
</tbody>
</table>

**Note**

If `sapadm` does not exist, it is created during the SAP Host Agent installation using `/bin/false` shell.

Make sure that `/bin/false` can be used as a login shell.

Only valid for ‘Platform’: AIX

**AIX:** Add `/bin/false` to the list of valid login shells (attribute `shells` in `/etc/security/login.cfg`).

End of ‘Platform’: AIX

### Groups and Members of the SAP Host Agent User

<table>
<thead>
<tr>
<th>Groups</th>
<th>Members</th>
</tr>
</thead>
<tbody>
<tr>
<td>sapsys</td>
<td>sapadm</td>
</tr>
<tr>
<td>sapinst</td>
<td>sapadm</td>
</tr>
</tbody>
</table>

### 4.3 Required File Systems and Directories

The following sections describe the directory structures for the SAP system, how to set up SAP file systems for the SAP system and, if required, raw devices on operating system level:

**Note**

The installation of any SAP system does not require a special file system setup or separate partitions.

### Related Information

- SAP Directories [page 108]
- Setting Up File Systems for a High-Availability System [page 114]
4.3.1 SAP Directories

Depending on the installation option you have chosen, the installer automatically creates the directories listed in the following figures and tables. Before running the installation, you have to set up the required file systems manually. In addition, you have to make sure that the required disk space for the directories to be installed is available on the relevant hard disks.

The installer creates the following types of directories:

- Physically shared directories
- Logically shared directories
- Local directories

**HP-UX only:** For recommendations about block size and mount option configuration, see SAP Note 1077887.

Directories of the SAP System

The figure below assumes that you have set up one file system for the SAP system mount directory `<sapmnt>` and one file system for the `/usr/sap` directory. However, you have to decide for which directories you want to set up separate file systems. If you do not set up any file system on your installation host, the installer creates all directories in the root directory (`/`). A high-availability setup might influence the file system structure.

Contact your HA partner for their recommendation. For more information, see Setting Up File Systems for a High-Availability System [page 114].

The installer prompts you only for the `<sapmnt>` directory during the installation.

The following figures show the directory structure of SAP systems based on SAP NetWeaver 7.5 and the directory structure of SAP systems based on SAP NetWeaver 7.1 to 7.4:

- **Directory Structure for an ABAP System Based on SAP NetWeaver 7.5:**
  
  In SAP systems based on SAP NetWeaver 7.5 or higher, all application server instances, including the primary application server instance, are named `D<Instance_Number>`. 
Directory Structure for an ABAP System Based on SAP NetWeaver 7.5 or Higher

- **Directory Structure for an ABAP System Based on SAP NetWeaver 7.1 to 7.4:**
  In SAP systems based on SAP NetWeaver 7.1 to 7.4 the primary application server instance is named DVEBMGS<Instance_Number>. 

- **Directory Structure for an ABAP System Based on SAP NetWeaver 7.5 or Higher:**
Every new installation of an ABAP standalone system is Unicode (directory \textit{uc} – Unicode).

**Physically Shared Directories (SAP System)**

Physically shared directories reside on the global host and are shared by Network File System (NFS). The installer creates the following directories:

- The directory \\
/sapmnt\/<SAPSID>, which contains SAP kernel and related files, is created on the first installation host. Normally, the first installation host is the host on which the central services instance is to run, but you can also choose another host for \\
/sapmnt\/<SAPSID>. You need to manually share this directory with Network File System (NFS) and – for a distributed system such as a high-availability system or a system with additional application server instances – mount it from the other installation hosts.

The installer creates the following shared subdirectories in \\
/sapmnt\/<SAPSID> during the SAP system installation. If you install an SAP system with instances distributed over several hosts, you have to share these directories for all hosts with the same operating system (see Exporting and Mounting Global Directories [page 140]):

- \textit{global}
  - Contains globally shared data and database-specific directories. For more information, see Directory Structure of the Db2 Client Connectivity [page 88].
- \textit{profile}
  - Contains the profiles of all instances
- \textit{exe}
Contains a folder `uc` and a folder `nuc`, each with a platform-specific subfolder:

- `<sapmnt>/<SAPSID>/exe/uc/<platform>` is used in Unicode systems.
  Executable kernel programs are replicated from this directory to the `exe` directories of each Unicode system instance.
- `<sapmnt>/<SAPSID>/exe/nuc/<platform>` is used in non-Unicode systems (see below).
  Executable kernel programs are replicated from this directory to the `exe` directories of each non-Unicode system instance (see below).

Contains a folder `jvm` with the SAP JVM files

- **The directory** `/usr/sap/trans`, which is the global transport directory.
  If you want to use an existing transport directory, you have to mount it before you install the relevant application server instance. Otherwise, the installer creates `/usr/sap/trans` locally.

→ **Recommendation**

We recommend that you set up your global transport directory as a shared file system.

For more information about the global transport directory, see Exporting and Mounting the Global Transport Directory [page 138].

### Physically Shared SAP Directories

<table>
<thead>
<tr>
<th>Directory</th>
<th>Required Minimum Disk Space</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;sapmnt&gt;/&lt;SAPSID&gt;</code></td>
<td>Minimum 2.5 GB</td>
</tr>
<tr>
<td><code>/usr/sap/trans</code></td>
<td>This value heavily depends on the use of your SAP system. For production systems, we recommend to use as much free space as available (at least 2 GB), because the space requirement normally grows dynamically. For the installation, it is sufficient to use 2 GB for each SAP system instance. You can enlarge the file system afterwards.</td>
</tr>
</tbody>
</table>

### Logically Shared Directories (SAP System)

Logically shared directories reside on the local hosts with symbolic links to the global host. The installer creates the directory `/usr/sap/<SAPSID>/SYS` on each host.

This directory contains the following symbolic links to physically shared directories:

- Symbolic link `profile` points to `/sapmnt/<SAPSID>/profile`
- Symbolic link `global` points to `/sapmnt/<SAPSID>/global`

This directory contains the `exe` subdirectory with symbolic links pointing to the corresponding subdirectories of `/sapmnt/<SAPSID>/exe` on the SAP global host:

- Symbolic link `uc` (for Unicode) points to `/sapmnt/<SAPSID>/exe/uc`
- Symbolic link `nuc` (for non-Unicode) points to `/sapmnt/<SAPSID>/exe/nuc`
- Symbolic link `run` points to another symbolic link `/usr/sap/<SAPSID>/SYS/exe/dbg` in the same directory, and symbolic link `dbg` finally points to `/sapmnt/<SAPSID>/exe/uc/<platform>`

Whenever a local instance is started, the `sapcpe` program checks the executables against those in the logically shared directories and, if necessary, replicates them to the local instance.
The installer uses `sapcpe` to replicate the kernel automatically from `/usr/sap/<SAPSID>/SYS/exe/run/DIR_CT_RUN` to `/usr/sap/<SAPSID>/<INSTANCE>/exe/DIR_EXECUTABLE` for each SAP system instance.

**Local Directories (SAP System)**

The installer also creates local directories that reside on the local hosts. The directory `/usr/sap/<SAPSID>` contains files for the operation of a local instance as well as symbolic links to the data for one system. This directory is physically located on each host in the SAP system and contains the following subdirectories:

- **SYS**
  
  *Note* The subdirectories of `/usr/sap/<SAPSID>/SYS` have symbolic links to the corresponding subdirectories of `/<sapmnt>/<SAPSID>`, as shown in the figure above.

- Instance-specific directories with the following names:
  - SAP systems based on SAP NetWeaver 7.1 to 7.4:
    - The directory of the primary application server instance is called `DVEBMGS<Instance_Number>`.
    - The directory of an additional application server instance is called `D<Instance_Number>`.
    - The directory of an application server instance (primary application server instance and additional application server instances) is called `D<Instance_Number>`.
  - The directory of the ABAP central services instance (ASCS) instance is called `ASCS<Instance_Number>`.
  - The directory of an ERS instance is called `ERS<Instance_Number>`.
  
  If you install a high-availability system, you must install an ERS instance for the ASCS instance.

**Local SAP Directories**

<table>
<thead>
<tr>
<th>Directory</th>
<th>Description</th>
<th>Required Minimum Disk Space</th>
</tr>
</thead>
</table>
| /usr/sap/<SAPSID>/DVEBMGS<Instance_Number> | Primary application server instance directory | • SAP Business Warehouse server only: minimum 25 GB  
• Other installations: minimum 4 GB |
| /usr/sap/<SAPSID>/D<Instance_Number> | Additional application server instance directory | • SAP Business Warehouse server only: minimum 25 GB  
• Other installations: minimum 4 GB |
| /usr/sap/<SAPSID>/ASCS<Instance_Number> | ABAP central services instance (ASCS instance) directory | Minimum 2 GB |
| /usr/sap/<SAPSID>/ERS<Instance_Number> | ERS instance directory for the ASCS instance (high availability only) | Minimum 2 GB |
Directories of the SAP Host Agent

The SAP Host Agent has only local directories as shown in the following figure:

**Local Directories (SAP Host Agent)**

The SAP Host Agent directory `/usr/sap/hostctrl` requires 100 MB of disk space. It contains the following subdirectories:

- `/exe`
  - Contains the profile `host_profile`
- `/work`
  - Working directory of the SAP Host Agent

**More Information**

Required File Systems for IBM Db2 for Linux, UNIX, and Windows [page 83]
4.3.2 Setting Up File Systems for a High-Availability System

Third-party technology is used to make the SAP directories available to the SAP system. The technologies of choice are NFS, shared disks, and cluster file system. If you have decided to use a high-availability (HA) solution for your SAP system, make sure that you properly address the HA requirements of the SAP file systems in your SAP environment with the HA partner of your choice.

Prerequisites

You have already installed the hardware – that is, hosts, disks, and network – and decided how to distribute the database, SAP instances, and – if required – Network File System (NFS) server over the cluster nodes (that is, over the host machines). For more information, see Planning the Switchover Cluster [page 97] and contact your HA partner.

Context

From the perspective of an SAP application, there are the following types of SAP Directories [page 108]:

- Physically shared directories: /<sapmnt>/<SAPSID> and /usr/sap/trans
  In an HA setup, /<sapmnt> should be a highly available file system, and /usr/sap/trans should be a shared file system.
- Logically shared directories that are bound to a node such as /usr/sap with the following local directories:
  - /usr/sap/<SAPSID>
  - /usr/sap/<SAPSID>/SYS
  - /usr/sap/hostctrl
  In an HA Setup, no special actions are required for these local directories.
- Local directories that contain the SAP instances such as /usr/sap/<SAPSID>/ASCS<Instance Number>.
  In an HA setup, the directories of the clustered instances (/usr/sap/<SAPSID>/<Instance Type><Instance Number>) should be mounted as cluster-controlled file systems and reside on highly available file systems.

Only valid for 'Platform': HP-UX

HP-UX only: For recommendations about block size and mount option configuration, see SAP Note 1077887.

End of 'Platform': HP-UX

Procedure

1. Create the file systems or raw partitions for the SAP instances you can switch over in such a way that the content can be made available to all nodes that can run the service.
At least the ABAP central services (ASCS) instance and the ERS instance must be part of the switchover cluster.

The SAP directories `/<sapmnt>/<SAPSID>` and `/usr/sap/trans` are usually mounted from a Network File System (NFS). Especially for `/<sapmnt>/<SAPSID>` you should think of using a highly available file system. However, an SAP instance directory `/usr/sap/<SAPSID>/<Instance Type><Instance Number>` that you want to prepare for HA must always be mounted on the cluster node that is currently running the instance.

⚠️ **Caution**

To start or stop an SAP instance, you have to do one of the following:
- Make the physically shared SAP directories under `/<sapmnt>/<SAPSID>` available to the server beforehand.
- Consult your HA partner to clarify the best solution for the cluster software.

2. Use the following approach for the file system for the `/usr/sap/<SAPSID>` directory:

   The `/usr/sap/<SAPSID>` directory contains at least two subdirectories (see also **SAP Directories** [page 108]):
   - `SYS/<sapmnt>/<SAPSID>`
   - `<Instance Type> <Instance Number>` – where the name is defined by the type of services and the application server number:
     - **SAP systems based on SAP NetWeaver 7.5 or higher**: `D<Instance Number>` – which contains data for the primary application server instance or an additional application server instance
     - **SAP systems based on SAP NetWeaver 7.1 to 7.4**: `DVEBMGS<Instance Number>` – which contains data for the primary application server instance
     - **SAP systems based on SAP NetWeaver 7.1 to 7.4**: `D<Instance Number>` – which contains data for an additional application server instance
     - `ASCS<Instance Number>` – which contains data for the ABAP central services instance (ASCS instance)
     - `ERS<Instance Number>` – which contains the replication table, which is a copy of the lock table

   Only `<Instance Type><Instance Number>` directories of clustered instances need to be migrated with the SAP instances during the switchover.

   Create cluster-controlled file systems for `/usr/sap/<SAPSID>/<Instance Type><Instance Number>` of clustered instances.

   The instance-specific directory name for the ABAP central services instance is normally `ASCS<Instance Number>`. Migrating only these directories avoids mount conflicts when switching over to a node on which another application server instance is already running. The `ASCS<Instance Number>` directory can join the `/usr/sap/<SAPSID>` tree instead of mounting on top of it. The same is true for all other clustered instances.

ℹ️ **Note**

This approach becomes increasingly important when you want to cluster the central services instances with other local instances running on the cluster hosts outside the control of the switchover software. This applies to the ERS instance and additional ABAP application server instances. The result is a more
efficient use of resources. Use this approach for integrated installations of the application server with ABAP stacks.

3. You assign the local (not switching) file systems to **permanent** mount points.
4. You assign the shared file systems as documented by your HA partner.

**Example**

The graphic below shows a scenario of the file systems and disks in an HA setup with an integrated NFS server. Such a setup is not mandatory. For more information about a setup that meets your needs, consult your HA partner.
4.4 Using Virtual Host Names

You can use one or more virtual TCP/IP host names for SAP servers within an SAP server landscape to hide their physical network identities from each other. This can be useful when quickly moving SAP servers or complete server landscapes to alternative hardware since you do not need to reinstall or reconfigure.

Prerequisites

Make sure that the virtual host name can be correctly resolved in your Domain Name System (DNS) setup.

Context

If you want to install a high-availability (HA) system [page 31], you need the virtual host name when you install the ASCS instance in a cluster.

Procedure

Proceed as described in SAP Note 962955. Assign the required virtual host names to the instance to be installed by specifying them in the `<Instance_Name> Host Name` field of the `<Instance_Name> Instance` screen while running the installer.

For more information, see the Virtual Host Name parameter description in SAP System Parameters [page 64].

4.5 Performing Switchover Preparations for High Availability

You have to assign virtual host names to prepare the switchover for high-availability.

Context

To be able to use the required virtual host names [page 117], you have to set the installer property `SAPINST_USE_HOSTNAME` to specify the required virtual host name before you start the installer. Alternatively, you can specify the virtual host in the `<Instance_Name> Host Name` field of the `<Instance_Name> Instance` screen.
To assign a virtual host name to a database instance, you must run the installer with the SAPINST_USE_HOSTNAME property.

For more information, see Virtual Host Name in SAP System Parameters [page 64].

Procedure

Assign the virtual IP addresses and host names for the ASCS instance, and (if required) NFS to appropriate failover groups.

i Note

For more information on virtual addresses and virtual host names and how to assign resources to failover groups, ask your HA partner.

4.6 Installing the SAP Front-End Software

Before you start the installation, make sure that the SAP front-end software is installed on at least one computer in your system environment to be able to log on to the SAP system after the installation has finished.

Procedure

1. Check SAP Note 147519 for the recommended SAP front-end release.
2. Install the SAP front-end software required for your SAP system release as described in the documentation SAP Frontend Installation Guide - <Release> at: https://wiki.scn.sap.com/wiki/display/ATopics/SAP+GUI+Family

4.7 Preparing the Installation Media

This section describes how to prepare the installation media.

Installation media are available as follows:

- The Software Provisioning Manager 1.0 archive containing the installer
  You always have to download the latest version of the Software Provisioning Manager 1.0 archive.
  For more information, see Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 123].
The media containing the software to be installed. These are the following:

- Kernel media:
  - You can make them available in one of the following ways:
    - Download the specific kernel archives from the SAP Software Center - this is the recommended way.
    - Download the SAP kernel archives (SAR files) from the SAP Software Center.
      If you are performing an Installation Using a Stack Configuration File [page 45], you can directly download the artefacts (SAR archives) as specified in the Maintenance Plan.
    - Use the physical installation media as part of the installation package.
    - Download the complete kernel media from the SAP Software Center.

- RDBMS and export media.
  - You can make them available in one of the following ways:
    - Use the physical installation media as part of the installation package.
    - Download the complete kernel media from the SAP Software Center.

For detailed information about how to obtain these media, see Media Required for the Installation - Listed by SAP System Instance [page 119].

Related Information

Media Required for the Installation - Listed by SAP System Instance [page 119]
Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 123]
Downloading SAP Kernel Archives (Archive-Based Installation) [page 125]
Downloading Software Packages for a Maintenance Planner Transaction [page 128]
Downloading Complete Installation Media [page 130]

4.7.1 Media Required for the Installation - Listed by SAP System Instance

This section provides a list of the media required for the installation, listed by SAP system instance to be installed.

The signature of installation media is checked automatically by the installer during the Define Parameters phase while the Media Browser screens are processed (see also Running the Installer [page 147]). The installer only accepts media whose signature has been checked. For more information, see SAP Note 2393060.

For more information about which kernel version to use, see SAP Note 1680045. In addition, check the Product Availability Matrix at: http://support.sap.com/pam.

The installer requests the related kernel media during the corresponding procedure. For more information about release and road map information around the kernel versions and their relationship to SAP NetWeaver support packages including important notes on downward compatibility and release dates, see the document Understanding Kernel Releases for the SAP NetWeaver AS ABAP at http://scn.sap.com/docs/DOC-54170.

Proceed as follows to make the media available:
1. Identify the required media for your installation [page 29] as listed below.

<table>
<thead>
<tr>
<th>SAP Instance Installation</th>
<th>Required Software Packages from Installation Media</th>
</tr>
</thead>
</table>
| ABAP Central services instance (ASCS instance) | ○ Software Provisioning Manager 1.0 archive  
○ UC or NUC Kernel (folder K_<Version>_<N or U>_<OS>) where U means Unicode and N means non-Unicode. |
| Database instance | ○ Software Provisioning Manager 1.0 archive  
○ UC or NUC Kernel (folder K_<Version>_<N or U>_<OS>) where U means Unicode and N means non-Unicode. |
| | ▲ Caution  
○ For the installation of your SAP system, only the English version of Db2 is supported.  
○ You must only use the Db2 software provided by the SAP installation media. |
| | ○ Installation Export (folders EXP*) |
| Enqueue Replication Server | ○ Software Provisioning Manager 1.0 archive  
○ UC or NUC Kernel (folder K_<Version>_<N or U>_<OS>) where U means Unicode and N means non-Unicode. |
| | ▲ i Note  
Every new installation of an SAP system is Unicode. You can only use the non-Unicode kernel if you perform the system copy for a non-Unicode SAP system that has been upgraded to the current release.
### SAP Instance Installation

<table>
<thead>
<tr>
<th>Required Software Packages from Installation Media</th>
</tr>
</thead>
<tbody>
<tr>
<td>○ Software Provisioning Manager 1.0 archive</td>
</tr>
<tr>
<td>○ UC or NUC Kernel (folder K_&lt;Version&gt;<em>U</em>&lt;OS&gt;) where U means Unicode and N means non-Unicode.</td>
</tr>
</tbody>
</table>

**i Note**

Every new installation of an SAP system is Unicode. You can only use the non-Unicode kernel if you perform the system copy for a non-Unicode SAP system that has been upgraded to the current release.

- Installation Export (folders EXP*)
- **SAP SCM only:** SAP liveCache
- Database Client Software
- CLI Driver / JDBC Driver

**Caution**

You must only use the Db2 software provided by the SAP installation media.

### Additional application server instance

<table>
<thead>
<tr>
<th>Required Software Packages from Installation Media</th>
</tr>
</thead>
<tbody>
<tr>
<td>○ Software Provisioning Manager 1.0 archive</td>
</tr>
<tr>
<td>○ UC or NUC Kernel (folder K_&lt;Version&gt;<em>U</em>&lt;OS&gt;) where U means Unicode and N means non-Unicode.</td>
</tr>
</tbody>
</table>

**i Note**

If you install an additional application server instance in an existing non-Unicode system, the additional application server instance is created automatically as a non-Unicode instance. The installer checks whether a non-Unicode system exists and chooses the right executables for the system type.

- **SAP SCM only:** SAP liveCache
- CLI Driver / JDBC Driver

**Caution**

You must only use the Db2 software provided by the SAP installation media.

### SAP Host Agent (Separate Installation Only)

<table>
<thead>
<tr>
<th>Required Media</th>
</tr>
</thead>
<tbody>
<tr>
<td>○ Software provisioning manager 1.0 archive</td>
</tr>
<tr>
<td>○ UC Kernel (folder K_&lt;Version&gt;<em>U</em>&lt;OS&gt;) where U means Unicode.</td>
</tr>
</tbody>
</table>

2. Make the installation media available on each installation host as follows:
   1. Download and unpack the latest version of Software Provisioning Manager as described in [Downloading and Extracting the Software Provisioning Manager 1.0 Archive](#).
   2. Make the kernel media available.
You can do this in one of the following ways:

○ Download the dedicated kernel archives - this is the recommended way.
  For more information, see Downloading SAP Kernel Archives (Archive-Based Installation) [page 125].

**Note**
If you are using a stack configuration file (see Installation Using a Stack Configuration File [page 45]), you have the installation media defined when generating the Landscape Plan. The media link provided in the Landscape Plan guides you to the location in the SAP Software Download Center at https://launchpad.support.sap.com/#/softwarecenter where you can download the installation media required for your SAP product, operating system and database.

Using the installer, you can also directly download the artefacts (SAR archives) as specified in the Maintenance Plan. For more information, see Downloading Software Packages for a Maintenance Planner Transaction [page 128].

○ Use the physical kernel medium from the installation package.
  You can do this in one of the following ways:
  ○ Copy the required media folders directly to the installation hosts.
  ○ Mount the media on a central media server that can be accessed from the installation hosts.

**Caution**
If you copy the media to disk, make sure that the paths to the destination location of the copied media do not contain any blanks.

○ Download the kernel medium from the Software Download Center.
  For more information, see Downloading Complete Installation Media [page 130].

**Note**
Even if you use the complete kernel media, the installer might prompt you during the provisioning process for additional archives (*.SAR files) due to special Patch Level (PL) requirements depending on categories such as the product, operating system, and database platform at the end of this section.

For example: The installer might require a certain PL of `<X>` of the `SAPEXEDB.SAR` (for DBTYPE `<Y>`), but this PL of the `SAPEXEDB.SAR` is not contained in the SAP kernel media. In this case you have to download the required PL from https://launchpad.support.sap.com/#/softwarecenter following the instructions in Downloading SAP Kernel Archives (Archive-Based Installation) [page 125].

**Note**
If you perform an additional application server installation, kernel archives - such as `SAPEXE<Version>.SAR`, `SAPEXEDB<Version>.SAR`, `IGSEXE<Version>.SAR`, and `igshelper<version>.sar` - are only prompted if they cannot be retrieved from the primary application server instance or the ASCS instance of the existing SAP system.

3. Make the RDBMS and export media available.
You can do this in one of the following ways:

- Copy the required media folders directly to the installation hosts.
- Mount the media on a central media server that can be accessed from the installation hosts.

⚠️ **Caution**

If you copy the media to disk, make sure that the paths to the destination location of the copied media do not contain any blanks.

3. If you want to perform target system installation in the context of a **heterogeneous system copy** you need a migration key. You can generate it at [https://support.sap.com/migrationkey](https://support.sap.com/migrationkey).

**Related Information**

- [Downloading and Extracting the Software Provisioning Manager 1.0 Archive](#)
- [Downloading SAP Kernel Archives (Archive-Based Installation)](#)
- [Downloading Software Packages for a Maintenance Planner Transaction](#)
- [Downloading Complete Installation Media](#)

**4.7.1.1 Downloading and Extracting the Software Provisioning Manager 1.0 Archive**

You must always download and extract the Software Provisioning Manager 1.0 archive from the SAP Software Download Center because you must use the latest version.

**Context**

You require the latest version of the SAPCAR tool to be able to unpack and verify software component archives (*.SAR files). *.SAR files are the format of software lifecycle media and tools that you can download from the SAP Software Download Center. For more information about how to get this tool, see the Procedure section below.

An up-to-date version of the load tools - such as R3load, R3szchk, R3ldctl, SAPuptool - which were available so far only in the SAPEXEDB.SAR archive of the kernel media, has now been made available in the Software Provisioning Manager archive (SWPM10SP<Support_Package_Number>_<Version_Number>.SAR), in a sub-archive named LOADTOOLS.SAR, located in the COMMON/LOADTOOLS folder. For an installation using kernel version 7.40 or higher, the load tools from the SWPM10SP<Support_Package_Number>_<Version_Number>.SAR are used automatically instead of the load tools available in the SAPEXEDB.SAR archive of the kernel media. **There is no action required from your side**, the installer uses the relevant load tools automatically once you run it from the extracted SWPM10SP<Support_Package_Number>_<Version_Number>.SAR archive.
**Procedure**

1. Download the latest version of the Software Provisioning Manager 1.0 archive SWPM10SP<Support_Package_Number>_<Version_Number>.SAR from:

   https://support.sap.com/sitoolset ➔ System Provisioning ➔ Download Software Provisioning Manager

2. Make sure that you use the latest version of the SAPCAR tool when manually extracting the Software Provisioning Manager archive.

   **Note**
   An older SAPCAR version might extract archive files in a wrong way and this could prevent the installer from working consistently.

   Proceed as follows to get the latest version of SAPCAR:
   a. Go to https://launchpad.support.sap.com/#/softwarecenter ➔ SUPPORT PACKAGES & PATCHES and search for "sapcar".
   b. Select the archive file for your operating system and download it to an empty directory.
   c. Rename the executable to sapcar.exe.

   For more information about SAPCAR, see SAP Note 212876.

3. Using the latest version of SAPCAR, you can verify the signature of the downloaded SWPM10SP<Support_Package_Number>_<Version_Number>.SAR archive as follows:
   a. Get the latest version of the SAPCRYPTOLIB archive to your installation host as follows:
      1. Go to https://launchpad.support.sap.com/#/softwarecenter ➔ SUPPORT PACKAGES & PATCHES and search for "sapcryptolib".
      2. Select the archive file for your operating system and download it to the same directory where you have put the SAPCAR executable.
      3. Use the following command to extract the SAPCRYPTOLIB archive to the same directory where you have put the SAPCAR executable:
         `sapcar -xvf sapcryptolibp_84_sar -R <target directory>`
      4. Download the Certificate Revocation List from https://tcs.mysap.com/crl/crlbag.p7s and move it to the same directory.
   b. Verify the signature of the downloaded SWPM10SP<Support_Package_Number>_<Version_Number>.SAR archive by executing the following command:

      **Note**
      Check SAP Notes 2178665 and 1680045 whether additional information is available.

      `<Path to SAPCAR>/sapcar -tvVf <Path to Download Directory>/SWPM10SP<Support_Package_Number>_<Version_Number>.SAR -crl<file name of revocation list>`

4. Unpack the Software Provisioning Manager archive to a local directory using the following command:
```bash
/path/to/SAPCAR>/sapcar -xvf <Path to Download Directory>/SWPM10SP<Support_Package_Number>_<Version_Number>.SAR -R <Path to Unpack Directory>
```

**Note**
Make sure that all users have read permissions for the directory where you want to unpack the installer.

**Caution**
Make sure that you unpack the Software Provisioning Manager archive to a dedicated folder. Do not unpack it to the same folder as other installation media.

### 4.7.1.2 Downloading SAP Kernel Archives (Archive-Based Installation)

Instead of downloading the complete SAP kernel media, we recommend that you download the SAP kernel archives specifically required for your installation option. During the installation, you can either specify the path to each archive separately, or provide the path to a download basket with all downloaded archives.

**Note**
If you are performing an installation using a stack configuration file, you can use the service Downloading Software Packages for a Maintenance Planner Transaction [page 128].

#### Context

The signature of installation archives is checked automatically by the installer [page 147] during the Define Parameters phase while processing the Software Package Browser screens. The installer only accepts archives whose signature has been checked. After scanning the archives and verifying the signature, an info file is written where you can find detailed information about matching and non-matching archive files. You can access this info file by choosing the info file link in the Archive Scanning Result section of the Software Package Browser screen. The info file contains only the results of the latest archive scan. For more information, see SAP Note 2393060.

#### Procedure

1. Download and unpack the latest version of Software Provisioning Manager as described in Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 123].
2. Go to https://launchpad.support.sap.com/#/softwarecenter SUPPORT PACKAGES & PATCHES
3. Choose the required software component, release, and technical stack:

○ If you want to install SAP NetWeaver AS for ABAP 7.52, choose SAP NetWeaver and complementary products > NW AS ABAP INNOVATION PKG > NW AS ABAP 7.52

○ If you want to install SAP NetWeaver AS for ABAP 7.51 innovation package, choose SAP NetWeaver and complementary products > NW AS ABAP INNOVATION PKG > NW AS ABAP 7.51 INNOVATION PKG

○ If you want to install AS ABAP FOR OOEM, choose SAP NetWeaver and complementary products

○ If you want to install SAP NetWeaver Mobile 7.1, choose SAP NetWeaver and complementary products > SAP NETWEAVER MOBILE <Release> Entry by Component

○ If you want to install an SAP NetWeaver ABAP system, choose SAP NetWeaver <Release> [For releases lower than 7.5: Entry by Component] Application Server ABAP

○ If you want to install an SAP Business Suite system based on SAP NetWeaver, choose SAP Application Components <SAP CRM | SAP ERP | SAP SCM | SAP SRM> <Release> Entry by Component <ABAP Product Instance>

4. Choose the required package:

ℹ️ Note

If you perform an additional application server installation, kernel archives - such as SAPEXE<Version>.SAR, SAPEXEDB<Version>.SAR, IGSEXEC<Version>.SAR, igshelper<version>.sar - are only prompted if they cannot be retrieved from the primary application server instance or the ASCS instance of the existing SAP system.

⚠️ Caution

○ Make sure that you always use the highest available patch level unless special patch levels are specified for the relevant package in SAP Note 1680045.

○ Make sure that you always choose SAPEXE<Version>.SAR, SAPEXEDB<Version>.SAR of the same SAP kernel release and extension.

💡 Example

○ If SAPEXE<Version>.SAR is of version 7.49, then SAPEXEDB<Version>.SAR must also be of version 7.49.

○ If SAPEXE<Version>.SAR is of version 7.45, then SAPEXEDB<Version>.SAR must also be of version 7.45.

○ If SAPEXE<Version>.SAR is of version 7.42 EXT, then SAPEXEDB<Version>.SAR must also be of version 7.42 EXT.

○ If you provide the archives in one download folder, and there is more than one version of the same archive available - for example SAPEXE<Version>.SAR - and these versions match the product-specific requirements, the installer selects one of these archive versions. If you want a specific archive version to be used, make sure that this is the only version available in the download folder. When running system provisioning in GUI mode, you can also check in the GUI which archive is being used. So even if there is more than one version of the same archive available in the download
folder, you can select the exact archive version you want to use and enter the exact path to the required archive file.

○ SAPEXE<Version>.SAR
  ➝ SAP KERNEL <Version> ➝ <Operating System> ➝ #DATABASE INDEPENDENT ➝
  If you want to install an SAP system based on SAP NetWeaver AS for ABAP 7.52 or higher, you can only choose 7.49 UNICODE for SAP KERNEL <Version>.
  If you want to install an SAP system based on SAP NetWeaver AS for ABAP 7.51 innovation package or higher, you can either choose 7.45 or 7.49 UNICODE for SAP KERNEL <Version>.
  If you want to install an SAP system based on SAP NetWeaver 7.5, you can either choose 7.45 or 7.49 UNICODE for SAP KERNEL <Version>.
  If you want to install an SAP system based on SAP NetWeaver 7.4, you can choose either 7.45 or 7.42 for SAP KERNEL <Version>.
  If you want to install an SAP system based on SAP NetWeaver 7.3 EHP1 or lower, choose 7.21 EXT for SAP KERNEL <Version>.

○ SAPEXEDB<Version>.SAR
  Choose the version corresponding to the SAPEXE<Version>.SAR from SAP KERNEL <Version> ➝ <Operating System> ➝ <DATABASE> ➝

○ igsexe<Version>.sar
  ➝ SAP IGS <Version> ➝ <Operating System> ➝
  If you want to install an SAP system based on SAP NetWeaver Application Server for ABAP 7.52, choose SAP IGS <7.49 or 7.53> ➝ # OS independent ➝
  If you want to install an SAP system based on SAP NetWeaver Application Server for ABAP 7.51 innovation package, choose SAP IGS <7.45 or 7.49> ➝ # OS independent ➝ depending on your SAPEXE<Version>.SAR version.
  If you want to install an SAP system based on SAP NetWeaver 7.5, choose SAP IGS <7.45 or 7.49> ➝ # OS independent ➝ depending on your SAPEXE<Version>.SAR version.
  If you want to install an SAP system based on SAP NetWeaver 7.4 and your SAPEXE<Version>.SAR is of version <7.45 or 7.49>, then choose SAP IGS <7.45 or 7.49> ➝ # OS independent ➝ depending on your SAPEXE<Version>.SAR version.. Otherwise, choose SAP IGS 7.20_EXT ➝ # OS independent ➝
  If you want to install an SAP system based on SAP NetWeaver 7.3 EHP1, choose SAP IGS 7.20_EXT ➝ # OS independent ➝
  If you want to install an SAP system based on SAP NetWeaver 7.3 or lower and use SAP kernel 7.21_EXT, choose SAP IGS 7.20_EXT ➝ <Operating System> ➝
  If you want to install an SAP system based on SAP NetWeaver 7.3 or lower and use SAP kernel 7.21, choose SAP IGS 7.20 ➝ <Operating System> ➝

○ igshelper<Version>.sar
  ➝ If you want to install an SAP system based on SAP NetWeaver 7.3 EHP1 or higher, choose SAP IGS HELPER ➝ # OS independent ➝
  ➝ If you want to install an SAP system based on SAP NetWeaver 7.3 or lower, choose SAP IGS 7.20 ➝ <Operating System> ➝

○ SAPHOSTAGENT<Version>.SAR
**SAP HOST AGENT 7.21** *(Operating System)*

→ **Recommendation**

It is highly recommended that you always choose the highest SP version of the SAPHOSTAGENT<SP-version>.SAR archive.

**Note**

The SAPHOSTAGENT<Version>.SAR archive is only prompted if there is either no SAP Host Agent available on the installation host or you specified during the Define Parameters phase that you want to upgrade an existing version of the SAP Host Agent already available on the installation host. In the latter case, you must specify a higher version of the SAPHOSTAGENT<Version>.SAR. Otherwise, the existing SAP Host Agent is not upgraded.

5. If you want to install an SAP system based on SAP NetWeaver 7.3 EHP1 or lower - that is you have to use SAP kernel 7.21 - download the latest patch level of SAPCRYPTOLIB <Version>.SAR from the following path:

https://launchpad.support.sap.com/#/softwarecenter

Support Packages and Patches ➔ By Category ➔ Additional Components ➔ SAPCRYPTOLIB ➔ COMMONCRYPTOLIB<Version> ➔ <Operating System>

6. Make the RDBMS and the export media available - either by using physical media as described in Media Required for the Installation - Listed by SAP System Instance [page 119] or by downloading them as described in Downloading Complete Installation Media [page 130].

**Related Information**

Downloading Software Packages for a Maintenance Planner Transaction [page 128]

**4.7.1.3 Downloading Software Packages for a Maintenance Planner Transaction**

Software Provisioning Manager (the installer) is now enabled to download all software packages that have been defined in a Maintenance Planner Transaction.

**Note**

This feature is only available if you perform an installation using a stack configuration file.

**Prerequisites**

Plan your new SAP system including the required Support Package level (applicable for SAP S/4 HANA, SAP NetWeaver, SAP Business Suite, and SAP Financials) as available in the Maintenance Planner and run sapinst.
SAPINST_STACK_XML=<stack configuration file> in order to benefit from an automated installation process.

Procedure

1. Specify a download directory for the artifacts (SAP archives) to be downloaded.
2. Start the installer as described in Running the Installer [page 147].
4. Follow the instructions on the installer screens.

The installer prompts you for the following input parameters:

- **Maintenance Planner Transaction ID**
  You can find the Maintenance Planner Transaction ID by one of the following ways:
  - In the *MP_Plan_*<Transaction ID>_*<Generation Date>_.pdf file which you can download during the Completed step in the Maintenance Planner by choosing the Download PDF button.
  - From the *Transaction ID* column in the list of transactions displayed in the Transactions panel in the maintenance planner.
  - From the parameter *mopz-transaction-id* in the stack configuration file *MP_Stack_*<Transaction ID>_*<Generation Date>_.xml* which you can download during the Download Files step in the Maintenance Planner by choosing the Download Stack XML button.

  **Note**
  If you started the installer using a stack configuration file, the Maintenance Planner Transaction ID is only displayed.

- **Your S-UserID and password**
  You call Software Provisioning Manager with command line parameter `SAPINST_STACK_XML=<Absolute_Path_To_Stack_XML_File>` to get the Maintenance Planner Transaction ID extracted from the stack configuration file.
  You must perform this option directly after creating the Maintenance Planner Transaction, because the contained download links usually expire soon.

  Ensure the following for your S-User:
  1. You have download permissions for all artifacts on https://launchpad.support.sap.com/#/softwarecenter to be able to download them.
  2. Consider the SAP Support Portal and the SAP ONE Support Launchpad password policies: Your **password must be the same** for both of them. If the passwords are not the same, you will lock the S-User in the SAP Support Portal. The **password must meet all of the following requirements**:
     - Must be exactly eight characters long
     - Contains at least one upper-case letter (A-Z)
     - Contains at least one lower-case letter (a-z)
     - Contains at least one decimal digit (0-9)
     - Contains at least one of the following special characters: ! $ % / ( ) + - * = ? ' ~ # _ . , ; : < >
     - Must not start with ? or !
Must not contain any blanks
Must not begin with three identical characters
Must be different from the last five passwords you have already used
Only one password change is allowed per day

- Location of download folder for the installation software packages to be downloaded
- If you have a proxy configured in your network, provide the proxy host and port.

5. You get a list of all downloadable artifacts (SAP archives) as specified in the stack configuration file along with their file size.
You can still deselect downloadable artifacts (SAP archives) that you do not need to be downloaded.

6. Choose Next to start the download.
If you get a download error, this is the result of an unsuccessful network connection. Check your network connection and proxy configuration. If the download of some artifacts finishes without any error, but still with a status other than OK, you must do one of the following:
- Create an up-to-date Maintenance Plan and perform again the download of the files which were not downloaded successfully. In case of an error, the installer skips the download of the artifact (SAR archive) in question and continue with the next one in the list.
- Download the still missing files directly from the SAP Software Center at https://launchpad.support.sap.com/#/softwarecenter.

Results

You have downloaded the artifacts (SAP archives) required for your SAP system installation with Software Provisioning Manager (the installer) - corresponding to the archives listed in section Downloading SAP Kernel Archives (Archive-Based Installation) [page 125] - and for applying the required kernel and support packages using Software Update Manager (SUM) after the installation has completed.

SAP BW/4HANA 1.0 SR1 only: RDBMS and export media are not covered by this feature. You have to provide them either as physical media or download them from the SAP Software Center as described in Downloading Complete Installation Media [page 130].

4.7.1.4 Downloading Complete Installation Media

This section describes how you can download complete media from the SAP Software Download Center.

Procedure

1. Download and unpack the latest version of Software Provisioning Manager as described in Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 123].
2. Create a download directory on the host where you want to run the installer.

3. You identify the required media as listed in Media Required for the Installation - Listed by SAP System Instance [page 119].

4. Identify all download objects that belong to one medium according to one of the following:

- **Note**
  Installation media might be split into several files. In this case, you have to reassemble the required files after the download.

- **Download path or location:**
  - To download the complete kernel media, go to https://support.sap.com/sitoolset System Provisioning > Software Provisioning Manager 1.0 SP<Current Version> > Download Kernel releases delivered for SL Toolset > SL TOOLSET 1.0 (INSTALLATIONS AND UPGRADES) > KERNEL FOR INSTALLATION/SWPM.
  - To download all media required for your SAP product, you can use one of the following navigation paths:
    - https://launchpad.support.sap.com/#/softwarecenter INSTALLATIONS & UPGRADES > By Category > SAP NETWEAVER AND COMPLEMENTARY PRODUCTS > <Product> <Product Release>
  - **Material number**
    All download objects that are part of an installation medium have the same material number and an individual sequence number:
    `<Material_Number>`<Sequence_Number>

- **Example**
  51031387_1
  51031387_2
  ...

- **Title**
  All objects that are part of an installation medium have the same title, such as `<Solution>`<Media_Name><OS> or `<Database>`RDBMS<OS> for database media.

5. Download the objects to the download directory.

6. To correctly re-combine the media that are split into small parts, unpack all parts into the same directory.

   In the unpacking directory, the system creates a subdirectory with a short text describing the medium and copies the data into it. The data is now all in the correct directory, the same as on the medium that was physically produced. For more information, see SAP Note 1258173.

- **Caution**
  Make sure that you unpack each installation media to a separate folder. Do not unpack installation media to the same folder where you unpack the Software Provisioning Manager archive.
Do not unpack installation media to the same folder where you unpack the SAP kernel archives for archive-based installation.
5 Installation

5.1 Installation Checklist

This section includes the installation steps for the following:

- Standard system
- Distributed system
- High-availability system
- Additional application server instance

Detailed information about the steps are available in the linked sections.

ℹ️ Note

This guide does not cover the installation of SAP systems running on IBM Db2 with the Db2 pureScale Feature. For information about the required installation steps for IBM Db2 with the Db2 pureScale Feature, see the installation guide *Running an SAP System on IBM Db2 with the Db2 pureScale Feature* (listed in Online Information from SAP [page 245]).

Standard System

ℹ️ Note

In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a standard system, you can ignore references to other hosts.

1. You check the prerequisites [page 143] and run the installer [page 147] to install the SAP system.

ℹ️ Note

In a standard system, all mandatory instances are installed on one host in one installation run.

2. You continue with Post-Installation [page 162].

Distributed System

1. If you want to share the transport directory `trans` from another system, you have to mount [page 138] it from this system. Otherwise, we recommend that you share the `trans` directory that is created during the installation of the primary application server instance.
On the **ASCS instance host**, you do the following:

1. You check the prerequisites [page 143] and run the installer [page 147] to install the ABAP central services instance (ASCS instance).

   **Note**
   
   If you want to install an ASCS instance with integrated SAP Web Dispatcher [page 37] or with integrated SAP Gateway [page 39] or both, you must choose the *Custom* parameter mode.

   When processing the screens for the ASCS instance installation, you are prompted to mark the corresponding checkbox on the screen **Additional Components to be Included in the ASCS Instance**.

   If you mark the checkbox for SAP Web Dispatcher, you are prompted for the additional parameters required for the SAP Web Dispatcher installation on the subsequent screens.

2. You export global directories [page 140] in `<sapmnt>/SAPSID` to the database and primary application server instance host.

3. On the **database instance host**, you do the following:
   
   1. You mount the global directories [page 140] in `<sapmnt>/SAPSID` that you exported from the SAP global host and – optionally – the `trans` directory that you exported [page 138] from the SAP transport host.
   
   2. You check the prerequisites [page 143] and run the installer [page 147] to install the database instance.

4. On the **primary application server instance host**, you do the following:
   
   1. You mount the global directories [page 140] in `<sapmnt>/SAPSID` that you exported from the SAP global host.
   
   2. You check the prerequisites [page 143] and run the installer [page 147] to install the primary application server instance.
   
   3. If you want to use the shared transport directory `trans` from another system, you also mount [page 138] this directory.

5. You continue with Post-Installation [page 162].

**Graphical Overview**
The following figure shows how you install the various instances in a distributed system:

![Distribution of Instances in an ABAP System](image)

**High-Availability System**

1. You make sure that you have already prepared the standby node, host B. You ought to have already made sure that it meets the hardware and software requirements and that it has all the necessary file systems, mount points, and (if required) Network File System (NFS). This is described in Performing Switchover Preparations for High Availability [page 117] and Setting Up File Systems for a High Availability System [page 114].

2. If you want to share the transport directory `trans` from another system, you have to mount [page 138] it from this system. Otherwise we recommend that you share the `trans` directory that is created during the installation of the primary application server instance (see below).

3. You set up the switchover cluster infrastructure as follows:
   1. You check the prerequisites [page 143] and run the installer [page 147] to install the ABAP central services instance (ASCS instance) on the primary cluster node, host A. Use a virtual host name [page 117].

   **i Note**
   If you want to install an ASCS instance with integrated SAP Web Dispatcher [page 37] or with integrated SAP Gateway [page 39] or both, you must choose the Custom parameter mode.
When processing the screens for the ASCS instance installation, you are prompted to mark the corresponding checkbox on the screen Additional Components to be Included in the ASCS Instance.

If you mark the checkbox for SAP Web Dispatcher, you are prompted for the additional parameters required for the SAP Web Dispatcher installation on the subsequent screens.

2. You check the prerequisites [page 143] and run the installer [page 147] to install the ERS instance for the ASCS instance on the primary cluster node, host A. Use a virtual host name [page 117].

3. You export global directories [page 140] in <sapmnt>/<SAPSID> to the database host and to the primary application server instance host.

4. You prepare the standby cluster node, host B, making sure that it meets the hardware and software requirements [page 47] and it has all the necessary file systems [page 114], mount points, and (if required) Network File System (NFS).

5. You set up the user environment on the standby node, host B:
   - You use the same user and group IDs, and OS specific files (such as etc/services) as on the primary node.
   - You create the home directories of users and copy all files from the home directory of the primary node.
   
   For more information about the required operating system users and groups, see Creating Operating System Users [page 102].

6. You configure the switchover software and test that switchover functions correctly to all standby nodes in the cluster.

7. You repeat the following steps until you have finished installing the ERS instance on all nodes in the cluster:
   1. You perform the switchover to a node where you want to install the ERS instance for the ASCS instance.
   2. You check the prerequisites [page 143] and run the installer [page 147] to install the ERS instance for the ASCS instance on the standby node, host B.

4. On the database instance host, you do the following:

   → Recommendation
   
   We recommend that the database instance is part of the hardware cluster or of any other proprietary high-availability solution for the database.

   1. You make available the global directories in <sapmnt>/<SAPSID> from the switchover cluster infrastructure and – optionally – from the SAP transport host.
   2. You check the prerequisites [page 143] and run the installer [page 147] to install the database instance on the database instance host.

5. On the primary application server instance host, you do the following:

   i Note

   In a high-availability installation, the primary application server instance does not need to be part of the cluster because it is no longer a single point of failure (SPOF). The SPOF is now in the ABAP central services instance (ASCS instance), which is protected by the cluster.

   1. You mount the global directories [page 140] in <sapmnt>/<SAPSID> that you exported from the switchover cluster infrastructure.
2. You check the prerequisites [page 143] and run the installer [page 147] to install the primary application server instance.

3. If you want to use the shared transport directory trans from another system, you also mount [page 138] this directory (see above).

6. We recommend you to install additional application server (AS) instances to create redundancy. The AS instances are not a SPOF. Therefore, do not include these instances in the cluster.

7. You continue with Post-Installation [page 162].

**Graphical Overview**

The following figure provides an overview of how you install the various instances in a high-availability installation:

![Distribution of Instances in a High-Availability ABAP System](image)

**Additional Application Server Instance**

**Installation Steps for Additional Application Server Instances for a Standard System**

1. If you want to install additional application server instances on a host different from the SAP system host, you export global directories in `<sapmnt>/<SAPSID>` to the hosts on which you want to install additional application server instances.

2. On every additional application server instance host, you do the following:
   1. If you want to install additional application server instances on a host different from the SAP system host, you mount the global directories [page 140] in `<sapmnt>/<SAPSID>` that you exported from the SAP system host.
   2. You check the prerequisites [page 143] and run the installer [page 147] to install the additional application server instance.
3. You continue with Post-Installation [page 162].

**Installation Steps for an Application Server Instance for a Distributed System**

1. If you want to share the transport directory `trans` from another system, you have to mount [page 138] it from this system. Otherwise, we recommend that you share the `trans` directory that is created during the installation of the primary application server instance.

2. On the SAP global host, you export global directories in `<sapmnt>/<SAPSID>` to the hosts on which you want to install additional application server instances.

3. On every additional application server instance host, you do the following:
   1. You mount the global directories [page 140] in `<sapmnt>/<SAPSID>` that you exported from the SAP global host.
   2. You check the prerequisites [page 143] and run the installer [page 147] to install the additional application server instance.
   3. If you want to use the shared transport directory `trans` from another system, also mount [page 138] this directory.

4. You continue with Post-Installation [page 162].

**Installation Steps for an Additional Application Server Instance for a High-Availability System**

1. If you want to share the transport directory `trans` from another system, you have to mount [page 138] it from this system. Otherwise, we recommend that you share the `trans` directory that is created during the installation of the primary application server instance.

2. On the primary node, host A, of the switchover cluster infrastructure, you export global directories in `<sapmnt>/<SAPSID>` to the hosts on which you want to install additional application server instances.

3. On each additional application server instance host, do the following:
   1. You mount the global directories [page 140] in `<sapmnt>/<SAPSID>` that you exported from the SAP global host.
   2. You check the prerequisites [page 143] and run the installer [page 147] to install the additional application server instance.
   3. If you want to use the shared transport directory `trans` from another system, you also mount [page 138] this directory.

4. You continue with Post-Installation [page 162].

### 5.2 Exporting and Mounting the Transport Directory

Every SAP system must be assigned to a transport directory. All application server instances of an SAP system must point to the same transport directory.

**Context**

Multiple SAP system can use the same transport directory. However, it is not required to have one global transport directory in your SAP system landscape. Depending on your security requirements, you must decide how you want to set up the transport directories in your landscape. Systems with lower security requirements
can share a transport directory (DEV, QA, for example). For systems with higher security requirements (PROD, for example), you might want to have a separate transport directory.

The transport directory is used by the Change and Transport System (CTS). The CTS helps you to organize development projects, and then transport the changes between the SAP systems in your system landscape.

For more information, see the SAP Library at:

<table>
<thead>
<tr>
<th>Release</th>
<th>SAP Library Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>● SAP NetWeaver 7.3</td>
<td>Application Help</td>
</tr>
<tr>
<td></td>
<td>Application Server</td>
</tr>
<tr>
<td></td>
<td>Administration of Application Server ABAP</td>
</tr>
<tr>
<td></td>
<td>Change and Transport System - Overview</td>
</tr>
<tr>
<td></td>
<td>Basics of the Change and Transport System</td>
</tr>
<tr>
<td></td>
<td>Transport Management System · Concept</td>
</tr>
<tr>
<td>● SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>● SAP NetWeaver 7.4</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>● SAP NetWeaver 7.5</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>● SAP NetWeaver Application Server for ABAP 7.51 innovation package</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>● SAP NetWeaver AS for ABAP 7.52</td>
<td></td>
</tr>
</tbody>
</table>

Consider the following:

- If the transport directory already exists, make sure that it is exported on the transport directory host and mount it on the SAP instance installation host.
- If the transport directory does not exist, proceed as follows:
  - Create the transport directory (either on the host where the primary application server instance is running or on a file server).
  - Export it on the transport directory host.
  - If you did not create the transport directory on your SAP instance installation host, mount it there.

**Procedure**

1. **Exporting the Transport Directory**
   a. Log on as user root to the host where the transport directory /usr/sap/trans resides.
   b. Make sure that /usr/sap/trans belongs to the group sapsys and to the user root.
   c. If not already done, export the directory using Network File System (NFS).
2. **Mounting the Transport Directory**

   **i Note**
   If the transport directory resides on your local SAP instance installation host, you do not need to mount it.
a. Log on as user **root** to the host of the primary or additional application server instance, where `/usr/sap/trans` is to be mounted.
b. Create the mount point `/usr/sap/trans`.
c. Mount `/usr/sap/trans` using Network File System (NFS) from the exporting host.

**Related Information**

- Exporting and Mounting Directories via NFS for Linux [page 215]
- Exporting and Mounting Directories via NFS for AIX [page 213]
- Exporting and Mounting Directories via NFS for Oracle Solaris [page 217]
- Exporting and Mounting Directories via NFS for HP-UX [page 214]

---

### 5.3 Exporting and Mounting Global Directories

If you install a database or an additional application server instance on a host other than the SAP global host, mount global directories from the SAP global host.

**Prerequisites**

If you want to install the executables locally instead of sharing them, do **not** mount the `exe` directory with Network File System (NFS). Instead, create `<sapmnt>/<SAPSID>/exe` as a local directory (not a link) with a minimum of 1.5 GB free space.

**Context**

There is no need to create the directories before the installation when you install a primary application server instance. The global directories must be exported only if you install additional application server instances.

**Example**

You install an SAP system distributed over several hosts. You decide that the host with the ABAP central services instance (ASCS instance) is the SAP global host. You then install the ASCS instance with the physical global directories on the SAP global host. Before you install the remaining instances (primary application server instance, a database instance, additional application server instances), you have to export the global directories from the SAP global host and mount them on the installation hosts for the remaining instances.
Choose one of the following ways to proceed, depending on whether you are performing a homogeneous or heterogeneous installation:

**Procedure**

- **Exporting and Mounting Global Directories for a Homogeneous Installation**
  a. Log on to the SAP global host as user `root` and export the following directories with read/write access for the `root` user to the host where you want to install the new instance:
    
    `<sapmnt>/<SAPSID>/exe`
    `<sapmnt>/<SAPSID>/profile`
    `<sapmnt>/<SAPSID>/global`
  
  Make sure that the user `root` of the host where you want to install the new instance can access the exported directories.

  ! Caution
  
  Make sure that the transport directory is mounted on every host where you want to install an SAP instance. Otherwise, the installation fails.
  
  For more information, see Exporting and Mounting the Transport Directory [page 138].

  b. Log on to the host of the new instance that you want to install as user `root`.
  c. Create the following mount points and mount them from the SAP global host:
    
    `<sapmnt>/<SAPSID>/exe`
    `<sapmnt>/<SAPSID>/profile`
    `<sapmnt>/<SAPSID>/global`

  ! Caution
  
  Make sure that the mount points under `/<sapmnt>/<SAPSID>/` are permanent. Otherwise, automatic start of the instance services does not work when you reboot the system.

- **Exporting and Mounting Global Directories for a Heterogeneous Installation**

  With a heterogeneous installation, the instances of an SAP system are installed on hosts with different UNIX operating systems. If you need information about the installation of application servers on Windows in a UNIX environment, see Heterogeneous SAP System Installations [page 218].

  i Note
  
  Mounting the directories between different system types, for example mounting a Windows file system on a Linux host, requires a 3rd party product such as Samba. The installation and configuration of Samba is not covered by this guide.
  
  Proceed as follows for a heterogeneous installation with different UNIX operating systems:

  a. Log on to the SAP global host as user `root` and export the following directories with `root` access to the host on which you want to install the new instance:
<sapmnt>/<SAPSID>/profile
<sapmnt>/<SAPSID>/global

⚠️ Caution
Do not export <sapmnt>/<SAPSID>/exe.

⚠️ Caution
Make sure that the global transport directory is mounted on every host where you want to install an SAP instance. For more information, see Exporting and Mounting the Transport Directory [page 138]. Otherwise, the installation fails.

b. Log on to the host of the new instance as user root.
c. Create the following mount points and mount them from the SAP global host:

<sapmnt>/<SAPSID>/profile
<sapmnt>/<SAPSID>/global

⚠️ Caution
Make sure that these mount points are permanent. Otherwise automatic start of the instance services does not work when you reboot the system.

⚠️ Caution
Do not mount <sapmnt>/<SAPSID>/exe and do not create it locally. It is created automatically during the installation.

Related Information

Exporting and Mounting Directories via NFS for Linux [page 215]
Exporting and Mounting Directories via NFS for AIX [page 213]
Exporting and Mounting Directories via NFS for Oracle Solaris [page 217]
Exporting and Mounting Directories via NFS for HP-UX [page 214]
5.4 Specifying the Initial Data Source of the User Management Engine

During the installation of your SAP system, you have to specify the initial data source of the User Management Engine (UME).

Prerequisites

You have planned how you want to configure user and access management for your SAP system to be installed as described in Planning User and Access Management [page 61].

Procedure

Using Central User Management

1. You install your SAP system as described in this installation guide.
2. Add the system to Central User Administration (CUA). For more information, see Configuring User Management [page 185].

Using an LDAP directory as Source for User Data

1. You install your SAP system as described in this installation guide.
2. Configure the user management of the newly installed SAP system to use an LDAP directory. For more information, see Configuring User Management [page 185].

5.5 Prerequisites for Running the Installer

Make sure you fulfil the following prerequisites before running the installer.

- For the SL Common GUI, make sure that the following web browser requirements are met:
  - You have one of the following supported browsers on the device where you want to run the SL Common GUI:
    - Google Chrome (recommended)
    - Mozilla Firefox
    - Microsoft Edge
    - Microsoft Internet Explorer 11 or higher.
    - Always use the latest version of these web browsers.
  - If you copy the SL Common GUI URL manually in the browser window, make sure that you open a new Web browser window in private browsing mode (Internet Explorer), incognito mode (Chrome) or private browsing mode (Firefox). This is to prevent Web browser plugins and settings from interfering with the SL Common GUI.
Caution

The installer uses a self-signed certificate, which is used temporarily only while the installer is running. This certificate is not trusted by the browser unless it is imported manually by the user running the installer. This behavior is intentionally designed in this way because - unlike ordinary public web servers - the installer has different usage patterns. You must configure your browser to trust the self-issued certificate of the installer after carefully performing the "thumbprint" verification described in Running the Installer [page 147]. For more information about adding trusted certificates, see the documentation of your browser.

For more information about the SL Common GUI, see Useful Information about the Installer [page 154].

- If you want to enable Internet Protocol Version 6 (IPv6), make sure that you set `SAP_IPv6_ACTIVE=1` in the environment of the user with root authorization which you use to start the installer. While running the installer, this setting is then also added to the environment of the `<sapsid>adm` user.

Note

By applying this setting the SAP system administrator is responsible for configuring the IP version on each host of the system landscape, before installing any additional instance to it.

- We recommend that you use the csh shell for the installation. If you want to use another shell, make sure that you have read SAP Note 202227.

The installer uses csh scripts during the installation to obtain the environment for user `<sapsid>adm`. This is also true if user `<sapsid>adm` already exists from an earlier SAP system installation, and the shell of this user is not csh. Before you start the installer, execute the following command as user `<sapsid>adm` to make sure that the csh scripts are up-to-date:

```
/bin/csh -c "source /home/<sapsid>adm/.cshrc;env"
```

- Make sure that your operating system does not delete the contents of the temporary directory `/tmp` or the contents of the directories to which the variables `TEMP`, `TMP`, or `TMPDIR` point, for example by using a crontab entry.

Make sure that the temporary directory has the permissions 755.

- Make sure that you have at least 300 MB of free space in the installation directory for each installation option. In addition, you need 300 MB free space for the installer executables. If you cannot provide 300 MB free space in the temporary directory, you can set one of the environment variables `TEMP`, `TMP`, or `TMPDIR` to another directory with 300 MB free space for the installer executables.

You can set values for the `TEMP`, `TMP`, or `TMPDIR` environment variable to an alternative installation directory as described in section Useful Information About the Installer [page 154].

- Make sure that `umask` is set to 022 for the user with root permissions that you want to use for running the installer.

As the user with root permissions that you want to use for running the installer, enter the following command: `umask 022`.

Only valid for ‘Platform’: AIX

AIX: Make sure that you have set the limits for operating system users as described in SAP Note 323816.

End of ‘Platform’: AIX

Only valid for ‘Platform’: HP-UX, Linux, Oracle Solaris

HP-UX, Linux, Oracle-Solaris: Make sure that you have set the limits for operating system users root, `<sapsid>adm`, and your database-specific operating system users (see also section “Creating Operating System Users and Groups” and “Running the Installer” in the installation guide).
Caution

Caution: the `limit` mechanism supports hard- and soft-limits. The soft-limit cannot be bigger than the hard-limit. The hard-limit can be set/increased by the root user like: `limit -h <limit> <new_value>`, for example `limit -h datasize unlimited`.

- Using `csh` shell, the output of command `limit` needs to be at least as follows:

  **Example**

  The following table lists example output taken from SUSE Linux Enterprise Server 11 (x86_64).

<table>
<thead>
<tr>
<th>Output</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>cputime</td>
<td>unlimited</td>
</tr>
<tr>
<td>filesize</td>
<td>unlimited</td>
</tr>
<tr>
<td>datasize</td>
<td>unlimited</td>
</tr>
<tr>
<td>stacksize</td>
<td>8192 KB</td>
</tr>
<tr>
<td>coredumpsize</td>
<td>unlimited</td>
</tr>
<tr>
<td>descriptors</td>
<td>8192</td>
</tr>
<tr>
<td>memoryuse</td>
<td>unlimited</td>
</tr>
</tbody>
</table>

- Using `sh` or `ksh` shell, the output of command `ulimit -a` needs to be at least as follows:

  **Example**

  The following table lists example output taken from SUSE Linux Enterprise Server 11 (x86_64).

<table>
<thead>
<tr>
<th>Output sh</th>
<th>Output ksh</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>cpu time (seconds)</td>
<td>cpu time (seconds)</td>
<td>unlimited</td>
</tr>
<tr>
<td>file size (blocks)</td>
<td>file size (blocks)</td>
<td>unlimited</td>
</tr>
<tr>
<td>data seg size (kbytes)</td>
<td>data size (Kibytes)</td>
<td>unlimited</td>
</tr>
<tr>
<td>stack size (kbytes)</td>
<td>stack size (Kibytes)</td>
<td>8192 KB</td>
</tr>
<tr>
<td>core file size (blocks)</td>
<td>core file size (blocks)</td>
<td>unlimited</td>
</tr>
<tr>
<td>open files</td>
<td>nofile</td>
<td>8192</td>
</tr>
<tr>
<td>max memory size (kbytes)</td>
<td>max memory size (Kibytes)</td>
<td>unlimited</td>
</tr>
</tbody>
</table>
• Make sure that you have carefully planned your database layout, in particular the tablespace layout, as described in Setup of Database Layout [page 83].

[Only valid for ‘Platform’: AIX, Linux, Oracle Solaris]

AIX, Linux, and Solaris SPARC only:
If you want to set up the high-availability cluster solution SA MP for Db2, make sure that you have read the document IBM Db2 High Availability Solution: IBM Tivoli System Automation for Multiplatforms (see Online Information from SAP [page 245]).

End of ‘Platform’: AIX, Linux, Oracle Solaris

• Make sure that you have defined the most important SAP system parameters as described in Basic Installation Parameters [page 63] before you start the installation.

• Check that your installation host meets the requirements for the installation options that you want to install.
For more information, see Running the Prerequisite Checker [page 48].

• If you are installing a second or subsequent SAP system in an existing database (MCOD), make sure that the database is up and running before starting the installation.
For more information, see Installation of Multiple Components in One Database [page 208].

• If you want to install an additional application server instance in an existing SAP system, make sure that:
  ○ There is exactly one entry in the /usr/sap/sapservices file for each SAP instance installed on this host. Be sure to check that the entry refers to the correct profile.
  ○ There are no profile backup files with an underscore “_” in their profile name. If so, replace the “_” with a “.”.

  Example


• Make sure that the following ports are not used by other processes:
  ○ Port 4237 is used by default as HTTPS port for communication between the installer and the SL Common GUI.
    If this port cannot be used, you can assign a free port number by executing sapinst with the following command line parameter:
    SAPINST_HTTPS_PORT=<Free Port Number>
  ○ Port 4239 is used by default for displaying the feedback evaluation form at the end of the installer processing.
    The filled-out evaluation form is then sent to SAP using HTTPS.
    If this port cannot be used, you can assign a free port number by executing sapinst with the following command line parameter:
    SAPINST_HTTP_PORT=<Free Port Number>

• If you want to perform the installation in unattended mode, see SAP Note 2230669 which describes an improved procedure using inifile.params.
5.6 Running the Installer

This section describes how to run the installer.

Prerequisites

For more information, see Prerequisites for Running the Installer [page 143].

Context

The installer has a web browser-based GUI named “SL Common GUI of the Software Provisioning Manager” - “SL Common GUI” for short.

This procedure describes an installation where you run the installer and use the SL Common GUI, that is you can control the processing of the installer from a browser running on any device.

For more information about the SL Common GUI, see Useful Information About the Installer [page 154].

Procedure

1. Log on to the installation host as a user with root permissions.

   Caution
   
   Make sure that the user with root permissions that you want to use for running the installer has not set any environment variables for a different SAP system or database.

   If your security policy requires that the person running the installer is not allowed to know the credentials of a user with root permissions on the installation host, you can specify another operating system user for authentication purposes. You do this using the SAPINST_REMOTE_ACCESS_USER parameter when starting the sapinst executable from the command line. You have to confirm that the user is a trusted one. For more information, see SAP Note 1745524.

2. Make the installation media available.

   Note
   
   Even if you use the complete SAP kernel media, the installer might prompt you during the provisioning process for additional archives (*.SAR files) due to special Patch Level (PL) requirements depending on categories such as the product, operating system, and database platform.
For example: The installer might require a certain PL of `<X>` of the `SAPEXEDB.SAR` (for DBTYPE `<Y>`), but this PL of the `SAPEXEDB.SAR` is not contained in the SAP kernel media. In this case you have to download the required PL from [https://launchpad.support.sap.com/#/softwarecenter](https://launchpad.support.sap.com/#/softwarecenter) following the instructions given in [Downloading SAP Kernel Archives (Archive-Based Installation)](page 125).

→ Recommendation

Make the installation media available locally. For example, if you use Network File System (NFS), reading from media mounted with NFS might fail.

<table>
<thead>
<tr>
<th>Only valid for ‘Platform’: Oracle Solaris</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>i Note</strong></td>
</tr>
<tr>
<td><strong>Oracle Solaris:</strong> If you mount installation media, make sure that you do this with option <strong>nomapcase</strong>.</td>
</tr>
</tbody>
</table>

End of ‘Platform’: Oracle Solaris

3. Start the installer from the directory to which you unpacked the Software Provisioning Manager archive by entering the following commands:

```bash
<Path_To_Unpack_Directory>/sapinst
```

**i Note**

If you are using a stack configuration file (see [Installation Using a Stack Configuration File (Optional)](page 45)), you must call the `sapinst` executable with command line parameter `SAPINST_STACK_XML=<Absolute_Path_To_Stack_XML_File>`:

```bash
/<Path_To_Unpack_Directory>/sapinst SAPINST_STACK_XML=<Absolute_Path_To_Stack_XML_File>
```

**i Note**

If you need to assign a virtual host name to the instance to be installed, and it is not possible to do this (for example, for database instances) by specifying it as an input parameter on the `<Instance Name>` screen, you can assign a virtual host name by starting the installer with the `SAPINST_USE_HOSTNAME` property:

```bash
<Path_To_Unpack_Directory>/sapinst SAPINST_USE_HOSTNAME=<Virtual_Host_Name>
```

For more information, see [Virtual Host Name in SAP System Parameters](page 64).

**i Note**

If you are running a system copy with parallel export/import using the Migration Monitor and started the export with command line option `SUPPORT_DECLUSTERING=false`, you must start the installer for the installation of the target database instance with command line option `SUPPORT_DECLUSTERING=true` for the import during the target system installation.

For more information, see the system copy guides at [http://support.sap.com/sitoolkit](http://support.sap.com/sitoolkit) ▶️ [System Provisioning ▶️ System Copy Option ▶️ Guide for Systems Based on SAP NetWeaver 7.1 & Higher]

4. The installer is starting up.
The installer now starts and waits for the connection with the SL Common GUI.

You can find the URL you require to access the SL Common GUI at the bottom of the shell from which you are running the installer.

```plaintext
...  
Open your browser and paste the following URL address to access the GUI
https://[<hostname>]:4237/sapinst/docs/index.html
Logon users: [<users>]
...  
```

**i Note**

If the host specified by `<hostname>` cannot be reached due to a special network configuration, proceed as follows:

1. Terminate the installer as described in Useful Information about the Installer [page 154].
2. Restart the installer from the command line with the `SAPINST_GUI_HOSTNAME=<hostname>` property.
   You can use a fully-qualified host name.

If you have a supported web browser (see Prerequisites for Running the Installer [page 143]) installed on the host where you run the installer, you can open this URL directly in the shell. Otherwise, open the URL in a supported web browser that runs on another device.

**∆ Caution**

After opening the browser URL, make sure that the URL in the browser starts with "https://" to avoid security risks such as SSL stripping.

Before you reach the Welcome screen, your browser warns you that the certificate of the sapinst process on this computer could not be verified.

Proceed as follows to avoid security risks such as a man-in-the-middle attack:

1. Click on the certificate area on the left hand side in the address bar of your browser, and view the certificate.
2. Open the certificate fingerprint or thumbprint, and compare all hexadecimal numbers to the ones displayed in the console output of the installer.
   Proceed as follows to get the certificate fingerprint or thumbprint from the server certificate printed in the installer console:
   1. Go to the `sapinst_exe.xxxxxx.xxxx` directory in the temporary directory to which the installer has extracted itself:
      `<User_Home>/sapinst/
   2. In the `sapinst_exe.xxxxxx.xxxx` directory, execute the sapgenpse tool with the command line option `getmyname -p`.
      As a result, you get the server fingerprint or thumbprint from the server certificate.
3. Accept the warning to inform your browser that it can trust this site, even if the certificate could not be verified.

The SL Common GUI opens in the browser by displaying the Welcome screen.

5. On the Welcome screen, choose the required option:
Perform preparations
Go to Generic Options > Database > Preparations and choose the required task.
To install SAP Host Agent separately, choose Generic Options > Database > Preparations > SAP Host Agent.

Install an SAP system:
- To install an SAP system based on SAP NetWeaver AS ABAP from scratch, choose Product > Database > Installation > Application Server ABAP > System_Variant.
- To install the application server ABAP for an SAP Process Integration system based on SAP NetWeaver 7.5 from scratch, choose SAP NetWeaver 7.5 > Database > Installation > Application Server ABAP for SAP Process Integration > System_Variant.
- To install the application server ABAP for an SAP Solution Manager 7.2 system from scratch, choose SAP Solution Manager 7.2 > Support_Release > Database > Installation > Application Server ABAP > System_Variant.
- To install a system based on SAP NetWeaver AS ABAP as target system of a system copy, choose Product > Database > System Copy > Target System > System_Variant > Based on AS ABAP.
- To install the application server ABAP for an SAP Process Integration system based on SAP NetWeaver 7.5 as target system of a system copy, choose SAP NetWeaver 7.5 > Database > System Copy > Target System > System_Variant > Based on AS ABAP.
- To install an additional application server instance, go to Product > Database > Additional SAP System Instances > Additional Application Server Instance.
- Perform other tasks or install additional components
  Go to Generic Options > Database and choose the required task.

6. Choose Next.

Note
If there are errors during the self-extraction process of the installer, you can find the log file dev_selfex.out in the temporary directory.

7. Follow the instructions on the installer screens and enter the required parameters.

Note
To find more information on each parameter during the Define Parameters phase, position the cursor on the required parameter input field, and choose either F1 or the HELP tab. Then the available help text is displayed in the HELP tab.

Note
If you want to install an ASCS instance with integrated SAP Web Dispatcher [page 37] or with integrated SAP Gateway [page 39] or both, you must choose the Custom parameter mode.
When processing the screens for the ASCS instance installation, you are prompted to mark the corresponding checkbox on the screen *Additional Components to be Included in the ASCS Instance*. If you mark the checkbox for SAP Web Dispatcher, you are prompted for the additional parameters required for the SAP Web Dispatcher installation on the subsequent screens.

**i Note**

If you are performing the target system installation in the context of a system copy with parallel export/import using the Migration Monitor and the target database is declustered - that is you started the installer for the target database instance installation with command line option `SUPPORT_DECLUSTERING=true` as described above - add the following load options parameter in the SAP System Advanced Load Configuration screen:

```-datacodepage <datacodepage_of_source_system>```

The advanced screen for load configuration only appears if you run the installer in *Custom* parameter mode. You can check the parameter within the `import_monitor_cmd.properties` file located in the installation directory, in the `loadArgs` entry.

For more information, see the system copy guides at [http://support.sap.com/sltoolset](http://support.sap.com/sltoolset) → System Provisioning → System Copy Option → Guide for Systems Based on SAP NetWeaver 7.1 & Higher.

**⚠ Caution**

The signature of installation media and installation archives is checked automatically during the *Define Parameters* phase while processing the Media Browser and - if you perform an archive-based installation - the Software Package Browser screens.

Note that this automatic check is only committed once and not repeated if you modify artifacts such as SAR archives or files on the media after the initial check has been done. This means that - if you modify artefacts later on either during the remaining *Define Parameters* phase or later on during the *Execute Service* phase - the signature is not checked again.

For more information, see SAP Note 2393060.

After you have entered all requested input parameters, the installer displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that the installer set by default. If required, you can revise the parameters before starting the installation.

Make sure that you check the following parameters depending on the installation type that you have chosen:

- If you are performing a **typical installation**, the installer creates the following:
  - Directories for tablespaces with table data and indexes (*sapdata* directories)
    - The installer creates four *sapdata* directories by default. If you require more or fewer *sapdata* directories, depending on the storage devices you are using, you must change this parameter before you start the installation. Select this parameter on the Summary screen and choose Revise. The installer then returns to the screen *IBM Db2 for Linux, UNIX, and Windows: Tablespace Layout*.
  - As of IBM Db2 10.1 and for lower IBM Db2 versions without automatic storage: Directories for temporary tablespaces (*saptmp* directories)
    - The installer creates four directories by default. If you require more or fewer *saptmp* directories, you must change this parameter before you start the installation. Select this parameter on the
Summary screen and choose Revise. The installer returns to the screen IBM Db2 for Linux, UNIX, and Windows: Tablespace Layout.

For more information, see Db2 Tablespaces [page 89].

- If you are performing a custom installation, you set these parameters during the Define Parameters phase of the installer.

**Note**

If the tablespace layout used by the installer does not meet your requirements, you can create the tablespaces manually by deselecting the option Create Tablespaces During the Installation Procedure on the screen IBM Db2 for Linux and UNIX and Windows: Tablespace Storage Management.

The installer does not check the page size of tablespaces that have either been created manually or that already exist. If you create the tablespaces manually, you must make sure that you use a page size of 16 KB.

For more information, see Creating Tablespaces Manually [page 222].

8. To start the installation, choose Next.

The installer starts the installation and displays the progress of the installation. When the installation has finished, the installer shows the message: Execution of <Option_Name> has completed.

Only valid for ‘Platform’: HP-UX

**Caution**

HP-UX only: If you decided to use 02 as the instance number, the instance fails to start during the installation process. For more information about the cause, see SAP System Parameters [page 64]. You have to manually change the port number for report RSLGCOLL to continue with the installation.

Proceed as follows:

1. Go to directory `/<sapmnt>//<SAPSID>/profile`.
2. Edit DEFAULT.PFL.
3. Set the parameter `rslg/collection_daemon/listen_port` to a free port number.

End of ‘Platform’: HP-UX

9. If required, delete directories with the name `sapinst_exe.xxxxxx.xxxx` after the installer has finished. Sometimes these directories remain in the temporary directory.

**Recommendation**

Keep all installation directories until you are sure that the system, including all instances, is completely and correctly installed. Once the system is completely and correctly installed, make a copy of the installation directories with all their contents and save it to a physically separate medium, such as an optical medium or a USB drive separate from your installation hosts. This might be useful for analyzing issues occurring later when you use the system. For security reasons, do not keep installation directories on installation hosts, but make sure that you delete them after saving them separately.

10. If not already done, install the Db2 license.
11. To make sure that the installer installed the most recent version of the database or the client software, see SAP Note 816773. This SAP Note provides information about the currently released database and Fix Pack combinations of IBM Db2 for Linux, UNIX, and Windows.

12. If you copied the installer software to your hard disk, you can delete these files when the installation has successfully completed.

13. For security reasons, we recommend that you remove the operating system users from the group sapinst after you have completed the installation.

14. For security reasons, we recommend that you delete the .sapinst directory within the home directory of the user with which you ran the installer:

   `<User_Home>/sapinst/`

15. The installer log files contain IP addresses and User IDs such as the ID of your S-User. For security, data protection, and privacy-related reasons we strongly recommend that you delete these log files once you do not need them any longer.

   You find the installer log files in the `sapinst_instdir` directory. For more information, see Useful Information about the Installer [page 154].

### 5.7 Additional Information about the Installer

The following sections provide additional information about the installer.

- **Useful Information about the Installer [page 154]**
  
  This section contains some useful technical background information about the installer and the installer GUI.

- **Interrupted Processing of the Installer [page 155]**
  
  Here you find information about how to restart the installer if its processing has been interrupted.

- **Entries in the Services File Created by the Installer [page 159]**

- **Troubleshooting with the Installer [page 160]**
  
  This section tells you how to proceed when errors occur while the installer is running.

- **Using the Step State Editor (SAP Support Experts Only) [page 161]**
  
  This section describes how to use the Step State Editor available in the installer.
5.7.1 Useful Information about the Installer

This section contains some useful technical background information about the installer and the installer GUI.

- **Software Provisioning Manager** (the “installer” for short) has the web browser-based “SL Common GUI of the Software Provisioning Manager” - “SL Common GUI” for short.
  
The SL Common GUI uses the SAP UI Development Toolkit for HTML5 - also known as SAPUI5 - a client-side HTML5 rendering library based on JavaScript. The benefits of this new user interface technology for the user are:
  
  ○ Zero footprint, since only a web browser is required on the client
  ○ New controls and functionality, for example, view logs in web browser.

The SL Common GUI connects the web browser on a client with the sapinst executable - which is part of Software Provisioning Manager - running on the installation host using the standard protocol HTTPS.

For the SL Common GUI the installer provides a pre-generated URL at the bottom of the shell from which you are running the installer. If you have a supported web browser installed on the host where you run the installer, you can start the SL Common GUI directly from this URL. Otherwise, open a web browser supported by the SL Common GUI on any device and run the URL from there.

For more information about supported web browsers see Prerequisites for Running the Installer [page 143].

If you need to run the SL Common GUI in **accessibility mode**, apply the standard accessibility functions of your web browser.

- As soon as you have started the sapinst executable, the installer creates a .sapinst directory underneath the `/home/<User>` directory where it keeps its log files. `<User>` is the user with which you have started the installer.

  After you have reached the **Welcome** screen and selected the relevant installer option for the SAP system or instance to be installed, the installer creates a directory sapinst_instdir where it keeps its log files, and which is located directly below the temporary directory. The installer finds the temporary directory by checking the value of the TEMP, TMP, or TMPDIR environment variable. If no value is set for these variables, the installer uses `/tmp` by **default**.

  All log files which have been stored so far in the .sapinst folder are moved to the sapinst_instdir directory as soon as the latter has been created.

  If you want the sapinst_instdir directory to be created in another directory than `/tmp`, set the environment variable TEMP, TMP, or TMPDIR to this directory before you start the installer.

### Shell Used Command

<table>
<thead>
<tr>
<th>Shell Used</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bourne shell (sh)</td>
<td><code>TEMP=&lt;Directory&gt;</code></td>
</tr>
<tr>
<td></td>
<td><code>export TEMP</code></td>
</tr>
<tr>
<td>C shell (csh)</td>
<td><code>setenv TEMP &lt;Directory&gt;</code></td>
</tr>
<tr>
<td>Korn shell (ksh)</td>
<td><code>export TEMP=&lt;Directory&gt;</code></td>
</tr>
</tbody>
</table>

⚠️ **Caution**

Make sure that the installation directory is not mounted with NFS, or there might be problems when the Java Virtual Machine is started.
Recommendation

We recommend that you keep all installation directories until the system is completely and correctly installed.

- The installer extracts itself to the temporary directory. These executables are deleted again after the installer has stopped running. Directories called sapinst_exe.xxxxxx.xxxx sometimes remain in the temporary directory after the installer has finished. You can safely delete them.
  - The temporary directory also contains the log file dev_selfex.out from the self-extraction process of the installer, which might be useful if an error occurs.

Caution

If the installer cannot find a temporary directory, the installation terminates with the error FCO-00058.

- To see a list of all available installer properties, start the installer as described above with the option -p:
  ```
  ./sapinst -p
  ```
- If you want to perform the installation in unattended mode, see SAP Note 2230669 which describes an improved procedure using inifile.params.
- If required, stop the installer by choosing the Cancel button.

Note

If you need to terminate the installer, press Ctrl + C.

5.7.2 Interrupted Processing of the Installer

Here you find information about how to restart the installer if its processing has been interrupted.

Context

The processing of the installer might be interrupted for one of the following reasons:

- An error occurred during the Define Parameters or Execute phase:
  The installer does not abort the installation in error situations. If an error occurs, the installation pauses and a dialog box appears. The dialog box contains a short description of the choices listed in the table below as well as a path to a log file that contains detailed information about the error.
- You interrupted the processing of the installer by choosing Cancel in the SL Common GUI.

Caution

If you stop an option in the Execute phase, any system or component installed by this option is incomplete and not ready to be used. Any system or component uninstalled by this option is not completely uninstalled.
The following table describes the options in the dialog box:

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Retry</strong></td>
<td>The installer retries the installation from the point of failure without repeating any of the previous steps. This is possible because the installer records the installation progress in the keydb.xml file. We recommend that you view the entries in the log files, try to solve the problem, and then choose <strong>Retry</strong>. If the same or a different error occurs, the installer displays the same dialog box again.</td>
</tr>
<tr>
<td><strong>Stop</strong></td>
<td>The installer stops the installation, closing the dialog box, the installer GUI, and the GUI server. The installer records the installation progress in the keydb.xml file. Therefore, you can continue the installation from the point of failure without repeating any of the previous steps. See the procedure below.</td>
</tr>
<tr>
<td><strong>Continue</strong></td>
<td>The installer continues the installation from the current point.</td>
</tr>
<tr>
<td><strong>View Log</strong></td>
<td>Access installation log files.</td>
</tr>
</tbody>
</table>

**Note**

You can also terminate the installer by choosing **Ctrl + C** but we do not recommend this because it kills the process immediately.

The following procedure describes the steps to restart an installation, which you stopped by choosing **Stop**, or to continue an interrupted installation after an error situation.

### Procedure

1. Log on to the installation host as a user with the required permissions as described in Running the Installer [page 147].
2. Make sure that the installation media are still available.

For more information, see Preparing the Installation Media [page 118].

**Recommendation**

Make the installation media available locally. For example, if you use remote file shares on other Windows hosts, CIFS shares on third-party SMB-servers, or Network File System (NFS), reading from media mounted with NFS might fail.
3. Make sure that the installation media are still available.

For more information, see Preparing the Installation Media [page 118].

Recommendation

Make the installation media available **locally**. For example, if you use remote file shares on other Windows hosts, CIFS shares on third-party SMB-servers, or Network File System (NFS), reading from media mounted with NFS might fail.

4. Restart the installer from the directory to which you unpacked the Software Provisioning Manager archive by executing the following command:

   `<Path_To_Unpack_Directory>/sapinst`

5. The installer is restarting.

   The installer now starts and waits for the connection with the SL Common GUI.

   You can find the URL you require to access the SL Common GUI at the bottom of the shell from which you are running the installer.

   ```
   ...
   ************************************************************
   Open your browser and paste the following URL address to access the GUI
   https://[(hostname)]:4237/sapinst/docs/index.html
   Logon users: [users]
   ************************************************************
   ...
   ```

i Note

If the host specified by `<hostname>` cannot be reached due to a special network configuration, proceed as follows:

1. Terminate the installer as described in Useful Information about the Installer [page 154].
2. Restart the installer from the command line with the `SAPINST_GUI_HOSTNAME=<hostname>` property.
   You can use a fully-qualified host name.

   If you have a supported web browser (see Prerequisites for Running the Installer [page 143]) installed on the host where you run the installer, you can open this URL directly in the shell. Otherwise, open the URL in a supported web browser that runs on another device.
Caution

After opening the browser URL, make sure that the URL in the browser starts with “https://” to avoid security risks such as SSL stripping.

Before you reach the Welcome screen, your browser warns you that the certificate of the sapinst process on this computer could not be verified.

Proceed as follows to avoid security risks such as a man-in-the-middle attack:

1. Click on the certificate area on the left hand side in the address bar of your browser, and view the certificate.
2. Open the certificate fingerprint or thumbprint, and compare all hexadecimal numbers to the ones displayed in the console output of the installer.

Proceed as follows to get the certificate fingerprint or thumbprint from the server certificate printed in the installer console:

1. Go to the sapinst_exe.xxxxxx.xxxx directory in the temporary directory to which the installer has extracted itself:
   
   `<User_Home>/sapinst/

2. In the sapinst_exe.xxxxxx.xxxx directory, execute the sapgenpse tool with the command line option `get_my_name -p`.

   As a result, you get the server fingerprint or thumbprint from the server certificate.

3. Accept the warning to inform your browser that it can trust this site, even if the certificate could not be verified.

The SL Common GUI opens in the browser by displaying the Welcome screen.

6. From the tree structure on the Welcome screen, select the installation option that you want to continue and choose Next.

The What do you want to do? screen appears.

7. On the What do you want to do? screen, decide between the following alternatives and continue with Next:
### Alternative Behavior

<table>
<thead>
<tr>
<th>Alternative</th>
<th>Behavior</th>
</tr>
</thead>
</table>
| Perform a new run     | The installer does not continue the interrupted installation option. Instead, it moves the content of the old installer directory and all installer-specific files to a backup directory. Afterwards, you can no longer continue the old option. The following naming convention is used for the backup directory: 

\[
\text{log}_{<\text{Day}>}_{<\text{Month}>}_{<\text{Year}>}_{<\text{Hours}>}_{<\text{Minutes}>}_{<\text{Seconds}>}
\]

**Example**

\[
\text{log}_{01}_{\text{Oct}}_{2016}_{13}_{47}_{56}
\]

**i Note**

All actions taken by the installation before you stopped it (such as creating directories or users) are not revoked.

**Caution**

The installer moves all the files and folders to a new log directory, even if these files and folders are owned by other users. If there are any processes currently running on these files and folders, they might no longer function properly.

| Continue with the existing one | The installer continues the interrupted installation from the point of failure. |

### 5.7.3 Entries in the Services File Created by the Installer

After the installation has finished successfully, the installer has created the following entries in `/etc/services`:

```
sapdp<Instance_Number> = 32<Instance_Number>/tcp
sapdp<Instance_Number>s = 47<Instance_Number>/tcp
sapgw<Instance_Number> = 33<Instance_Number>/tcp
sapgw<Instance_Number>s = 48<Instance_Number>/tcp
sapms<SAPSID> = 36<Instance_Number>/tcp (unless you specified another value during the installation)
```

**i Note**

- There is a port created for every possible instance number, regardless of which instance number you specified during the installation. For example, for `sapgw<Instance_Number> = 33<Instance_Number>/tcp` the following range of entries is created:

  ```
sapgw00 = 3300/tcp
sapgw01 = 3301/tcp
sapgw02 = 3302/tcp
  ```
If there is more than one entry for the same port number, this is not an error.

5.7.4 Troubleshooting with the Installer

This section tells you how to proceed when errors occur while the installer is running.

Context

If an error occurs, the installer:

- Stops processing
- Displays a dialog informing you about the error

Procedure

1. Check SAP Note [1548438](http://example.com) for known installer issues.
2. If an error occurs during the Define Parameters or the Execute Service phase, do one of the following:
   - Try to solve the problem:
     - To check the installer log files (sapinst.log and sapinst_dev.log) for errors, choose the LOG FILES tab.
     - The LOG FILES tab is only available if you have selected on the Welcome screen the relevant installer option for the SAP product to be installed.
     - If you need to access the log files before you have done this selection, you can find them in the .sapinst directory underneath the /home/<User> directory, where <User> is the user which you used to start the installer.
     - For more information, see Useful Information about the Installer [page 154].
   - To check the log and trace files of the installer GUI for errors, go to the directory <User_Home>/sapinst/
   - Then continue by choosing Retry.
   - If required, abort the installer by choosing Cancel in the tool menu and restart the installer. For more information, see Interrupted Processing of the Installer [page 155].
3. If you cannot resolve the problem, report an incident using the appropriate subcomponent of BC-INS*.
   - For more information about using subcomponents of BC-INS*, see SAP Note [1669327](http://example.com).
5.7.5 Using the Step State Editor (SAP Support Experts Only)

This section describes how to use the Step State Editor available in the installer.

**Note**

Only use the Step State Editor if the SAP Support requests you to do so, for example to resolve a customer incident.

**Prerequisites**

- SAP Support requests you to use the Step State Editor.
- Make sure that the host where you run the installer meets the requirements listed in Prerequisites for Running the Installer [page 143].

**Procedure**

1. Start the installer from the command line as described in Running the Installer [page 147] with the additional command line parameter `SAPINST_SET_STEPSTATE=true`.
2. Follow the instructions on the installer screens and fill in the parameters prompted during the Define Parameters phase until you reach the Parameter Summary screen.
3. Choose Next.

   The Step State Editor opens as an additional dialog. Within this dialog you see a list of all steps to be executed by the installer during the Execute Service phase. By default all steps are in an initial state. Underneath each step, you see the assigned installer component. For each step you have a Skip and a Break option.
   - Mark the checkbox in front of the Break option of the steps where you want the installer to pause.
   - Mark the checkbox in front of the Skip option of the steps which you want the installer to skip.
4. After you have marked all required steps with either the Break or the Skip option, choose OK on the Step State Editor dialog.

   The installer starts processing the Execute Service phase and pauses one after another when reaching each step whose Break option you have marked. You can now choose one of the following:
   - Choose OK to continue with this step.
   - Choose Step State Editor to return to the Step State Editor and make changes, for example you can repeat the step by marking the checkbox in front of the Repeat option.
   - Choose Cancel to abort the installer.
5. Continue until you have run through all the steps of the Execute Service phase of the installer.
6 Post-Installation

6.1 Post-Installation Checklist

This section includes the post-installation steps that you have to perform for the following:

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SAP systems based on SAP NetWeaver 7.4</strong> You can skip some of these post-installation steps if you have already completed them as a step in task list SAP_BASIS_SETUP_INITIAL_CONFIG when running the ABAP task manager for lifecycle management automation (transaction STC01) immediately after the installation was completed. For more information, see SAP NetWeaver 7.4 and Higher: Performing Automated Initial Setup (Optional) [page 165]. The sections describing these steps are marked with a corresponding note at the beginning.</td>
</tr>
</tbody>
</table>

- Standard, distributed, or high-availability system
- Additional application server instance

More detailed information about the steps are available in the linked sections.

### Standard, Distributed, or High-Availability System

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a standard system, you can ignore references to other hosts.</td>
</tr>
</tbody>
</table>

1. If required, you perform a full installation backup [page 195] immediately after the installation has finished.
2. You check and if necessary modify the settings for the operating system users for your SAP system if they were created by the installer. For more information, see Creating Operating System Users and Groups [page 102].
3. You check whether you can log on to the Application Server ABAP [page 164].
4. **SAP systems based on SAP NetWeaver 7.4 and higher only**: You perform the automated initial setup [page 165].
5. **Note** This step is optional.
6. If you have installed a high-availability system, you set up the licenses for high availability [page 168].
7. You configure the remote connection to SAP support [page 169].
8. You install the SAP online documentation [page 170].
9. You perform the consistency check [page 170].
10. You configure the Transport Management System [page 172].
11. For production systems it is highly recommended that you connect the system to SAP Solution Manager [page 174].
12. You apply the latest kernel and Support Packages [page 176].
13. You perform post-installation steps for the application server ABAP [page 177].
14. If you installed a high-availability system based on SAP NetWeaver AS for ABAP 7.52, you can decide whether you want to switch to the new standalone enqueue server 2 and enqueue replicator 2 [page 180].
15. If you installed the ABAP part of an SAP Solution Manager 7.2 or SAP Process Integration 7.5 system, enable HTTPS communication with the Java part of the system. For more information, see SAP Solution Manager 7.2, SAP Process Integration 7.5 only: Enabling HTTPS Communication for ABAP [page 181].
16. If required, you install additional languages and perform language transport [page 182].
17. SAP Kernel Release 7.4 and Higher: You perform IP Multicast Configuration [page 183].
18. You configure the Process Integration system after installation [page 184].

**Note**

This post-installation step is only relevant if you have installed an SAP NetWeaver 7.5 Process Integration (PI) system.

19. You configure the user management [page 185].
20. You ensure user security [page 186].
21. You perform the client copy [page 190].
22. SAP systems based on SAP NetWeaver 7.4 and higher only: If required, you change the keys for the secure storage [page 191].
23. For a production system, you must enable the database for monitoring [page 193].
24. For a production system, you must enable your database for recoverability [page 194] immediately after the installation.
25. You perform a full installation backup [page 195].
26. You check the parameters for database configuration and database manager configuration (see Checking Database Parameters [page 197]).
27. If you chose to install an integrated SAP Web Dispatcher within the ASCS instance, you log on to the SAP Web Dispatcher Management Console [page 198]
28. If you chose to install an integrated SAP Web Dispatcher within the ASCS instance, you configure the SAP Web Dispatcher [page 200]
29. If you chose to install an integrated Gateway within the ASCS instance, you configure the SAP Gateway [page 201].
30. You check the Master Guide for your SAP Business Suite application or SAP NetWeaver application (section Configuration of Systems and Follow-Up Activities) for additional implementation and configuration steps, such as language installation, monitoring, work processes, transports, SAP license, printers, system logs, and connectivity to system landscape directory (SLD).

### Additional Application Server Instance

1. If required, you perform an installation backup [page 195] immediately after the installation has finished.
2. You check and if necessary modify the settings for the operating system users for your SAP system if they were created by the installer. For more information, see Creating Operating System Users and Groups [page 102].

3. You check whether you can log on to the Application Server ABAP [page 164].

4. You install the SAP online documentation [page 170].

5. You ensure user security [page 186].

6. You perform a full installation backup [page 195].

7. You check the parameters for database configuration and database manager configuration (see Checking Database Parameters [page 197]).

6.2 Logging On to the Application Server ABAP

You need to check that you can log on to the Application Server ABAP with the standard users, given in the table below.

Prerequisites

- The SAP system is up and running.
- You have installed the SAP front-end software.

Context

In a distributed or high-availability system, you check whether you can log on to every instance of the SAP system that you installed.

**Note**

Client 066 is no longer available in newly installed SAP systems based on SAP NetWeaver 7.5 or higher. For more information, see SAP Note 1749142.

<table>
<thead>
<tr>
<th>User</th>
<th>User Name</th>
<th>Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP system user</td>
<td>SAP*</td>
<td>000, 001, 066</td>
</tr>
<tr>
<td></td>
<td>DDIC</td>
<td>000, 001</td>
</tr>
</tbody>
</table>

You access the application server ABAP using **SAP Logon**.
Procedure

1. Start **SAP Logon** on the host where you have installed the SAP front-end software as follows:
   - **SAP GUI for Windows:**
     On the host where you have installed the front end, choose:
     
     ![Start ➤ Programs ➤ SAP Front End<Release> ➤ SAPlogon](image)
   - **SAP GUI for Java:**
     Enter the following command from the GUI installation directory:
     
     `guilogon`

2. Create a logon entry for the newly installed system in the **SAP Logon**.
   For more information about creating new logon entries, press `F1`.

3. When you have created the entry, log on as user **SAP* or **DDIC**.

6.3 **SAP NetWeaver 7.4 and Higher: Performing Automated Initial Setup (Optional)**

After the installation of a new SAP system you have to configure the system to enable its usage. For example, you have to install an SAP license, create logon groups, and configure the Transport Management System (TMS) and security settings. If your SAP system is based on SAP NetWeaver 7.4 and higher, you can profit from an automated initial setup which executes these steps automatically.

Prerequisites

Note that the best point in time when you perform automated initial setup depends on the following:

- If you have run the installation using a stack configuration file (also called “up-to-date installation”), we recommend that you proceed as follows:
  1. Perform the **complete** installation and update process - that is the installation with Software Provisioning Manager and the update with Software Update Manager.
  2. Perform the automated initial setup.
   By running first the update and then the automated initial setup, you can profit from latest features and fixes in the initial setup configuration content.
   Background: As of Software Logistics Toolset 1.0 SPS12, the installation procedure with Software Provisioning Manager 1.0 SPO7 and higher also includes basic configuration activities, such as initial basic configuration of transport management, which are a prerequisite for the subsequent maintenance process.
   In previous SP versions of Software Logistics Toolset 1.0, this prerequisite had to be fulfilled by running automated initial setup before the update process.

- If you have **not** run the installation using a stack configuration file (also called “up-to-date installation”), we recommend that you proceed as follows:
  1. Run automated initial setup directly after the installation, using the automation content provided with the system load.
2. Apply the Support Packages to benefit from the already performed initial configuration – for example, using the already configured Transport Management System.

3. Consider running the automated initial setup a second time, especially if you want to benefit from the latest improvements and fixes offered by the updated automation content provided by the applied Support Package.

For more information about automated initial setup, see the SAP Community Network at https://wiki.scn.sap.com/wiki/display/SL/Automated+Initial+Setup+of+ABAP-Based+Systems.

**Procedure**

1. Start the ABAP Task Manager by calling transaction STC01.
2. Choose task list `SAP_BASIS_SETUP_INITIAL_CONFIG`.
3. Select the tasks you want to get executed.
   For this, the task list offers sophisticated online documentation of the comprised activities.
4. Choose Execute.

   You are guided through the configuration steps where you can enter the required values.

**Related Information**

- Installation Using a Stack Configuration File [page 45]
- Installing the SAP License [page 166]
- Configuring the Remote Connection to SAP Support [page 169]
- Configuring the Change and Transport System [page 172]
- Applying the Latest Kernel and Support Package Stacks [page 176]
- Performing Post-Installation Steps for the ABAP Application Server [page 177]
- Performing the Consistency Check [page 170]

**6.4 Installing the SAP License**

You must install a **permanent** SAP license. When you install your SAP system, a **temporary** license is automatically installed.

**i Note**

**SAP systems based on SAP NetWeaver 7.4 or higher only:**

You can skip this task if you have already completed it as a step in task list `SAP_BASIS_SETUP_INITIAL_CONFIG` when running the ABAP task manager for lifecycle management automation (transaction STC01) immediately after the installation was completed. For more information, see SAP NetWeaver 7.4 and Higher: Performing Automated Initial Setup (Optional) [page 165].
### Context

⚠️ Caution

**Before** the temporary license expires, you must apply for a permanent license key from SAP. We recommend that you apply for a permanent license key as soon as possible after installing your system.

For more information about SAP license keys and how to obtain them, see [http://support.sap.com/licensekey](http://support.sap.com/licensekey).

### Procedure

Install the SAP license as described in the SAP Library at:

- **i Note**
  - If you have installed a high-availability system, proceed as described in [High Availability: Setting Up Licenses](page 168).

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>- SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0</td>
<td>See the SAP NetWeaver Mobile Library</td>
</tr>
</tbody>
</table>
| - SAP NetWeaver 7.1 including Enhancement Package 1 for Banking Services from SAP 5.0 and 6.0 | **i Note**
  - Since the SAP NetWeaver Mobile 7.1 Library is the only available SAP Library for ABAP systems based on SAP NetWeaver 7.1, in this guide we always refer to it also for SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0. |
| - SAP NetWeaver Mobile 7.1 including Enhancement Package 1 | ![SAP NetWeaver Mobile Library] ![Administrator’s Guide] ![Configuration] ![General Configuration Tasks] ![License Configuration] |
6.5 High Availability: Setting Up Licenses

You need to install a permanent license, which is determined by the hardware environment of the message server.

Prerequisites

The SAP system is up and running.

Context

SAP has implemented a license mechanism for switchover solutions and clustered environments. Your customer key is calculated on the basis of local information on the message server host. This is the host machine where the ABAP central services instance (ASCS instance) runs.

To be able to perform a switchover, the temporary license that is installed automatically with the ASCS instance is not sufficient. You first need to install a permanent license, which is determined by the hardware environment of the message server. Since SAP’s high-availability (HA) solution stipulates two or more cluster nodes (host machines) where the message server is enabled to run, you have to order as many license keys [page 166] as you have cluster nodes.

When we receive confirmation from your vendor that you are implementing a switchover environment, we provide the required license keys for your system, one key for each machine.
Procedure

1. To find the hardware ID of the primary host, log on to any application server instance of the SAP system and call transaction SLICENSE.

2. Perform a switchover of the ABAP central services instance (ASCS) to another node in the cluster and repeat the previous step.

   Repeat this for all remaining nodes in the cluster.

3. To obtain the two license keys, enter the hardware IDs for each cluster node, where message server is enabled to run: http://support.sap.com/licensekey

4. To import the files containing the two licenses, log on to any application server instance of the SAP system and call transaction SLICENSE.

5. Perform a switchover of the ABAP central services instance (ASCS) to another node in the cluster and repeat the previous step.

   Repeat this for all remaining nodes in the cluster.

Results

The license is no longer a problem during switchover. This means you do not need to call saplicense in your switchover scripts.

6.6 Configuring the Remote Connection to SAP Support

SAP offers its customers access to support and a number of remote services such as the Early Watch Service or the GoingLive Service. Therefore, you have to set up a remote network connection to SAP.

i Note

SAP systems based on SAP NetWeaver 7.4 or higher only:

You can skip this task if you have already completed it as a step in task list SAP_BASIS_SETUP_INITIAL_CONFIG when running the ABAP task manager for lifecycle management automation (transaction STC01) immediately after the installation was completed. For more information, see SAP NetWeaver 7.4 and Higher: Performing Automated Initial Setup (Optional) [page 165].

For more information, see SAP Support Portal at https://support.sap.com/remote-support.html.
6.7 Installing SAP Online Documentation

You can install SAP online documentation as application help.

Context

SAP currently provides an HTML-based solution for the online documentation, including the Application Help, Glossary, Implementation Guide (IMG), and Release Notes. You can display the documentation with a Java-compatible Web browser on all front-end platforms supported by SAP.

Procedure

Install the application help in your SAP system as described in the README.TXT file contained in the root directory of the application help media.

Online documentation media are delivered as part of the installation package. You can also download them from https://launchpad.support.sap.com/#/softwarecenter <Product> <Product Version> APPLICATION HELP (SAP LIBRARY).

https://launchpad.support.sap.com/#/softwarecenter <Product> <Product Version> APPLICATION HELP (SAP LIBRARY)

6.8 Performing the Consistency Check

We recommend that you check the consistency of the newly installed SAP ABAP system.

i Note

SAP systems based on SAP NetWeaver 7.4 or higher only:

You can skip this task if you have already completed it as a step in task list SAP_BASIS_SETUP_INITIAL_CONFIG when running the ABAP task manager for lifecycle management automation (transaction STCO1) immediately after the installation was completed. For more information, see SAP NetWeaver 7.4 and Higher: Performing Automated Initial Setup (Optional) [page 165].
Prerequisites

- If the installation finished successfully, your SAP system should be up and running. Otherwise, start it as described in Starting and Stopping SAP System Instances [page 229].
- You have logged on to the SAP system [page 164].

Context

When logging on to the system for the first time, you need to trigger a consistency check manually. The function is then called automatically whenever you start the system or an application server.

The following checks are performed:

- Completeness of installation
- Version compatibility between the SAP release and the operating system
  The initial consistency check determines whether:
  - The release number in the SAP kernel matches the release number defined in the database system
  - The character set specified in the SAP kernel matches the character set specified in the database system
  - Critical structure definitions that are defined in both the data dictionary and the SAP kernel are identical. The structures checked by this function include SYST, T100, TSTC, TDCT and TFDI.
- Accessibility of the message server
- Availability of all work process types
- Information about the standalone enqueue server and the update service

Procedure

1. Perform a system check:
   Call transaction SICK.
   You should see the entry SAP System Check | no errors reported

2. Perform a database check:
   In the DBA Cockpit (transaction DBACOCKPIT), check for missing tables or indexes by choosing
   Diagnostics » Missing Tables and Indexes ». 
6.9 Configuring the Change and Transport System

You have to perform some steps in the Transport Management System to be able to use the Change and Transport System (TMS).

**Note**

You can skip this task if one of the following is true:

- **Only valid for SAP systems based on SAP NetWeaver 7.4 and higher**: You already completed these steps as part of task list SAP_BASIS_SETUP_INITIAL_CONFIG have to perform these steps or at least some of these steps when running the ABAP task manager for lifecycle management automation (transaction STC01) immediately after the installation had completed. Note that SAP_BASIS_SETUP_INITIAL_CONFIG only covers the configuration of TMS as single system.

- **You are using a stack configuration file** (see Installation Using a Stack Configuration File (Optional) [page 45]) and chose Run TMS Configuration (for Single System) during the installation.

**Context**

**Procedure**

1. Call transaction STMS in the ABAP system to configure the domain controller in the Transport Management System (TMS).

   For more information, see the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>○ SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0</td>
<td>See the SAP NetWeaver Mobile Library</td>
</tr>
<tr>
<td>○ SAP NetWeaver 7.1 including Enhancement Package 1 for Banking Services from SAP 5.0 and 6.0</td>
<td><strong>Note</strong></td>
</tr>
</tbody>
</table>

   Since the SAP NetWeaver Mobile 7.1 Library is the only available SAP Library for ABAP systems based on SAP NetWeaver 7.1, in this guide we always refer to it also for SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0.
2. In addition, you must configure the system change options. For more information, see the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
</table>
| SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0 | See the SAP NetWeaver Mobile Library

**i Note**

Since the SAP NetWeaver Mobile 7.1 Library is the only available SAP Library for ABAP systems based on SAP NetWeaver 7.1, in this guide we always refer to it also for SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0.
### SAP Release and SAP Library Quick Link

- SAP NetWeaver 7.3
- SAP NetWeaver 7.3 including Enhancement Package 1
- SAP NetWeaver 7.4
- SAP NetWeaver 7.5
- SAP NetWeaver Application Server for ABAP 7.51
  - Innovation package
  - [https://help.sap.com/nw751abap](https://help.sap.com/nw751abap)
- SAP NetWeaver AS for ABAP 7.52
  - [https://help.sap.com/nw752abap](https://help.sap.com/nw752abap)

### SAP Library Path (Continued)

- Application Help
- Function-Oriented View: English
- Solution Life Cycle Management
- Software Logistics
- Change and Transport System
- Transport Organizer (BC-CTS-ORG)
- Requirements for Working with the Transport Organizer
- Setting the System Change Option

3. Call transaction SE38 to schedule a dispatcher job for transport programs by executing report RDDIMPDP. You schedule the transport dispatcher in the current client. This is equivalent to the execution of job RDDNEWPP in transaction SE38.

### 6.10 Connecting the System to SAP Solution Manager

Here you find information about how to connect your newly installed SAP system to SAP Solution Manager.

#### Prerequisites

An SAP Solution Manager system must be available in your system landscape. For more information, see [http://help.sap.com/solutionmanager](http://help.sap.com/solutionmanager).

#### Context

SAP Solution Manager gives you central access to tools, methods, and preconfigured content that you can use to evaluate and implement your solutions.

When your implementation is running, you can use SAP Solution Manager to manage, monitor, and update systems and business processes in your solution landscape, and also to set up and operate your own solution support.
Procedure

You connect a technical system to SAP Solution Manager by the following steps:

1. On the technical systems of your landscape, **data suppliers** are implemented, for example, with transaction RZ70 for Application Server ABAP and with Visual Administrator for Application Server Java.

   For more information, see the SAP Solution Manager Application Help:
   - If your SAP Solution Manager release is 7.1:
   - If your SAP Solution Manager release is 7.2:

2. The data suppliers send information about the hardware and installed software to a central **System Landscape Directory (SLD)**. Updates are sent to the SLD as well.

   For more information, see the Planning Guide - System Landscape Directory in the SAP Community Network at [System Landscape Directory (SLD) - Overview](http://help.sap.com/solutionmanager).

3. From the SLD, this information is regularly synchronized with **SAP Solution Manager** where it is managed in the Landscape Management Database (LMDB).

   For more information, see the SAP Solution Manager Application Help:
   - If your SAP Solution Manager release is 7.1:
   - If your SAP Solution Manager release is 7.2:

4. In the LMDB, you complete the information from the SLD manually.

   For more information, see the SAP Solution Manager Application Help:
   - If your SAP Solution Manager release is 7.1:
   - If your SAP Solution Manager release is 7.2:
Next Steps

For more information, see the following pages in the SAP Community Network:

- System Landscape Directory (SLD) - Overview
- Documentation for Landscape Management Database - LMDB

6.11 Applying the Latest Kernel and Support Package Stacks

We strongly recommend that you apply the latest kernel and Support Package stacks before you start configuring your SAP system.

- **i Note**
  If you are using a stack configuration file (see Installation Using a Stack Configuration File (Optional) [page 45]), you already downloaded the stack.xml file and the delta archives using the Maintenance Optimizer in your SAP Solution Manager. If you then already called the Software Update Manager (SUM) from the installer and applied the Support Package Stacks after the installation had finished, you can skip this section.

Context

For more information about release and roadmap information for the kernel versions and how this relates to SAP NetWeaver support packages, including important notes on downward compatibility and release dates, see the document Understanding Kernel Releases for the SAP NetWeaver AS ABAP at http://scn.sap.com/docs/DOC-54170.

- **i Note**
  If you have installed an SAP Solution Manager 7.2 system, you must apply at least Support Package Stack (SPS) 01. You cannot use SAP Solution Manager 7.2 with SPS 00.

Procedure

- Download and apply the latest Kernel and Support Package stacks using the Software Update Manager (SUM) as described in the documentation Updating SAP Systems Using Software Update Manager <Release> available at https://support.sap.com/sitoolset System Maintenance Software Update Manager (SUM) scenarios Software Update/Upgrade with SUM <Release>
- If you want to update the kernel manually, proceed as described below:
a. Log on as user `<sapsid>`adm to the hosts of the SAP system instances to be updated.
b. Download the latest kernel for your operating system and database platform as described in SAP Note 194665.
c. Back up the kernel directory that is specified by the profile parameter `DIR_CT_RUN`.
d. Extract the SAR files of the kernel Support Packages of the target SP level to a temporary directory using the SAPCAR tool.
e. Copy or move the extracted programs from the temporary directory to the local kernel directory.
f. Adjust the ownership and permissions of the kernel binaries by entering the following command sequence (Execute the `saproot.sh` script that is located in the kernel directory):

```
su - root
cd <Kernel_Directory>
./saproot.sh <SAPSID>
exit
```

### 6.12 Performing Post-Installation Steps for the ABAP Application Server

This section describes the post-installation steps you have to perform for the ABAP application server.

---

**Note**

SAP systems based on SAP NetWeaver 7.4 or higher only:

You can skip this task if you have already completed it as a step in task list SAP_BASIS_SETUP_INITIAL_CONFIG when running the ABAP task manager for lifecycle management automation (transaction STC01) immediately after the installation was completed. For more information, see SAP NetWeaver 7.4 and Higher: Performing Automated Initial Setup (Optional) [page 165].

---

**Prerequisites**

You have logged on to the ABAP application server as described in Logging On to the Application Server [page 164].

---

**Context**

You have to perform the following post-installation steps for the ABAP application server:

- Upload and set system profiles using transaction RZ10
- Create logon and RFC server groups using transactions SMLG and RZ12
• Create operation modes using transaction RZ04
• Schedule standard jobs using transaction SM36
• Configuration of SLD data supplier using transaction RZ70
• Perform load generation using transaction SGEN

For more information, see the appropriate sections below.

**Procedure**

• **Upload and Set System Profiles using Transaction RZ10**
  
  You upload system profiles, such as default profile and instance profile, from the file system into the database of the target system using transaction RZ10.
  
  For more information about how to maintain SAP system profiles, see the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>○ SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0</td>
<td>See the SAP NetWeaver Mobile Library</td>
</tr>
<tr>
<td>○ SAP NetWeaver 7.1 including Enhancement Package 1 for Banking Services from SAP 5.0 and 6.0</td>
<td>i Note</td>
</tr>
<tr>
<td></td>
<td>Since the SAP NetWeaver Mobile 7.1 Library is the only available SAP Library for ABAP systems based on</td>
</tr>
<tr>
<td></td>
<td>SAP NetWeaver 7.1, in this guide we always refer to it also for SAP NetWeaver 7.1 for Banking Services from</td>
</tr>
<tr>
<td></td>
<td>SAP 5.0 and 6.0.</td>
</tr>
<tr>
<td>○ SAP NetWeaver Mobile 7.1</td>
<td>Application Help ➤ Function-Oriented View: English ➤ Application Server ABAP / ABAP Technology ➤</td>
</tr>
</tbody>
</table>
Create Logon and RFC Server Groups using Transactions SMLG and RZ12

You create the following:
- Logon groups using transaction SMLG
- RFC server groups using transaction RZ12

Specify the following:
- Name of the logon or RFC server group
- Instance name (application server)
- Group type attributes are optional

If required, you create the RFC server group parallel_generators.

Create Operation Modes using Transaction RZ04

You check for existing operation modes and - if required - create a new operation mode using transaction RZ04.

Specify the following:
- Name of the operation mode
- Short description
- Optional: monitoring properties variant

Select the corresponding checkbox to assign the operation mode to the following:
- Time table (assignment only from 0-24 h)
- Current application server instance

Schedule Standard Jobs using Transaction SM36

You schedule SAP standard jobs using transaction SM36.

If a standard job is already scheduled, it is kept. Only missing jobs are scheduled.

Configure the SLD Data Supplier using Transaction RZ70

a. Make sure that the SLD and the SLD bridge (the receiving thread of the SLD, which runs on a Java EE engine) are running.
b. Configure the System Landscape Directory (SLD) data supplier with default settings, using transaction RZ70.

SLD configuration is a prerequisite for the connection of an SAP system to SAP Solution Manager.

For more information, see Connecting the System to SAP Solution Manager [page 174]

- **Perform Load Generation using Transaction SGEN**

You generate the ABAP loads using transaction SGEN. ABAP loads are platform-dependent programs that are generated during runtime and stored in database tables. Using transaction SGEN you can generate ABAP loads of a number of programs, function groups, classes, and so on.

Choose one of the following generation modes:

- **Generate All Objects**
  
  All existing objects of all software components are generated synchronously. Job RSPARGENER8M starts the generation directly after all ABAP objects have been prepared for generation and have been stored in table GENSETC. Be aware that this is a time-consuming process.

  **Note**

  Make sure that you have sufficient space available on your database. The generation of all existing objects requires around 2 - 9 GB of free space.

- **Prepare All Objects for Generation**

  All objects to be generated are prepared for generation and stored in table GENSETM. You can start the generation of these objects later with transaction SGEN. Choose this strategy if object generation is to be done outside the configuration task due to performance issues.

**6.13 Systems Based on SAP NetWeaver AS for ABAP 7.52 only: Switching to Standalone Enqueue Server 2 and Enqueue Replicator 2**

If you installed a high-availability SAP system based on SAP NetWeaver AS for ABAP 7.52, you can switch to “Standalone Enqueue Server 2” and “Enqueue Replicator 2”.

When installing an SAP system based on SAP NetWeaver AS for ABAP 7.52 or lower, Software Provisioning Manager 1.0 installs the ASCS instance with the classic “Standalone Enqueue Server” and the ERS instance with the classic “Enqueue Replication Server” by default. However, if you installed an SAP system based on SAP NetWeaver AS for ABAP 7.52, you can switch to “Standalone Enqueue Server 2” and “Enqueue Replicator 2”.

For more information, see [https://help.sap.com/nw752abap](https://help.sap.com/nw752abap) > Application Help > SAP NetWeaver Library: Function-Oriented View > SAP NetWeaver Application Server for ABAP Infrastructure > Components of SAP NetWeaver Application Server for ABAP > Standalone Enqueue Server 2 > Switching to the Standalone Enqueue Server 2 >
6.14  SAP Solution Manager 7.2, SAP Process Integration 7.5 only: Enabling HTTPS Communication for ABAP

For secure communication between the SAP systems connected to the ABAP stack, further post-installation steps are required to fully enable HTTPS communication.

Prerequisites

- You have installed the application server ABAP for an SAP Solution Manager 7.2 or SAP Process Integration 7.5.
- You entered the HTTPS port that is to be configured in the application server instance profile when processing the Communication Port for ABAP screen. For more information, see Additional Parameters when Installing SAP Process Integration 7.5 or SAP Solution Manager 7.2.

Procedure

Proceed as described in the SAP Notes 1527879 and 510007.

Related Information

Additional Parameters when Installing SAP Process Integration 7.5 or SAP Solution Manager 7.2 [page 79]
6.15 Installing Additional Languages and Performing Language Transport

This section describes how to install and transport additional languages.

**i Note**

You do not have to perform these steps or at least some of these steps if you are using a stack configuration file (see *Installation Using a Stack Configuration File (Optional)* [page 45]) and processed the *Install Additional Languages* screen during the installation.

**Context**

If you have problems during the language installation, see SAP Note 2456868.

**Procedure**

1. Configure the language settings by using transaction I18N and choosing I18N Customizing I18N System Configuration or by executing report RSCPIINST directly.
   
   For more information, see SAP Note 42305.
   
   **AIX:** If you wish to use the Turkish locale with SAP on AIX, you must install the Turkish locale supplied by SAP instead of the one supplied with the operating system. For more information, see SAP Note 39718.

2. Perform the language transport using transaction SMLT:
   
   **i Note**
   
   German is already available in the system. Do not transport it via SMLT.
   
   a. Classify the language.
   
   b. Schedule the language transport.
   
   c. Schedule the language supplementation.

**Next Steps**

**i Note**

You can also install additional languages later, but if you install any Support Packages in the meantime, you have to do one of the following:

- Install the Support Packages again.
• Use the report RSTLAN_IMPORT_OCS to extract the language-relevant information from each Support Package.

For information about the language transport, see the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>• SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0</td>
<td>See the SAP NetWeaver Mobile Library</td>
</tr>
<tr>
<td>• SAP NetWeaver 7.1 including Enhancement Package 1 for Banking Services from SAP 5.0 and 6.0</td>
<td></td>
</tr>
</tbody>
</table>

• SAP NetWeaver Mobile 7.1
  http://help.sap.com/nwmobile71

• SAP NetWeaver Mobile 7.1 including Enhancement Package 1
  http://help.sap.com/nwmobile711

• SAP NetWeaver 7.3
  http://help.sap.com/nw73

• SAP NetWeaver 7.3 including Enhancement Package 1
  http://help.sap.com/nw731

• SAP NetWeaver 7.4
  http://help.sap.com/nw74

• SAP NetWeaver 7.5
  http://help.sap.com/nw75

• SAP NetWeaver Application Server for ABAP 7.51 innovation package
  https://help.sap.com/nw751abap

• SAP NetWeaver AS for ABAP 7.52
  https://help.sap.com/nw752abap

### 6.16 SAP Kernel 7.40 and Higher: IP Multicast Configuration and Wake-Up Mechanism

Since SAP kernel release 7.40, the ABAP application server (AS ABAP) uses IP multicast datagrams with host local scope to wake up the internal processes (such as dispatcher, Gateway, internet communication manager, work processes) when dispatching requests.
Since SAP kernel release 7.40 Patch Level (PL) 46 and 7.41 PL 13, the dispatcher checks during startup whether local IP multicast communication is working properly. You have to adjust the network configuration of AS ABAP as described in SAP Note 1931675.

Since SAP kernel 7.41 PL 47 and 7.42 PL 14, a new event-based wake-up mechanism is available that replaces the multicast mechanism. SAP recommends using this new mechanism in case of problems with multicast. For details on activating the new mechanism see SAP Note 2050408 to ensure that local IP multicast communication works properly.

6.17 PI 7.5 Only: Configuring the Process Integration System After the Installation

To configure your SAP Process Integration 7.5 (SAP PI 7.5) system after installation, execute the Central Technical Configuration (CTC) Wizard.

Prerequisites

If you have installed an SAP PI 7.5 system and you intend to run automated configuration using the Central Technical Configuration (CTC) Wizard after the installation, make sure that the ABAP communication port is either completely configured for HTTPS or optionally for HTTP, for example by configuring the ABAP communication port during the installation process (see the Ports table in section SAP System Parameters [page 64]). You can only run the CTC Wizard if the ABAP communication port is configured.

Procedure

To configure your SAP PI 7.5 system, execute the “SAP NetWeaver initial setup” CTC Wizard described in SAP Note 1309239.

i Note
The CTC Wizard automatically executes all required technical configuration steps.
For more details about all single configuration steps executed by the CTC Wizard and how to apply them manually, see the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.5</td>
<td>[Application Help ➤ Function-Oriented View: English ➤ Process Integration ➤ Configuring Process Integration After Installation ➤ Configuring Process Integration (PI) Dual Usage Type ➤ Basic Configuration for SAP Process Integration (PI) ]</td>
</tr>
</tbody>
</table>

### 6.18 Configuring the User Management

After the installation has completed, configure the user management of your SAP system.

#### Procedure

After the installation of your SAP system has finished, you must decide whether you want to do the following:
- Add the system to Central User Administration (CUA)
- Use Lightweight Directory Access Protocol (LDAP) synchronization

For more information, see the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>o SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0</td>
<td>See the SAP NetWeaver Mobile Library</td>
</tr>
<tr>
<td>o SAP NetWeaver 7.1 including Enhancement Package 1 for Banking Services from SAP 5.0 and 6.0</td>
<td>[Application Help ➤ Function-Oriented View: English ➤ Security ➤ Identity Management ➤ Identity Management for System Landscapes ➤ Integration of User Management in Your System Landscape ➤ Adding an ABAP System to Your System Landscape ]</td>
</tr>
<tr>
<td>o SAP NetWeaver Mobile 7.1</td>
<td></td>
</tr>
<tr>
<td><a href="https://help.sap.com/nwmobile71">https://help.sap.com/nwmobile71</a></td>
<td></td>
</tr>
<tr>
<td>o SAP NetWeaver Mobile 7.1 including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td><a href="https://help.sap.com/nwmobile711">https://help.sap.com/nwmobile711</a></td>
<td></td>
</tr>
</tbody>
</table>
### SAP Release and SAP Library Quick Link

- SAP NetWeaver 7.3
  - [https://help.sap.com/nw73/](https://help.sap.com/nw73/)
- SAP NetWeaver 7.3 including Enhancement Package 1
  - [https://help.sap.com/nw731](https://help.sap.com/nw731)
- SAP NetWeaver 7.4
  - [https://help.sap.com/nw74](https://help.sap.com/nw74)
- SAP NetWeaver 7.5
  - [https://help.sap.com/nw75](https://help.sap.com/nw75)
- SAP NetWeaver Application Server for ABAP 7.51 innovation package
  - [https://help.sap.com/nw751abap](https://help.sap.com/nw751abap)
- SAP NetWeaver AS for ABAP 7.52
  - [https://help.sap.com/nw752abap](https://help.sap.com/nw752abap)

### SAP Library Path (Continued)

- Application Help ➤ Function-Oriented View: English ➤ Security ➤ Identity Management ➤ Identity Management for System Landscapes ➤ Integration of User Management in Your System Landscape ➤ Adding an ABAP System to Your System Landscape

### 6.19 Ensuring User Security

You need to ensure the security of the users that the installer created during the installation.

The tables below at the end of this section list the following users:

- Operating system users
- SAP system users

During the installation, the installer by default assigned the master password to all users created during the installation unless you specified other passwords.

**Recommendation**

In all cases, the user ID and password are encoded only when transported across the network. Therefore, we recommend using encryption at the network layer, either by using the Secure Sockets Layer (SSL) protocol for HTTP connections, or Secure Network Communications (SNC) for the SAP protocols dialog and RFC.

**Caution**

Make sure that you perform this procedure **before** the newly installed SAP system goes into production.

For the users listed below, take the precautions described in the relevant SAP security guide.

You can find the security guide in the **Security** section of the product page for your SAP product at [https://help.sap.com/](https://help.sap.com/).
Operating System and Database Users

After the installation, operating system users for SAP system, database, and SAP Host Agent are available as listed in the following table:

**Recommendation**

For security reasons, we recommend that you remove the operating system users from the group sapinst after you have completed the installation of your SAP system.

You do not have to do this if you specified this “cleanup” already during the Define Parameters phase on the Cleanup Operating System Users screen. Then the removal had already been done automatically when the processing of the installer had completed. For more information, see Operating System Users in SAP System Parameters [page 64].

<table>
<thead>
<tr>
<th>User Type</th>
<th>User</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system user</td>
<td>&lt;sapsid&gt;adm</td>
<td>SAP system administrator</td>
</tr>
<tr>
<td>Database and operating system user</td>
<td>db2&lt;dbsid&gt;</td>
<td>Database administrator</td>
</tr>
<tr>
<td></td>
<td>sap&lt;sapsid&gt;</td>
<td>Database connect user in an ABAP system</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can specify the name of the ABAP connect user (sap&lt;sapsid&gt;) independently from the SAP schema name during the dialog phase of the installer.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>We recommend, however, that you keep the names of the connect user and the database schema identical in standard use cases.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you are performing a system copy using database means, Db2 is not able to change the schema name and you can then choose a connect user name that is different from the schema name.</td>
</tr>
</tbody>
</table>
SAP Host Agent User

<table>
<thead>
<tr>
<th>User Type</th>
<th>User</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system user</td>
<td>sapadm</td>
<td>SAP Host Agent administrator is the user for central monitoring services.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You do not need to change the password of this user after the installation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This user is for administration purposes only.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You are not able to log on as sapadm as this user is locked.</td>
</tr>
</tbody>
</table>

Role-Based Security Concept for Database Users

You can use roles to restrict user privileges on the database according to organizational tasks. The following database roles are available for SAP systems running on IBM Db2 as of version 9.7:

- **SAPAPP** role (for business applications, assigned to all connect users by default)
- **SAPMON** role (for monitoring)
- **SAPTOOLS** role (for database administration)

All new SAP system installations of SAP NetWeaver running on IBM Db2 V9.7 or higher work with the new role-based security concept. The installer creates the roles automatically and does not assign any single user authorizations. The installer also assigns the SAP default users to their appropriate database role.

For more information about the role-based security concept, see SAP Note [1365982](https://support.sap.com/notes) and the SAP DBA Guide for IBM IBM Db2 (see Online Information from SAP [page 245]).

**i Note**

The *<sapsid>* adm user is not assigned to any of the new database roles. The *<sapsid>* adm user still belongs to the database group SYSCTRL, so administrators with this user can start and stop the database server.

SAP System Users

After the installation, ABAP system users are available. The following table shows these users with the SAP system clients in which they are available, together with recommendations on how you can ensure the security of these users.

**i Note**

Client 066 is no longer available in newly installed SAP systems based on SAP NetWeaver 7.5 or higher. For more information, see SAP Note [1749142](https://support.sap.com/notes).
## SAP System Users

<table>
<thead>
<tr>
<th>User</th>
<th>User Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP system user</td>
<td>SAP*</td>
<td>User exists in at least SAP system clients 000, 001, and 066.</td>
</tr>
<tr>
<td></td>
<td>DDIC</td>
<td>User exists in at least SAP system clients 000 and 001.</td>
</tr>
<tr>
<td></td>
<td>EARLYWATCH</td>
<td>User exists in at least SAP system client 066.</td>
</tr>
</tbody>
</table>

### Application Server Java Administrator

**i Note**

This user has only been created if you have installed the application server ABAP for an SAP Process Integration (PI) 7.5 system or for an SAP Solution Manager 7.2 system.

- The name that you gave this user during the installation or the default name J2EE_ADMIN (see SAP System Parameters [page 64])
- This user exists in at least clients 000 and 001 of the ABAP system and in the User Management Engine (UME) of the Java system. It has administrative permissions for user management.
- The password of this user is stored in secure storage. Therefore, whenever you change the password of the administrator password, you must also change the password in secure storage.

**Recommendation**

We recommend that you use strong password and auditing policies for this user.

### Application Server Java Guest

**i Note**

This user has only been created if you have installed the application server ABAP for an SAP Process Integration (PI) 7.5 system or for an SAP Solution Manager 7.2 system.

- The name that you gave this user during the installation or the default name J2EE_GUEST (see SAP System Parameters [page 64])
- This user exists in at least clients 000 and 001 of the ABAP system and in the User Management Engine (UME) of the Java system. It is used for anonymous access.

### Communication user for Application Server Java

**i Note**

This user has only been created if you have installed the application server ABAP for an SAP Process Integration (PI) 7.5 system or for an SAP Solution Manager 7.2 system.

- The name that you gave this user during the installation or the default name SAPJSF (see SAP System Parameters [page 64])
- This user exists in at least clients 000 and 001 of the ABAP system and in the User Management Engine (UME) of the Java system. It is used for a remote function call (RFC) between the ABAP system and the Java system.
6.20 Performing the Client Copy

To get a production client, you have to perform a copy of the SAP reference client.

Context

The installer creates three ABAP clients during the installation, client 000, client 001, and client 066.

Note

Client 066 is no longer available in newly installed SAP systems based on SAP NetWeaver 7.5 or higher. For more information, see SAP Note 1749142.

Use client 000 as source client for the client copy.

Note

SAP SCM: If you want to mark the client 001 as not relevant for liveCache, run report /SAPAPO/OM_NON_LC_RELEVANT_CLT or /SLCA_NON_LC_RELEVANT_CLIENT using transaction SE38.

Procedure

1. Maintain the new client with transaction SCC4.
2. Activate kernel user SAP*:  
   a. Set the profile parameter login/no_automatic_user_sapstar to 0.
   b. Restart the application server.
3. Log on to the new client with kernel user SAP* and password PASS.
4. Copy the client with transaction SCCL and profile SAP_CUST.
5. Check the log files with transaction SCC3.
6. Create the required users. These users must have at least the authorizations required for user administration and system administration. Create a user SAP* with all required authorizations for this user. If you want to have other users for system administration, you can also create user SAP* without authorizations.
7. Deactivate kernel user SAP*:
   a. Reset login/no_automatic_user_sapstar to 1.
   b. Restart the application server.
Next Steps

For more information about the client copy and about how to perform it, see the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>- SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0</td>
<td>See the SAP NetWeaver Mobile Library</td>
</tr>
<tr>
<td>- SAP NetWeaver 7.1 including Enhancement Package 1 for Banking Services from SAP 5.0 and 6.0</td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver Mobile 7.1</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nwmobile71">http://help.sap.com/nwmobile71</a></td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver Mobile 7.1 including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nwmobile711">http://help.sap.com/nwmobile711</a></td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver 7.3</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw73">http://help.sap.com/nw73</a></td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw731">http://help.sap.com/nw731</a></td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver 7.4</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw74">http://help.sap.com/nw74</a></td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver 7.5</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw75">http://help.sap.com/nw75</a></td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver Application Server for ABAP 7.51 innovation package</td>
<td></td>
</tr>
<tr>
<td><a href="https://help.sap.com/nw751abap">https://help.sap.com/nw751abap</a></td>
<td></td>
</tr>
<tr>
<td>- SAP NetWeaver AS for ABAP 7.52</td>
<td></td>
</tr>
<tr>
<td><a href="https://help.sap.com/nw752abap">https://help.sap.com/nw752abap</a></td>
<td></td>
</tr>
</tbody>
</table>

### 6.21 SAP Systems Based on SAP NetWeaver 7.4 and Higher: Changing Keys for the Secure Storage

The secure storage in the file system and the secure storage in the database have been encrypted with a randomly generated individual encryption key or with a default key.

In the first case, you have made a backup of the individual key because you need this value in case of failure to recover the data.
No matter what you chose during installation, you can change the encryption key at any time using the respective maintenance tool.

→ Recommendation
SAP recommends using an individual encryption key.

- For the secure storage in the file system, the key change is described in the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>o SAP NetWeaver 7.4</td>
<td><img src="http://help.sap.com/nw74" alt="Application Help" /></td>
</tr>
<tr>
<td>o SAP NetWeaver 7.5</td>
<td><img src="http://help.sap.com/nw75" alt="Function-Oriented View: English" /></td>
</tr>
<tr>
<td>o SAP NetWeaver Application Server for ABAP 7.51 innovation package</td>
<td><img src="http://help.sap.com/nw751abap" alt="Security" /></td>
</tr>
<tr>
<td>o SAP NetWeaver AS for ABAP 7.52</td>
<td><img src="http://help.sap.com/nw752abap" alt="System Security" /></td>
</tr>
</tbody>
</table>

- For the secure storage in the database, the key change is described in the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>o SAP NetWeaver 7.4</td>
<td><img src="http://help.sap.com/nw74" alt="Application Help" /></td>
</tr>
<tr>
<td>o SAP NetWeaver 7.5</td>
<td><img src="http://help.sap.com/nw75" alt="Function-Oriented View: English" /></td>
</tr>
<tr>
<td>o SAP NetWeaver Application Server for ABAP 7.51 innovation package</td>
<td><img src="http://help.sap.com/nw751abap" alt="Security" /></td>
</tr>
<tr>
<td>o SAP NetWeaver AS for ABAP 7.52</td>
<td><img src="http://help.sap.com/nw752abap" alt="System Security" /></td>
</tr>
</tbody>
</table>

More Information

See also the entry Individual Encryption Key for the Secure Storage in table SAP System Parameters in SAP System Parameters [page 64].
6.22 Enabling the Database for Monitoring

Use

**i Note**
Enabling the database for monitoring is only relevant if you use an SAP system based on SAP NetWeaver 7.0 EHP2, 7.03, or on SAP NetWeaver 7.30 and higher.

After the SAP system installation, you **must** enable the database for monitoring by setting up a data collection framework (DCF). The DCF provides a time-based collection and evaluation of performance, configuration, and space-related data. The DCF consists of the following:

- A set of tables holding history data
- Tablespaces to store these monitoring tables
- A set of stored procedures to collect data on a regular basis
  These stored procedures are scheduled by the Db2 administrative task scheduler (ATS).

**Procedure**

In your SAP system, call transaction **DBACOCKPIT** to start the DBA Cockpit. Calling the DBA Cockpit automatically checks the existence of the DCF:

- If you installed the database **with** automatic storage management, calling the DBA Cockpit automatically installs the DCF.

  → **Recommendation**
  To make sure that the DCF was set up correctly, we recommend that you go to the screen **Data Collection Framework: Configuration** to check the status of the DCF.

- If you installed the database **without** automatic storage management, set up and configure the DCF as described in section **Enablement of Databases for the Data Collection Framework** in the **Database Administration Guide: Database Administration Using the DBA Cockpit**.

  → **Caution**
  Any error during the installation process can result in the DCF not being automatically installed. For example, if the installation failed due to missing tablespaces, create these tablespaces first and retry the installation. If the installation completes successfully, the DCF also has been installed and is available for monitoring.

**More Information**

*Database Administration Guide: Database Administration Using the DBA Cockpit - IBM Db2 for Linux, UNIX, and Windows* (see *Online Information from SAP [page 245]*)
6.23 Enabling Recoverability of the IBM Db2 for Linux, UNIX, and Windows Database

Use

⚠️ Caution
This section only applies to your database. You only have to perform the steps outlined in this section once — even if you install multiple SAP systems into one database.

Roll forward recovery provides the ability to recover lost data due to media failure, such as hard disk failure, and applies log file information (log journal) against the restored database. These log files contain the changes made to the database since the last backup.

⚠️ Caution
A production system must run in log retention mode.

If a system is not running in log retention mode, all changes applied to the database since the last complete backup are lost in the event of a disk failure.

In log retention mode, the log files remain in the log directory (`log_dir`). To archive the log files, you can use Db2’s own log file management solution. For more information, see the Database Administration Guide for SAP on IBM Db2 for Linux, UNIX, and Windows.

Procedure

1. Log on to the database server as user `db2<dbsid>`.
2. To activate log retention mode and to specify the log archiving method, you must set configuration parameter `LOGARCHMETH1` to one of the following options:
   - `LOGRETAIN`
     No log archiving takes place. Log files remain in the log directory.
   - `DISK:<log_archive_path>`
     Log files are archived to a disk location. You can archive them to tape using the Db2 tape manager (`db2tapemgr`) at a later point in time.
   - `TSM:<TSM_management_class>`
     Log files are archived to Tivoli Storage Management (TSM)
   - `VENDOR:<path_to_vendor_lib>`
     Log files are archived to a library that is provided by your vendor storage management
   - `USEREXIT`
     For downward compatibility with the former user exit concept, you can specify value `USEREXIT` for parameter `LOGARCHMETH1`.

   To set configuration parameter `LOGARCHMETH1` for your preferred archiving method, enter the following command:
   ```
db2 update db cfg for <dbsid> using LOGARCHMETH1 <log_archiving_method>
```
For more information, see the *Database Administration Guide for SAP on IBM Db2 for Linux, UNIX, and Windows*.

3. To activate the settings, you must restart the database. The database is now in backup pending mode. You need to take an offline backup before you can continue.

4. To start the offline backup for a single-partitioned database, enter the following command:

   ```
   db2 backup db <dbsid> to <device>
   ```

   **Example**

   For example, to perform an offline backup of database C11 to tapes in devices rmt0 and rmt1, enter the following command:

   ```
   db2 backup database C11 to /dev/rmt0, /dev/rmt1
   ```

   **Note**

   On a multi partition database, you must activate log retention mode on all database partitions. In addition, you also have to perform an offline backup for all database partitions.

   For more information about how to start a Db2 backup, see the IBM Db2 online documentation.

**More Information**

- For access to the *Database Administration Guide for SAP on IBM Db2 for Linux, UNIX, and Windows* and more documentation about SAP systems on IBM Db2 for Linux, UNIX, and Windows, see Online Information from SAP [page 245].
- For access to online information about Db2 that is provided by IBM, see Online Information from IBM [page 245].

### 6.24 Performing a Full Installation Backup

You must perform a full offline backup after the configuration of your SAP system. If required, you can also perform a full offline backup after the installation (recommended). In addition, we recommend you to regularly back up your database.

**Caution**

Make sure that you fully back up your database so that you can recover it later if necessary.

The UNIX commands used in this procedure work on all hardware platforms. For more information about operating system-specific backup tools, see your operating system documentation.

You need to back up the following directories and files:

- All SAP-specific directories:

  ```
  /usr/sap/<SAPSID>
  ```
You have logged on as user as
/usr/sap/trans
<sapmnt>/<SAPSID>
Home directory of the user <sapid>adm

- Perform a full offline database backup.
  For more information about backups, see the IBM Db2 documentation.
- Make sure that you back up the home directory of db2<dbsid>.
  For more information about backups, see the IBM Db2 documentation.
- The root file system
  This saves the structure of the system and all configuration files, such as file system size, logical volume manager configuration, and database configuration data.

**i Note**
This list is only valid for a standard installation.

**Prerequisites**

You have logged on as user <sapid>adm and stopped the SAP system and database [page 229].

Use the backup tool of your choice and refer to the backup software documentation. You can also use the standard UNIX commands as described below.

**Backing Up the Installation**

1. Log on as user root.
2. Manually create a compressed tar archive that contains all installed files:
   - Saving to tape:
     `tar -cf - <file_system> | compress -c > <tape_device>`
   - Saving to the file system:
     `tar -cf - <file_system> | compress -c > ARCHIVENAME.tar.Z`

**i Note**
**Linux only:** You can also execute the following command to manually create a compressed GNU tar archive that contains all installed files and save it to the file system:

`tar -czf <ARCHIVENAME>.tgz <file_system>`

3. Perform your offline database backup.
   For more information, see the IBM Db2 documentation.
Restoring Your Backup

If required, you can restore the data that you previously backed up.

⚠️ Caution

Check for modifications in the existing parameter files before you overwrite them when restoring the backup.

1. Log on as user root.
2. Go to the location in your file system where you want to restore the backup image.
3. Restore the data with the following commands:
   - From tape:
     ```bash
     cat <tape_device> | compress -cd | tar -xf -
     ```
   - From the file system:
     ```bash
     cat ARCHIVENAME.tar.Z | compress -cd | tar -xf -
     ```

   Only valid for 'Platform': Linux

   **Note**
   
   Linux only: If you want to restore the data from a GNU tar archive, you have to execute the following command:
   ```bash
   tar -xzf <ARCHIVENAME>.tgz
   ```

   End of 'Platform': Linux

4. Restore your offline database backup.
   For more information about how to restore backups, see the IBM Db2 documentation.

6.25 Checking the Database Parameters for IBM Db2 for Linux, UNIX, and Windows

Use

After installation has completed, make sure that you check the parameters of the database configuration and of the database manager configuration. A check of the database parameters ensures that your database parameters conform with the latest SAP recommendations where necessary and are adapted to your needs.
You can check the parameters of the database in one of the following ways:

- Compare the current parameters of your database with the parameters as they are recommended for SAP systems in the following SAP Notes:

<table>
<thead>
<tr>
<th>Database Version</th>
<th>Corresponding SAP Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Db2 V9.7</td>
<td>1329179</td>
</tr>
<tr>
<td>IBM Db2 10.1</td>
<td>1692571</td>
</tr>
<tr>
<td>IBM Db2 10.5</td>
<td>1851832</td>
</tr>
<tr>
<td>IBM Db2 11.1</td>
<td>2303771</td>
</tr>
</tbody>
</table>

- Use the DBA Cockpit to compare the current parameters with the standard parameters. In the DBA Cockpit (transaction `DBACOCKPIT`), on the `Database` tab page, choose `Configuration > Parameter Check`.

**Note**
The parameter check in the DBA Cockpit is available as of SAP Basis 7.00 with enhancement package 2 and support package 6. For more information about the parameter check, see the Database Administration Guide: Database Administration Using the DBA Cockpit – IBM Db2 for Linux, UNIX, and Windows listed in Online Information from SAP [page 245].

### 6.26 Logging on to the SAP Web Dispatcher Management Console

This section describes how to log on to the SAP Web Dispatcher.

**Context**

**Note**
This step is only required if you chose to install an integrated SAP Web Dispatcher instance within the ASCS instance.

You must log on to the SAP Web Dispatcher Management Console to do the following:

- Check whether the SAP Web Dispatcher was installed successfully.
Change the password of the `webadm` user.
Access monitoring and administration tools.

**Procedure**

1. Open a web browser.
2. Enter the following URL, depending on whether you use HTTP or HTTPS:
   
   \[
   
   \text{http(s)://<Webdispatcher}_{\text{Host}}:\text{<HTTP(S)}_{\text{PORT}}>/\text{sap/wdisp/admin/public/}
   \text{default.html}
   \]

   **Example**

   \[
   \text{https://plx282:44300/sap/wdisp/admin/public/default.html}
   \]

3. Log on as user `webadm` with the password that you entered during the input phase of the installation.

   The *SAP Web Dispatcher Monitor* screen appears.

4. We recommend that you change the password of `webadm` immediately after the installation for security reasons.

   For more information on how to change passwords of existing users using the *Admin Handler*, see the SAP Library at:

   **SAP Release and SAP Library Quicklink**

   - SAP NetWeaver Mobile 7.1
   - SAP NetWeaver Mobile 7.1 including Enhancement Package 1

   **SAP Library Path (Continued)**

   - SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0
   - SAP NetWeaver 7.1 including Enhancement Package 1 for Banking Services from SAP 5.0 and 6.0

   **i Note**

   Since the SAP NetWeaver Mobile 7.1 Library is the only available SAP Library for ABAP systems based on SAP NetWeaver 7.1, in this guide we always refer to it also for SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0.
Related Information

ASCS Instance with Integrated SAP Web Dispatcher [page 37]

6.27 SAP Web Dispatcher Configuration (Optional)

After installing SAP Web Dispatcher, you must configure it to be able to use it.

i Note

This step is only required if you chose to install an integrated SAP Web Dispatcher instance within the ASCS instance.

You can find the configuration information in the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quicklink</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver Mobile 7.1</td>
<td>Application Help ➤ Function-Oriented View ➤ Application Server ➤ Application Server Infrastructure ➤ Components of SAP NetWeaver Application Server ➤ SAP Web Dispatcher ➤ Administration of the SAP Web Dispatcher ➤ Area menu ➤ Section “HTTP Handler” ➤</td>
</tr>
<tr>
<td>SAP NetWeaver Mobile 7.1 including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver Mobile 7.1 including Enhancement Package 1</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quicklink</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Related Information</th>
<th>Application Help ➤ Function-Oriented View ➤ Application Server ➤ Application Server Infrastructure ➤ Components of SAP NetWeaver Application Server ➤ SAP Web Dispatcher ➤ Administration of the SAP Web Dispatcher ➤ Area menu ➤ Section “HTTP Handler”</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.4</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.5</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver Application Server for ABAP 7.51 innovation package</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver AS for ABAP 7.52</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.51 innovation package</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver AS for ABAP 7.52</td>
<td></td>
</tr>
</tbody>
</table>

SAP Release and SAP Library Quicklink

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quicklink</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.3</td>
<td>Application Help ➤ Function-Oriented View ➤ Application Server ➤ Application Server Infrastructure ➤ Components of SAP NetWeaver Application Server ➤ SAP Web Dispatcher ➤ Administration of the SAP Web Dispatcher ➤ Area menu ➤ Section “HTTP Handler”</td>
</tr>
<tr>
<td>SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quicklink</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver Mobile 7.1</td>
<td>Application Help ➤ Function-Oriented View ➤ Application Server ➤ Application Server Infrastructure ➤ Components of SAP NetWeaver Application Server ➤ SAP Web Dispatcher ➤ Administration of the SAP Web Dispatcher ➤ Area menu ➤ Section “HTTP Handler”</td>
</tr>
<tr>
<td>SAP NetWeaver Mobile 7.1 including Enhancement Package 1</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quicklink</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td></td>
</tr>
</tbody>
</table>

Related Information

ASCS Instance with Integrated SAP Web Dispatcher [page 37]

6.27 SAP Web Dispatcher Configuration (Optional)

After installing SAP Web Dispatcher, you must configure it to be able to use it.

i Note

This step is only required if you chose to install an integrated SAP Web Dispatcher instance within the ASCS instance.

You can find the configuration information in the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quicklink</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver Mobile 7.1</td>
<td>Application Help ➤ Function-Oriented View ➤ Application Server ➤ Application Server Infrastructure ➤ Components of SAP NetWeaver Application Server ➤ SAP Web Dispatcher ➤ Administration of the SAP Web Dispatcher ➤ Area menu ➤ Section “HTTP Handler”</td>
</tr>
<tr>
<td>SAP NetWeaver Mobile 7.1 including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver Mobile 7.1 including Enhancement Package 1</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quicklink</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td></td>
</tr>
</tbody>
</table>

Related Information

ASCS Instance with Integrated SAP Web Dispatcher [page 37]

6.27 SAP Web Dispatcher Configuration (Optional)

After installing SAP Web Dispatcher, you must configure it to be able to use it.

i Note

This step is only required if you chose to install an integrated SAP Web Dispatcher instance within the ASCS instance.

You can find the configuration information in the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quicklink</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver Mobile 7.1</td>
<td>Application Help ➤ Function-Oriented View ➤ Application Server ➤ Application Server Infrastructure ➤ Components of SAP NetWeaver Application Server ➤ SAP Web Dispatcher ➤ Administration of the SAP Web Dispatcher ➤ Area menu ➤ Section “HTTP Handler”</td>
</tr>
<tr>
<td>SAP NetWeaver Mobile 7.1 including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver Mobile 7.1 including Enhancement Package 1</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quicklink</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td></td>
</tr>
</tbody>
</table>

Related Information

ASCS Instance with Integrated SAP Web Dispatcher [page 37]

6.27 SAP Web Dispatcher Configuration (Optional)

After installing SAP Web Dispatcher, you must configure it to be able to use it.

i Note

This step is only required if you chose to install an integrated SAP Web Dispatcher instance within the ASCS instance.

You can find the configuration information in the SAP Library at:
SAP Release and SAP Library Quicklink

- SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0
- SAP NetWeaver 7.1 including Enhancement Package 1 for Banking Services from SAP 5.0 and 6.0

SAP Library Path (Continued)

See the SAP NetWeaver Mobile Library.

i Note
Since the SAP NetWeaver Mobile 7.1 Library is the only available SAP Library for ABAP systems based on SAP NetWeaver 7.1, in this guide we always refer to it also for SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0.

- SAP NetWeaver 7.3
  http://help.sap.com/nw73
- SAP NetWeaver 7.3 including Enhancement Package 1
  http://help.sap.com/nw731
- SAP NetWeaver 7.4
  http://help.sap.com/nw74
- SAP NetWeaver 7.5
  http://help.sap.com/nw75
- SAP NetWeaver Application Server for ABAP 7.51 innovation package
  https://help.sap.com/nw751abap
- SAP NetWeaver AS for ABAP 7.52
  https://help.sap.com/nw752abap

Related Information

ASCS Instance with Integrated SAP Web Dispatcher [page 37]

6.28 Gateway Configuration (Optional)

You have to configure the gateway to be able to use it.

i Note
This step is only relevant if you installed a gateway integrated in the ASCS instance. For more information, see ASCS Instance with Integrated Gateway [page 39].
You can find all relevant configuration information in the gateway documentation in the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quicklink</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver Mobile 7.1</td>
<td><a href="http://help.sap.com/nwmobile71">Application Help ➤ Function-Oriented View ➤ Application Server Infrastructure ➤ Connectivity ➤ SAP Gateway</a></td>
</tr>
<tr>
<td>SAP NetWeaver Mobile 7.1 including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.1 including Enhancement Package 1 for Banking Services from SAP 5.0 and 6.0</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver Process Integration 7.1</td>
<td><a href="http://help.sap.com/nwpi71">Application Help ➤ Function-Oriented View ➤ Application Server Infrastructure ➤ Connectivity ➤ SAP Gateway</a></td>
</tr>
<tr>
<td>SAP NetWeaver Process Integration 7.1 Including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.3</td>
<td><a href="http://help.sap.com/nw73">Application Help ➤ SAP NetWeaver Library: Function-Oriented View ➤ Application Server ➤ Application Server Infrastructure ➤ Connectivity ➤ Gateway</a></td>
</tr>
<tr>
<td>SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.4</td>
<td><a href="http://help.sap.com/nw74">Application Help ➤ SAP NetWeaver Library: Function-Oriented View ➤ Application Server ➤ Application Server Infrastructure ➤ Components of SAP NetWeaver Application Server ➤ Gateway</a></td>
</tr>
<tr>
<td>SAP NetWeaver 7.5</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver Application Server for ABAP 7.51 innovation package</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver AS for ABAP 7.52</td>
<td></td>
</tr>
</tbody>
</table>

### Related Information

ASCS Instance with Integrated Gateway [page 39]
7 Additional Information

The following sections provide additional information about optional preparation, installation, and post-installation tasks.

There is also a section describing how to delete an SAP system.

7.1 Integration of LDAP Directory Services

This section explains the benefits of using the SAP system with the Lightweight Directory Access Protocol (LDAP) directory and gives an overview of the configuration steps required to use an SAP system with the directory.

LDAP defines a standard protocol for accessing directory services, which is supported by various directory products such as Microsoft Active Directory, and OpenLDAP slapd. Using directory services enables important information in a corporate network to be stored centrally on a server. The advantage of storing information centrally for the entire network is that you only have to maintain data once, which avoids redundancy and inconsistency.

If an LDAP directory is available in your corporate network, you can configure the SAP system to use this feature. For example, a correctly configured SAP system can read information from the directory and also store information there.

i Note

The SAP system can interact with the Active Directory using the LDAP protocol, which defines:

- The communication protocol between the SAP system and the directory
- How data in the directory is structured, accessed, or modified

If a directory other than the Active Directory also supports the LDAP protocol, the SAP system can take advantage of the information stored there. For example, if there is an LDAP directory on a UNIX or Windows server, you can configure the SAP system to use the information available there. In the following text, directories other than the Active Directory that implement the LDAP protocol are called generic LDAP directories.
This section does not provide information about the use of LDAP directories with the LDAP Connector. For more information about using and configuring the LDAP Connector for an ABAP system, see the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver Mobile 7.1</td>
<td>Application Help ▶ Function-Oriented View ▶ Security ▶ Identity Management ▶ Identity Management of the Application Server ABAP ▶ Configuration of User and Role Administration ▶ Directory Services ▶ LDAP Connector</td>
</tr>
<tr>
<td>SAP NetWeaver Mobile 7.1 including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nwmobile711">http://help.sap.com/nwmobile711</a></td>
<td>See the SAP NetWeaver Mobile Library.</td>
</tr>
<tr>
<td>SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.1 including Enhancement Package 1 for Banking Services from SAP 5.0 and 6.0</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver Process Integration 7.1</td>
<td>Application Help ▶ Function-Oriented View ▶ Security ▶ Identity Management ▶ Identity Management of the Application Server ABAP ▶ Configuration of User and Role Administration ▶ Directory Services ▶ LDAP Connector</td>
</tr>
<tr>
<td>SAP NetWeaver Process Integration 7.1 Including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nwpi711">http://help.sap.com/nwpi711</a></td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.3</td>
<td>Application Help ▶ Function-Oriented View: English ▶ Security ▶ Identity Management ▶ User and Role Administration of Application Server ABAP ▶ Configuration of User and Role Administration ▶ Directory Services ▶ LDAP Connector</td>
</tr>
<tr>
<td>SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw73">http://help.sap.com/nw73</a></td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.4</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw74">http://help.sap.com/nw74</a></td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.5</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw75">http://help.sap.com/nw75</a></td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver Application Server for ABAP 7.51 innovation package</td>
<td></td>
</tr>
<tr>
<td><a href="https://help.sap.com/nw751abap">https://help.sap.com/nw751abap</a></td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver AS for ABAP 7.52</td>
<td></td>
</tr>
<tr>
<td><a href="https://help.sap.com/nw752abap">https://help.sap.com/nw752abap</a></td>
<td></td>
</tr>
</tbody>
</table>

**Prerequisites**

You can only configure the SAP system for Active Directory services or other LDAP directories if these are already available on the network. As of Windows 2000 or higher, the Active Directory is automatically available.
You can only configure the SAP system for Active Directory services or other LDAP directories if these are already available on the network. As of Windows 2000 or higher, the Active Directory is automatically available on all domain controllers. A generic LDAP directory is an additional component that you have to install separately on a UNIX or Windows server.

- Make sure that the required software is installed:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Required Software</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIX</td>
<td>IBM Tivoli Directory Server client packages</td>
</tr>
<tr>
<td>HP-UX</td>
<td>The LDAP libraries listed in SAP Note 541344 📄</td>
</tr>
</tbody>
</table>
| Linux            | You must have at least the following RPM packages installed:  
  ○ Oracle Linux:  
    openldap2  
  ○ Red Hat Linux:  
    openldap2  
  ○ SUSE LINUX  
    openldap2  
    openldap2-client |
| Solaris          | You must have at least the libldap.so library installed. |

**Features**

In the SAP environment, you can exploit the information stored in an Active Directory or generic LDAP directory by using:

- SAP Logon
- The SAP Microsoft Management Console (SAP MMC)
  For more information about the automatic registration of SAP components in LDAP directories and the benefits of using it in SAP Logon and SAP MMC, see the documentation *SAP System Information in Directory Services* at: [https://archive.sap.com/documents/docs/DOC-14384](https://archive.sap.com/documents/docs/DOC-14384)
- The SAP Management Console (SAP MC)

**SAP Logon**

Instead of using a fixed list of systems and message servers, you can configure SAP Logon in the sapmsg.ini configuration file to find SAP systems and their message servers from the directory. If you configure SAP logon to use the LDAP directory, it queries the directory each time Server or Group selection is chosen to fetch up-to-date information on available SAP systems.

To use LDAP operation mode, check that the sapmsg.ini file contains the following:

```
[Address]
```

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.1 to 7.52 on UNIX: IBM Db2 for Linux, UNIX, and Windows

**Additional Information**
Distinguish the following cases:

- If you use an Active Directory, you must set `LDAPOptions="DirType=NT5ADS"`. For more information, see the SAP system profile parameter `ldap/options`.
- You must specify the directory servers (for example, `LDAPServer=pcintel6 p24709`) if one of the following is true:
  - The client is not located in the same domain forest as the Active Directory
  - The operating system does not have a directory service client (Windows NT and Windows 9X without installed `dsclient`).
  For more information, see the SAP system profile parameter `ldap/servers`.
- For other directory services, you can use `LDAPNode` to specify the distinguished name of the SAP root node. For more information, see the SAP system profile parameter `ldap/saproot`.

**SAP MMC**

The SAP MMC is a graphical user interface (GUI) for administering and monitoring SAP systems from a central location. It is automatically set up when you install an SAP system on Windows. If the SAP system has been prepared correctly, the SAP MMC presents and analyzes system information that it gathers from various sources, including the Active Directory.

Integrating the Active Directory as a source of information has advantages for the SAP MMC. It can read system information straight from the directory that automatically registers changes to the system landscape. As a result, up-to-date information about all SAP application servers, their status, and parameter settings is always available in the SAP MMC.

If you need to administer distributed systems, we especially recommend that you use the SAP MMC together with Active Directory services. You can keep track of significant events in all of the systems from a single SAP MMC interface. You do not need to manually register changes in the system configuration. Instead, such changes are automatically updated in the directory and subsequently reflected in the SAP MMC.

If your SAP system is part of a heterogeneous SAP system landscape that comprises systems or instances both on Unix and Windows operating systems, you can also use the SAP MMC for operating and monitoring the instances running on Unix.

**SAP MC**

The SAP MC is a graphical user interface (GUI) for administering and monitoring SAP systems from a central location. The SAP MC is automatically set up when you install an SAP system on any platform. If the SAP system has been prepared correctly, the SAP MC presents and analyzes system information that it gathers from various sources, including a generic LDAP Directory.

Integrating a generic LDAP Directory as a source of information has advantages for the SAP MC. It can read system information straight from the directory that automatically registers changes to the system landscape. As a result, up-to-date information about all SAP application servers, their status, and parameter settings is always available in the SAP MC.
For more information about the SAP MC and about how to configure it to access LDAP directories, see the documentation SAP Management Console in the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>• SAP NetWeaver Mobile 7.1</td>
<td><img src="#" alt="Application Help" />  Function-Oriented View  <img src="#" alt="Application Server Infrastructure" />  SAP Management Console</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nwmobile71">http://help.sap.com/nwmobile71</a></td>
<td><img src="#" alt="Application Help" />  Function-Oriented View  <img src="#" alt="Application Server Infrastructure" />  SAP Management Console</td>
</tr>
<tr>
<td>• SAP NetWeaver Mobile 7.1 including Enhancement Package 1</td>
<td><img src="#" alt="Application Help" />  Function-Oriented View: English  <img src="#" alt="Solution Life Cycle Management" />  SAP Management Console</td>
</tr>
<tr>
<td>• SAP NetWeaver 7.3</td>
<td><img src="#" alt="Application Help" />  Function-Oriented View: English  <img src="#" alt="Solution Life Cycle Management" />  SAP Management Console</td>
</tr>
<tr>
<td>• SAP NetWeaver 7.3 including Enhancement Package 1</td>
<td><img src="#" alt="Application Help" />  Function-Oriented View: English  <img src="#" alt="Solution Life Cycle Management" />  SAP Management Console</td>
</tr>
<tr>
<td>• SAP NetWeaver 7.4</td>
<td><img src="#" alt="Application Help" />  Function-Oriented View: English  <img src="#" alt="Solution Life Cycle Management" />  SAP Management Console</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw74">http://help.sap.com/nw74</a></td>
<td><img src="#" alt="Application Help" />  Function-Oriented View: English  <img src="#" alt="Solution Life Cycle Management" />  SAP Management Console</td>
</tr>
<tr>
<td>• SAP NetWeaver 7.5</td>
<td><img src="#" alt="Application Help" />  Function-Oriented View: English  <img src="#" alt="Solution Life Cycle Management" />  SAP Management Console</td>
</tr>
<tr>
<td><a href="http://help.sap.com/nw75">http://help.sap.com/nw75</a></td>
<td><img src="#" alt="Application Help" />  Function-Oriented View: English  <img src="#" alt="Solution Life Cycle Management" />  SAP Management Console</td>
</tr>
<tr>
<td>• SAP NetWeaver Application Server for ABAP 7.51 innovation package</td>
<td><img src="#" alt="Application Help" />  Function-Oriented View: English  <img src="#" alt="Solution Life Cycle Management" />  SAP Management Console</td>
</tr>
<tr>
<td>• SAP NetWeaver AS for ABAP 7.52</td>
<td><img src="#" alt="Application Help" />  Function-Oriented View: English  <img src="#" alt="Solution Life Cycle Management" />  SAP Management Console</td>
</tr>
<tr>
<td><a href="https://help.sap.com/nw752abap">https://help.sap.com/nw752abap</a></td>
<td><img src="#" alt="Application Help" />  Function-Oriented View: English  <img src="#" alt="Solution Life Cycle Management" />  SAP Management Console</td>
</tr>
</tbody>
</table>

**Configuration Tasks for LDAP Directories**

This section describes the configuration tasks for the Active Directory or other (generic) LDAP directories.

- **Configuration Tasks for Active Directory**
  To enable an SAP system to use the features offered by the Active Directory, you have to configure the Active Directory so that it can store SAP system data.
  
  To prepare the directory, you use the installer to automatically:
  - Extend the Active Directory schema to include the SAP-specific data types
  - Create the domain accounts required to enable the SAP system to access and modify the Active Directory. These are the group SAP_LDAP and the user sapldap.
  - Create the root container where information related to SAP is stored
  - Control access to the container for SAP data by giving members of the SAP_LDAP group permission to read and write to the directory

  You do this by running the installer on the Windows server on which you want to use Active Directory Services and choosing ![Generic Installation Options](#)  ![Database](#)  ![Preparations](#)  ![LDAP Registration](#)  ![Active Directory Configuration](#). For more information about running the installer on Windows, see the documentation ![Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver](#)  ![Release](#)  ![Database](#)  on Windows: ![Database](#) at ![System Provisioning](#).

Additional Information

Installation of SAP Systems Based on the Application Server ABAP of SAP NetWeaver 7.1 to 7.52 on UNIX: IBM Db2 for Linux, UNIX, and Windows

PUBLIC 207
You have to configure the directory server only **once**. Then all SAP systems that need to register in this directory server can use this setup.

- **Configuration Tasks for Generic LDAP Directories**
  To configure other LDAP directories, refer to the documentation of your directory vendor.

- **Configuration Tasks for Generic LDAP Directories on Windows**
  To configure other LDAP directories, refer to the documentation of your directory vendor. The installer software contains schema extensions for directory servers Netscape/iPlanet (ldregns4.txt, ldregns5.txt) and OpenLDAP slapd (ldregslapd.schema). Both files are located in the directory \
<Unpack_Directory>\COMMON\ADS. After you have applied the schema extension, you need to create a root container to store the SAP-related information and create a directory user that the SAP application server can use to write information to the directory.

For more information about how to set up a Netscape/iPlanet directory server, see the documentation **SAP System Information in Directory Services** at:

- **Enabling the SAP System LDAP Registration**
  Once you have correctly configured your directory server, you can enable the LDAP registration of the SAP system by setting some profile parameters in the default profile.

  To do this, run the installer [page 147] **once** for your system and choose:

  - **Generic Installation Options**
    - **<Database>**
    - **Preparations**
    - **LDAP Registration**
    - **LDAP Support**

  If you use a directory server other than Microsoft Active Directory and/or non-Windows application servers, you have to store the directory user and password information by using ldappasswd pf=<any_instance_profile>. The information is encrypted for storage in DIR_GLOBAL and is therefore valid for all application servers. After restarting all application servers and start services, the system is registered in your directory server. The registration protocols of the components are dev_ldap*. The registration is updated every time a component starts.

### 7.2 Installation of Multiple Components in One Database

You can install **multiple** SAP systems in a **single** database. This is called Multiple Components in One Database (MCOD).

→ **Recommendation**

MCOD is generally available and there is no intention to de-support this installation feature.

However, SAP recommends that customers should **not** use the MCOD feature when installing new systems.

The major drawbacks are as follows:

- Previous-point-in-time (PPT) recovery of a single system within an MCOD installation becomes a highly complex and time-consuming procedure.
- SAP Landscape Management (LaMa) is generally not supported for MCOD installations. For more information, see SAP Note [1709155](https://archive.sap.com/documents/docs/DOC-14384).
- There are strong dependencies, for example on the database version used for the MCOD system.
- Downtime - planned or unplanned - always affects all systems sharing the same database.
Exception: In case of a dual-stack split you can use the “Keep Database” option thus keeping ABAP and Java stack in one database. There, the PPT recovery problem does not apply because both stacks belong logically together and would always be recovered jointly anyhow. However, keep in mind that even for this specific case the introduction of SAP Landscape Management would require a split into separate database subsystems.

Additional information is available in SAP Note 2146542.

MCOD is available with all SAP components and all the major databases for the SAP system. No extra effort is required because the MCOD installation is fully integrated into the standard installation procedure. MCOD is not an additional installation option. Instead, it is an option of the database instance installation.

With MCOD we distinguish two scenarios:

- The installation of an SAP system in a new database
- The installation of an additional SAP system in an existing database (MCOD)

Prerequisites

- For more information about MCOD and its availability on different platforms, see Multiple Components in One Database (MCOD) at: https://wiki.scn.sap.com/wiki/pages/viewpage.action?pageId=448466580.
- Since SAP does not support mixed solutions with MCOD, your SAP system must contain Unicode SAP instances only.
- Improved sizing required
  You calculate the CPU usage for an MCOD database by adding up the CPU usage for each individual SAP system. You can do the same for memory resources and disk space.
  You can size multiple components in one database by sizing each individual component using the Quick Sizer tool and then adding the requirements together. For more information about the Quick Sizer, see http://sap.com/sizing.

Features

- Reduced administration effort
- Consistent system landscape for backup, system copy, administration, and recovery
- Increased security and reduced database failure for multiple SAP systems due to monitoring and administration of only one database
- Independent upgrade
  In an MCOD landscape, you can upgrade a single component independently from the other components running in the same database, assuming that the upgraded component runs on the same database version. However, if you need to restore a backup, be aware that all other components are also affected.

Note

Special MCOD considerations and differences from the standard procedure are listed where relevant in the installation documentation.
Constraints

- We **strongly recommend** that you test MCOD in a test or development system. We recommend that you run MCOD systems in the same context. We do not recommend that you mix test, development, and production systems in the same MCOD.
- In the event of database failure, all SAP systems running on the single database are affected.
- Automated support in an MCOD landscape for the following administrative tasks depends on your operating system and database:
  - Copying a single component from an MCOD landscape to another database at database level.
  - Uninstalling a single component from an MCOD landscape requires some additional steps. You can use a remote connection to SAP support to request help with these tasks. For more information, see [http://support.sap.com/remoteconnection](http://support.sap.com/remoteconnection).
- You **cannot** install a Unicode ABAP system with a non-Unicode ABAP system in one database.
- For the first SAP system, the database system ID can be different from the SAP system ID.
- For the second SAP system, you must use the same `<DBSID>` as for the first SAP system.
- If you decide to turn off database logging during the database load phase of the installation, you need to plan downtime for all MCOD systems sharing the database.

7.3 MCOD Tablespaces, File Systems, and Connect Users

If you install multiple SAP components into one database (MCOD), you might need additional tablespaces, file systems, and connect users for each SAP component.

MCOD Tablespaces

If you install additional SAP components into one database, each system has its own tablespaces. Only SYSCATSPACE and temporary tablespaces are shared. For example, the additional SAP system `<SAPSID2>` uses tablespaces, such as `<SAPSID2>#BTABD` and `<SAPSID2>#BTABI`.

**Notes**

During an installation of multiple components on one database, additional space is required for tablespace SYSCATSPACE. If you are not using tablespaces with autoresize mode or Db2’s automatic storage, you must extend SYSCATSPACE manually before you start the SAP system installation.

If you are using a database with automatic storage in an MCOD environment, you can choose on the Tablespace Storage Management dialog if your tablespaces are also managed using automatic storage. Otherwise, the checkbox for automatic storage is disabled and autoresize is used.
**Required File Systems for the Database**

The following table lists the required database-specific file systems for an additional SAP system:

<table>
<thead>
<tr>
<th>Use</th>
<th>File System/Logical Volume</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Directories for table and index data</td>
<td>• With Db2’s automatic storage: The installer uses the automatic storage paths that have already been configured in your database (/db2/&lt;DBSID&gt;/sapdata&lt;n&gt; or /db2/&lt;DBSID&gt;/sapdata/sapdata&lt;n&gt;).  &lt;br&gt;  • No automatic storage: The installer uses the paths /db2/&lt;SAPSID2&gt;/sapdata&lt;n&gt; or /db2/&lt;SAPSID2&gt;/sapdata/sapdata&lt;n&gt;.</td>
<td>The sapdata directories are used for automatic storage tablespaces or for container type <strong>database-managed space (DMS) FILE</strong>.  &lt;br&gt;  No automatic storage: By default, four directories are created (sapdata1, sapdata2, sapdata3, sapdata4). You can change the number of sapdata directories and the path of the directories on the <strong>Tablespace Layout</strong> dialog of the installer.</td>
</tr>
<tr>
<td>Directories for temporary tablespaces</td>
<td>The temporary tablespaces of the additional SAP system &lt;SAPSID2&gt; are the same as for &lt;SAPSID1&gt;.  &lt;br&gt;  If the expected temporary tablespaces do not exist, the installer creates them automatically using the following paths:  &lt;br&gt;  • /db2/&lt;DBSID&gt;/sapdata&lt;n&gt; or in /db2/&lt;DBSID&gt;/sapdata/sapdata&lt;n&gt; (for IBM Db2 versions up to and including V9.7, when using automatic storage)  &lt;br&gt;  • /db2/&lt;DBSID&gt;/saptmp&lt;n&gt; or in /db2/&lt;DBSID&gt;/saptmp/saptmp&lt;n&gt; (for IBM Db2 versions 10.1 and higher, when using automatic storage)  &lt;br&gt;  • /db2/&lt;SAPSID2&gt;/saptmp&lt;n&gt; or in /db2/&lt;SAPSID2&gt;/saptmp/saptmp&lt;n&gt; (for all Db2 versions, when not using automatic storage)</td>
<td>If expected temporary tablespaces do not exist:  &lt;br&gt;  By default, four directories are created. You can change the number of sapdata and saptmp directories and the path of the directories on the <strong>Tablespace Layout</strong> dialog of the installer.</td>
</tr>
</tbody>
</table>

For more information about required file systems for the application server, see [SAP Directories](#page_108).
SAP Connect Users

Each additional system works with its own SAP connect user sap<sapsid>, that means all database objects of SAP system <SAPSID2> are owned by sap<sapsid2>. You can specify the name of the ABAP connect user (sap<sapsid>) independently from the SAP schema name during the dialog phase of the installation.

We recommend, however, that you keep the names of the connect user and the database schema identical in standard use cases. If you are performing a system copy using database means, Db2 is not able to change the schema name and you can then choose a connect user name that is different from the schema name.

⚠️ Caution
There is only one database administrator db2<dbsid>.

7.4 Creating a User for LDAP Directory Access

If you use LDAP directory services, you have to set up a user with a password on the host where the SAP system is running. This permits the SAP system to access and modify the LDAP directory.

Prerequisites

During the SAP instance installation you chose to configure the SAP system to integrate LDAP services.

Context

For more information, see Integration of LDAP Directory Services [page 203].

Procedure

1. Log on as user <sapsid>adm.
2. Enter the following:
   ldappasswd pf=<Path_and_Name_of_Instance_Profile>
3. Enter the required data.

Example

The following is an example of an entry to create an LDAP Directory User:

CN=sapldap,CN=Users,DC=nt5,DC=sap-ag,DC=de
7.5 Exporting and Mounting Directories via NFS

Related Information

Exporting and Mounting Directories via NFS for Linux [page 215]
Exporting and Mounting Directories via NFS for AIX [page 213]
Exporting and Mounting Directories via NFS for Oracle Solaris [page 217]
Exporting and Mounting Directories via NFS for HP-UX [page 214]

7.5.1 Exporting and Mounting Directories via NFS for AIX

This topic is only valid for 'Platform': AIX

This procedure describes how to export and mount directories via NFS for AIX using the command line.

Context

This section only provides the basic procedure. If you need more detailed information, check your OS vendor’s documentation.

Procedure

- To export an NFS filesystem, do the following steps:
  a. Take the backup of the exports file:
     \[ \text{cp -p /etc/exports /etc/exports_bak} \]
  b. Create an entry for each directory to be exported, using the full path name of the directory:
     \[ \text{vi /etc/exports} \]
  c. Read the /etc/exports file and export all the directories listed:
     \[ \text{exportfs -a} \]
  d. Confirm the exported directory listed:
     \[ \text{showmount -e} \]
  e. Confirm the nfs client name and directory list:
     \[ \text{showmount -a} \]
- Mounting the NFS filesystem on the client:
a. Verify if the NFS server has exported the directory.
   ```bash
   showmount -e <server_name>
   ```
b. Create the mounting directory if not already exist.
   ```bash
   mkdir /local_directory
   ```
c. Mount the remote directory on the client:
   ```bash
   mount <ServerName>:/<remote_directory> /<local_directory>
   ```
d. Confirm that the NFS filesystem has been mounted:
   ```bash
   df -gt <NFS mount_name>
   ```

End of ‘Platform’: AIX

7.5.2 Exporting and Mounting Directories via NFS for HP-UX

This topic is only valid for ‘Platform’: HP-UX

This section describes how to export and mount directories via NFS for HP-UX manually.

Context

This section only provides the basic procedure. If you need more detailed information, check your OS vendor’s documentation.

Procedure

1. On the host where you want to export directories do the following:
   a. Add the file system that you want to export to the file `/etc/dfs/dfstab` using the following syntax:
      ```bash
      share -F nfs -o root= <client_1>:<client_n> access= <client_1>:<client_n>
      <file system to share>
      ```
      ```bash
      share -F nfs -o root=hw5111:hw5115, access=hw511:hw5115 /sapmnt/C11/exe.
      ```
      If you encounter problems, try using the FQDN (Fully Qualified Domain Name).
   b. To make the file system available to NFS clients, enter the following command:
      ```bash
      /usr/sbin/shareall
      ```

2. On the host where you want to mount the directories you exported in the previous step, do the following:
   a. Add the remote file system to `/etc/fstab`
      ```bash
      hw5115:/sapmnt/C11 /sapmnt/C11 nfs defaults 0 0
      ```
   b. Mount the file system.
7.5.3 Exporting and Mounting Directories via NFS for Linux

This topic is only valid for ‘Platform’: Linux

To export directories via NFS, perform the following steps.

Context

This section only provides the basic procedure. If you need more detailed information, check your OS vendor’s documentation.

The following procedure assumes that the central instance host is the NFS server.

Procedure

1. Log on as user root to the NFS server.
2. Make sure that your host is configured as NFS server as follows:
   - On Red Hat Linux, make sure that the output of the command:
     ```bash
     chkconfig --list nfs
     ```
     The output looks as follows:
     ```plaintext
     Example:
     nfs 0:off 1:off 2:off 3:on 4:on 5:on 6:off
     ```
   - On SUSE Linux, enter the following command:
     ```bash
     yast2
     ```

   You can set up your host as NFS server as follows:
   - On Red Hat Linux, enter the following command:
     ```bash
     system-config-users
     ```
   - On SUSE Linux, enter the following command:
     ```bash
     yast2
     ```

3. To export a directory from a local file system, you can proceed as follows:
   - On Red Hat Linux, use the following tool:
     ```bash
     system-config-nfs
     ```
   - On SUSE Linux, use the following tool:
     ```bash
     yast2
     ```

   Perform the configuration manually.
To perform the configuration manually, proceed as follows:

a. To add a line to the local file /etc/exports, enter the following:

```
#/etc/exports
<directory> <hostname> (<options>)
```

**Note**

There must **not** be a blank between `<hostname>` and `<options>`. Otherwise, the directory is exported with default option (ro) (read-only) to the host specified by `<hostname>` and with the option specified by `<options>` to all other hosts.

To export directories on Linux with root permissions, use the option `no_root_squash`. For security reason, **only** use this option during installation.

**Example**

- To export the directory `/usr/sap/trans` in read-only mode to the NFS client host.wdf.sap-ag.de, enter the following:

  ```
  #/etc/exports
  /usr/sap/trans host.wdf.sap-ag.de(ro)
  ```

- To export the directory in read-write mode with root permissions, enter the following:

  ```
  #/etc/exports
  /usr/sap/trans host.wdf.sap-ag.de(rw,no_root_squash)
  ```

- To export the directory to all NFS clients of the domain using a wildcard (*), enter the following:

  ```
  #/etc/exports
  /usr/sap/trans *.wdf.sap-ag.de(rw)
  ```

b. To activate the changes (that is, inform the NFS daemon about the changes performed in `/etc/exports`), enter the following command:

```
exportfs -r
```

c. To see a list of all currently exported directories, enter the following command:

```
exportfs -v
```

For more information, consult the man page by entering `man exports`.

4. Log on as user root to the host where the file system is to be imported.

5. To mount the file systems, enter the following command:

```
mount <nfs_server>:<file_system> <mount_point>
```
7.5.4 Exporting and Mounting Directories via NFS for Oracle Solaris

To mount directories via NFS from the host where the directory resides that you want to mount, log on as user root and proceed as follows.

Context

This section only provides the basic procedure. If you need more detailed information, check your OS vendor's documentation.

Procedure

- On the host on which the directory to be mounted resides:
  a. Enter the following command:
     
     ```
     /usr/sbin/share
     ```
  b. To add file systems shared via NFS, edit file `/etc/dfs/dfstab`:
     
     ```
     vi /etc/dfs/dfstab
     ```
     Add the following line for each file system:
     
     ```
     share -F nfs -o root=<nfsclient1>::<nfsclient2>,anon=0 -d "description" <file_system_to_be_shared>
     ```

     i Note
     Depending on your configuration, a full qualified name may be required for `nfsclient`, for example, `myclient.mydomain.com`.

     △ Caution
     After your SAP system has been installed successfully, in the above line you have to change `-o root` to `-o rw` (or remove `anon=0`, respectively) for all exported directories:
     
     ```
     share -F nfs -o rw=<nfsclient1>::<nfsclient2> -d "description" <file_system_to_be_shared>
     ```
c. If the `/etc/dfs/dfstab` was empty, the NFS server is not active.
   - On Solaris 9, start the NFS server with the following command:
     ```
     /etc/init.d/nfs.server start
     ```
   - On Solaris 10, start the NFS server with the following command:
     ```
     svcadm enable svc:/network/nfs/server:default
     ```

   d. To see if the NFS server is active and which partitions are mountable, enter the command:

   ```
   showmount -e <NFS-server>
   ```

   - On the host on which the additional instance runs:

     a. If you are mounting NFS disks for the first time, the NFS client software is not active.
        - On Solaris 9, start the NFS server with the following command:
          ```
          /etc/init.d/nfs.client start
          ```
        - On Solaris 10, start the NFS server with the following command:
          ```
          svcadm enable svc:/network/nfs/client:default
          ```

     b. Edit the file `/etc/vfstab` to mount the directory:

        ```
        vi /etc/vfstab
        ```

        Add the following line for each file system:
        ```
        <host_name_where_directory_resides>:<file_system_to_be_shared> - <mount point> nfs - yes -
        ```

        If the mount point exists, mount `<file_system_to_be_shared>` with the command:
        ```
        mount <mount point>
        ```

---

**7.6 Heterogeneous SAP System Installation**

This section provides information on the installation of an SAP system in a heterogeneous system landscape. “Heterogeneous system landscape” means that application servers run on different operating systems.

See SAP Note [1067221](1067221) for more information on:

- Supported combinations of operating systems and database systems
- How to install an application server on Windows in a heterogeneous (UNIX) SAP system environment
- Heterogeneous SAP system landscapes with different UNIX operating systems
7.7 Installing the SAP Host Agent Separately

This procedure tells you how to install an SAP Host Agent separately.

Context

The SAP Host Agent is installed automatically during the installation of new SAP instances with SAP kernel 7.20 or higher (integrated installation). This procedure is only for hosts with no SAP Host Agent running on them, due to the following reasons:

- There is no SAP system or instance on the host.
- The SAP system or instance running on the host has a kernel release lower than SAP kernel 7.20 and the host does not yet have an SAP Host Agent.
- You have upgraded your SAP system to a release with a kernel release lower than SAP kernel 7.20 and the host of the upgraded system or instance does not yet have an SAP Host Agent.

SAP Host Agent has the following executable programs and services:

- The `SAPHostExec` service
- The `sapstartsrv` service `SAPHostControl`
- The operating system collector `saposcol`

Note

The installed programs are automatically started when the host is booted.

The automatic start is ensured by the startup script `sapinit`, which starts the required executables.

The following procedure describes the steps you have to perform on the host where you install the SAP Host Agent separately.

Procedure

1. Check the hardware and software requirements on the installation host.
   
   The minimum requirements are as follows:
   
   - Hard Disk Space: 1 GB
   - RAM: 0.5 GB
   - Swap Space: 2 x RAM

   For more information, see hardware and software requirements [page 47].

2. Make sure that the `sapadm` user is created.

   During the installation, the installer checks all required accounts (users, groups) and services on the local machine. The installer checks whether the required users and groups already exist. If not, it creates new users and groups as necessary.
User and Groups of the SAP Host Agent

<table>
<thead>
<tr>
<th>User</th>
<th>Primary Group</th>
<th>Additional Group</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>sapadm</td>
<td>sapsys</td>
<td>–</td>
<td>SAP Host Agent administrator</td>
</tr>
</tbody>
</table>

**Note**

If `sapadm` does not exist, it is created during the SAP Host Agent installation using `/bin/false` shell.

Make sure that `/bin/false` can be used as a login shell.

- Only valid for 'Platform': AIX
- AIX: Add `/bin/false` to the list of valid login shells (`attribute shells`) in `/etc/security/login.cfg`.

---

Groups and Members of the SAP Host Agent User

<table>
<thead>
<tr>
<th>Groups</th>
<th>Members</th>
</tr>
</thead>
<tbody>
<tr>
<td>sapsys</td>
<td>sapadm</td>
</tr>
<tr>
<td>sapinst</td>
<td>sapadm</td>
</tr>
</tbody>
</table>

3. Set up the required file system for the SAP Host Agent and make sure that the required disk space is available for the directories to be created during the installation.

For more information, see Required File Systems and Directories [page 107].

4. Download and unpack the Software Provisioning Manager 1.0 archive on the host where you want to install the SAP Host Agent as described in Downloading and Extracting the Software Provisioning Manager 1.0 Archive [page 123].

5. Make the latest patch level of the `SAPHOSTAGENT <Version>.SAR` available on the host where you want to install the SAP Host Agent.

Download it from the following path: https://launchpad.support.sap.com/#/softwarecenter SUPPORT PACKAGES & PATCHES By Category SAP Technology Components SAP HOST AGENT SAP HOST AGENT 7.21 <Operating System>
Result section of the **Software Package Browser** screen. The info file contains only the results of the latest archive scan. For more information, see SAP Note 2393060.

→ **Recommendation**

It is highly recommended that you always choose the highest SP version of the `SAPHOSTAGENT<SP-version>.SAR` archive.

6. To install the SAP Host Agent, you start the installer [page 147] and choose ***Generic Options*** ». **Database** » *Preparations* » **SAP Host Agent** on the **Welcome** screen of the installer.

7. Check whether the installed services are available:
   a. Log on as a user with **root** authorizations.
      
      **i Note**
      
      When the host is booted, the startup script `sapinit` automatically starts the required executables.

   b. Check whether the following services are available:
      ○ The control program `saphostexec`
      ○ The SAP NetWeaver Management agent `SAPHostControl` (`sapstartsrv` in host mode)

**Next Steps**

For more information about the SAP Host Agent, see the following documentation:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>• SAP NetWeaver Mobile 7.1&lt;br/&gt;<a href="http://help.sap.com/nwmobile71">http://help.sap.com/nwmobile71</a>&lt;br/&gt;</td>
<td><a href="#">Application Help</a> » <a href="#">Function-Oriented View</a> » <a href="#">Application Server Infrastructure</a> » <strong>SAP Host Agent</strong> [ ]</td>
</tr>
<tr>
<td>• SAP NetWeaver Mobile 7.1 including Enhancement Package 1&lt;br/&gt;<a href="http://help.sap.com/nwmobile711">http://help.sap.com/nwmobile711</a>&lt;br/&gt;</td>
<td></td>
</tr>
<tr>
<td>• SAP NetWeaver 7.1 for Banking Services from SAP&lt;br/&gt;<a href="http://help.sap.com/nwmobile71">http://help.sap.com/nwmobile71</a>&lt;br/&gt;</td>
<td></td>
</tr>
<tr>
<td>• SAP NetWeaver 7.1 including Enhancement Package 1 for Banking Services from SAP&lt;br/&gt;<a href="http://help.sap.com/nwmobile711">http://help.sap.com/nwmobile711</a>&lt;br/&gt;</td>
<td>See the SAP NetWeaver Mobile Library.</td>
</tr>
</tbody>
</table>

**i Note**

Since the SAP NetWeaver Mobile 7.1 Library is the only available SAP Library for ABAP systems based on SAP NetWeaver 7.1, in this guide we always refer to it also for SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0.
7.8 Creating Tablespaces Manually (Optional)

Use

If the tablespace layout used by the installer does not meet your requirements, you can optionally create your tablespaces manually. During the **dialog phase of the installation**, you can specify if you want to use tablespaces managed by Db2’s automatic storage management and if you want the installer to create your tablespaces.

Procedure

⚠️ **Caution**

The installer does not check the page size of tablespaces that have either been created manually or are already existing. If you create the tablespaces manually, you **must** use a page size of **16 KB**.

1. On the dialog **IBM Db2 for Linux, UNIX, and Windows: Tablespace Storage Management**, you must deselect the option **Create Tablespaces During the Installation Procedure**.

   🔄 **Note**

   In a **typical** installation, this dialog does not appear. To get to this dialog, select this parameter on the **Parameter Summary** screen and choose **Revise**.

2. Continue to enter all the required parameters and start the installer.

   During the installation phase, a message box appears that prompts you to create tablespaces using the script **createTablespaces.sql**.
3. Go to your installation directory and search for script `createTablespaces.sql`. This file content depends on your selection during the dialog phase and the file contains the same commands for the creation of tablespaces that the installer uses.

```
3. Note
You must create all the tablespaces that are listed in the script.
```

4. Modify the CREATE statements according to your requirements.

5. To execute the script, enter the following command:

```
db2 -tvf <script_name>
```

6. When you have finished, continue with the installation by choosing OK on the message box.

**More Information**

- Db2 Tablespaces [page 89]
- Data Safety and Performance Considerations for Production Systems [page 94]

## 7.9 Adding Database Partitions to a Database Instance

**Use**

Adding database partitions in a database instance means that you can distribute the following tablespaces across multiple database partitions:

- `<SAPSID>#ODSD`
- `<SAPSID>#ODSI`
- `<SAPSID>#FACTD`
- `<SAPSID>#FACTI`

```
3. Note
These tablespaces are used for SAP BW reporting only. Therefore, you should only consider to install on a distributed database server if you plan to use SAP BW reporting extensively with large volumes of data in BW InfoCubes.
```

**Prerequisites**

**Recommendation**

We strongly recommend that you involve a consultant with multipartition skills in the whole process of planning and installing a multipartition SAP system on a Db2 database.
You have successfully installed an SAP database instance.

**Note**
In an MCOD environment, you are able to use tablespaces without AutoStorage and a database with AutoStorage.

The multipartition database manager instance DB2<DBSID> for SAP BW Db2 is only created on database server 1.

Check if your database is enabled for automatic storage management:
- If the database is enabled for automatic storage management, make sure that the automatic storage paths do exist on the host where you want to add a new database partition. In addition, make sure that the user db2<dbsid> can access these automatic storage paths.
- If the database is **not** enabled for automatic storage management, no further action is required.

**Procedure**

1. Stop the SAP system and the SAP database instance.
2. To add database partitions on a database server, proceed as follows:
   1. Log on with the same user who installed Db2 on the instance-owning database partition server.
   2. Make sure that you have the same system time on each participating computer as on the instance-owning database partition server.
   3. On every additional database server where you want to add database partitions, mount the home directory of user db2<dbsid> (/db2/db2<dbsid>).
      **Note**
      Optionally, you can also mount /db2/<DBSID>/db2dump so that diagnostic files are all written to a central location. If you do not mount /db2/<DBSID>/db2dump, all diagnostic files are written to each additional database server.
      Therefore, we recommend that you mount /db2/<DBSID>/db2dump to have all diagnostic files in one place.
   4. Mount the following directory on every additional database server:
      /sapmnt/<SAPSID>
   5. Start SAP’s installer, the Software Provisioning Manager.
   6. On the Welcome screen, choose **Generic Installation Options > IBM Db2 for Linux, UNIX, and Windows > Database Tools > Db2 Database Partitioning Feature - Add Database Partitions**.
   7. To continue, choose **Next** and follow the instructions on the dialogs of the installer.
      **Note**
      Choose the same communication ports on all database servers.

3. Add the new partitions to the existing database partition groups by using the **BW Data Distribution** wizard in the DBA Cockpit:
   1. In the SAP system, call transaction DBACOCKPIT and choose **BW Administration > BW Data Distribution** in the navigation frame of the SAP GUI-based DBA Cockpit.
2. Follow the instructions on the screens.

7.10 Splitting Off an ABAP Central Services Instance from an Existing Primary Application Server Instance

With the installation option Split Off ASCS Instance from existing Primary Application Server Instance, you can move the message server and the enqueue work process from an existing primary application server instance to a newly installed ABAP central services instance (ASCS instance). The new ASCS instance is installed while the split is done.

Prerequisites

The existing SAP system of the primary application server instance must meet the following requirements:

- It was upgraded from an SAP system release based on SAP NetWeaver lower than 7.1.
- It does not yet have an ASCS instance

Context

Before the Split

The primary application server instance includes:

- ABAP dispatcher and work processes (dialog, batch, spool, enqueue, or update)
- Gateway
- Internet communication manager (ICM)
- Internet graphics service (IGS)
- ABAP message server

After the Split

An ABAP central services instance (ASCS instance) has been split off from the existing primary application server instance.

The primary application server instance now includes:

- ABAP dispatcher and work processes (dialog, batch, spool, or update)
- Gateway
- Internet communication manager (ICM)
- Internet graphics service (IGS)

The newly created ABAP central services instance (ASCS instance) includes:

- ABAP message server
- ABAP standalone enqueue server
The ABAP enqueue work process is now replaced with the ABAP standalone enqueue server.

**Note**

ASCS instance with “Standalone Enqueue Server” versus ASCS instance with new “Standalone Enqueue Server 2”: Software Provisioning Manager 1.0 installs the “Standalone Enqueue Server” by default for all SAP system releases in the ASCS instance. However, if you have installed the ASCS instance for an SAP system based on SAP NetWeaver AS for ABAP 7.52, you can switch to the new “Standalone Enqueue Server 2” after the installation has completed. For more information, see https://help.sap.com/nw752abap

The Effect of the Split

The following graphic provides an overview of the components contained in the primary application server instance before and after the split, along with the newly created ASCS instance:
**Procedure**

1. Plan the basic parameters, as described in SAP System Parameters [page 64]:
   - Choose an instance number for the ASCS instance to be created.
   - Note that the message server port is not changed during the split.
2. Check the hardware and software requirements for the ASCS instance to be created as described in Hardware and Software Requirements [page 47].
3. Specify basic SAP System Parameters [page 64] for the ASCS instance to be created.
4. Set up the required file systems [page 107] for the ASCS instance to be created.
5. Check the prerequisites [page 143] and start the installer [page 147] on the host where the ASCS instance is to be created.
6. On the Welcome screen, choose Generic Options <Database> Split Off ASCS Instance from Existing Primary Application Server Instance.
7. Follow the instructions on the installer screens and enter the required parameters.
   
   **Note**
   
   To find more information on each parameter during the Define Parameters phase, position the cursor on the required parameter input field, and choose either F1 or the HELP tab. Then the available help text is displayed in the HELP tab.

   After you have entered all requested input parameters, the installer displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that the installer set by default. If required, you can revise the parameters before starting the installation.

8. To start the installation, choose Start.

   **Caution**

   All SAP system instances are stopped during the split procedure.

   The installer starts the installation and displays the progress of the installation. When the installation has successfully completed, the installer shows the dialog Execution of Split Off ASCS Instance from existing Primary Application Server Instance has completed.

9. You check and if necessary modify the settings for the operating system users for your SAP system if they were created by the installer.

   For more information, see Creating Operating System Users and Groups [page 102].

10. Restart the application server instances [page 229] (primary application server instance and additional application server instances if they exist).

11. Check whether you can log on to the application servers [page 164].

12. Ensure user security [page 186] for the operating system users of the newly created ASCS instance.

13. If you installed a high-availability system based on SAP NetWeaver AS for ABAP 7.52, you can decide whether you want to switch to standalone enqueue server 2 and enqueue replication server.

14. If required, perform an installation backup [page 195].
7.11 Installing a Near-Line Storage Database for an SAP Business Warehouse

Use

You install a near-line database if you want to use a Db2 remote database as repository to store BW data that is not frequently used.

Prerequisites

You have successfully installed an SAP BW system. You must use IBM Db2 V9.7 or higher for the installation of the near-line storage database, even if you have installed your SAP BW system on a lower Db2 version.

Procedure

1. Log on as user root to the host where you want to install the Db2 remote database.
2. Start the installer (the Software Provisioning Manager [page 147]).
3. On the Welcome screen, choose Generic Installation Options > IBM Db2 for Linux, UNIX, and Windows > Database Tools > Install Near-Line Storage Database.
4. To continue, choose Next and follow the instructions on the dialogs of the installer.

   **Note**
   During the dialog phase of the installer, write down the following information:
   - Name of server where you installed the Db2 remote database
   - Communication port
   - Name of database

   This information is required when you want to configure the access to the remote database from your SAP BW system.

5. To further configure and set up your NLS database for near-line storage, follow the steps described in the guide Enabling an SAP BW to Use IBM Db2 for Linux, UNIX, and Windows as Near-Line Storage.

More Information

*Enabling an SAP BW to Use IBM Db2 for Linux, UNIX, and Windows as Near-Line Storage (see Online Information from SAP [page 245])*
7.12 Starting and Stopping SAP System Instances

Start or stop SAP system instances in one of the following ways:

- Using the SAP Management Console (SAP MC) [page 229]
- Using commands [page 233].

7.12.1 Starting and Stopping SAP System Instances Using the SAP Management Console

You can start and stop all instances of your SAP system using the SAP Management Console (SAP MC).

Prerequisites

- Make sure that the host names defined in the DNS server match the names of the SAP system instance hosts. In particular, keep in mind that host names are case-sensitive. For example, if the names of the SAP system instance hosts are in upper case, but the same host names are defined in the DNS server in lower case, starting and stopping the system does not work.
- If you want to start or restart remote systems or instances, make sure that you have registered them in the SAP Management Console (SAP MC). You do not need to register SAP systems or instances installed on the local host, because the SAP MC displays them automatically.
- The SAP Host Agent is installed on the host where the application server of the SAP system or instance runs.
- You have installed Java Runtime Environment (JRE) 5.0 or higher.
- Your Web browser supports Java.
- Your Web browser’s Java plug-in is installed and enabled to run scripting of Java applets.

Context

→ Recommendation

If you experience any issues when starting or using the SAP MC, refer to SAP Note 1153713.
For more information about handling the SAP MC, see the SAP Library at:

<table>
<thead>
<tr>
<th>SAP Release and SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver Mobile 7.1</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nwmobile71">http://help.sap.com/nwmobile71</a></td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver Mobile 7.1 including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td><a href="http://help.sap.com/nwmobile711">http://help.sap.com/nwmobile711</a></td>
<td></td>
</tr>
</tbody>
</table>

- SAP NetWeaver 7.3
  - SAP NetWeaver 7.3 including Enhancement Package 1
- SAP NetWeaver 7.4
  - http://help.sap.com/nw74
- SAP NetWeaver 7.5
  - http://help.sap.com/nw75
- SAP NetWeaver Application Server for ABAP 7.51 innovation package
  - https://help.sap.com/nw751abap
- SAP NetWeaver AS for ABAP 7.52
  - https://help.sap.com/nw752abap

If your newly installed SAP system is part of a heterogeneous SAP system landscape comprising systems or instances on Windows platforms, you can also start and stop it from a Windows system or instance using the **SAP Microsoft Management Console (SAP MMC)**. For more information about handling the SAP MMC, see the SAP Library at:

<table>
<thead>
<tr>
<th>Release SAP Library Quick Link</th>
<th>SAP Library Path (Continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP NetWeaver Mobile 7.1</td>
<td>See the SAP Library path for SAP NetWeaver 7.3 and higher.</td>
</tr>
<tr>
<td>SAP NetWeaver Mobile 7.1 including Enhancement Package 1</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.1 for Banking Services from SAP 5.0 and 6.0</td>
<td></td>
</tr>
<tr>
<td>SAP NetWeaver 7.1 including Enhancement Package 1 for Banking Services from SAP 5.0 and 6.0</td>
<td></td>
</tr>
</tbody>
</table>
### Release SAP Library Quick Link

- SAP NetWeaver 7.3
- SAP NetWeaver 7.3 including Enhancement Package 1
- SAP NetWeaver 7.4
- SAP NetWeaver 7.5
- SAP NetWeaver Application Server for ABAP 7.51 innovation package
  [https://help.sap.com/nw751abap](https://help.sap.com/nw751abap)
- SAP NetWeaver AS for ABAP 7.52
  [https://help.sap.com/nw752abap](https://help.sap.com/nw752abap)

### SAP Library Path (Continued)

- Application Help
- Function-Oriented View: English
- Solution Life Cycle Management
- SAP Microsoft Management Console: Windows

---

### Procedure

1. **Starting the Web-Based SAP Management Console**
   - Start a Web browser and enter the following URL:
     
     ```
     http://<Host_Name>:5<Instance_Number>13
     ```
     
     **Example**
     
     If the instance number is 53 and the host name is `saphost06`, you enter the following URL:
     
     ```
     http://saphost06:55313
     ```
     
     This starts the SAP MC Java applet.

     **Note**
     
     If your browser displays a security warning message, choose the option that indicates that you trust the applet.

   - Choose **Start**.
     
     The SAP Management Console (SAP MC) appears.
     
     By default, the instances installed on the host you have connected to are already added in the SAP MC.

     **Note**
     
     If the instances have not been added or if you want to change the configuration to display systems and instances on other hosts, you have to register your system manually. This is described in *Registering Systems and Instances in the SAP Management Console* below.

2. **Starting SAP Systems or Instances**
   
   Similarly, you can start or restart all SAP systems and individual instances registered in the SAP MC.
   
   - In the navigation pane, open the tree structure and navigate to the system node that you want to start.
2. Select the system or instance and choose **Start** from the context menu.
3. In the **Start SAP System(s)** dialog box, choose the required options.
4. Choose **OK**.
   The SAP MC starts the specified system or system instances.

   **Note**
   The system might prompt you for the SAP system administrator credentials. To complete the operation, you require administration permissions.
   Log in as user `<sapsid>adm`.

**Starting SAP System Instances Successively**

If you need to start the instances of an SAP system successively – for example when you want to start a distributed or a high-availability system – proceed as follows:

1. Start the database instance.
2. Start the ABAP central services instance `ASCS<Instance_Number>`.
3. Start the primary application server instance `D[VEBMGS]<Instance_Number>`.

   **Note**
   In SAP systems based on SAP NetWeaver 7.5 or higher, the primary application server instance is named `D<Instance_Number>`.
   In SAP systems based on SAP NetWeaver 7.4 or lower, the primary application server instance is named `DVEBMGS<Instance_Number>`.

4. Start additional application server instances `D<Instance_Number>`, if there are any.

**Stopping SAP Systems or Instances**

Similarly, you can stop all SAP systems and individual instances registered in the SAP MC.

1. Select the system or instance you want to stop and choose **Stop** from the context menu.
2. In the **Stop SAP System(s)** dialog box, choose the required options.
3. Choose **OK**.
   The SAP MC stops the specified system or system instances.

   **Note**
   The system might prompt you for the SAP system administrator credentials. To complete the operation, you require administration permissions.
   Log in as user `<sapsid>adm`.

**Stopping SAP System Instances Successively**

If you need to stop the instances of an SAP system successively – for example when you want to start a distributed or a high-availability system – proceed as follows:

1. Stop additional application server instances `D<Instance_Number>`, if there are any.
2. Stop the primary application server instance `D[VEBMGS]<Instance_Number>`.
In SAP systems based on SAP NetWeaver 7.5 or higher, the primary application server instance is named D<Instance_Number>.

In SAP systems based on SAP NetWeaver 7.4 or lower, the primary application server instance is named DVEBMGS<Instance_Number>.

3. Stop the ABAP central services instance ASCS<Instance_Number>.
4. Stop the database instance.

7.12.2 Starting and Stopping SAP System Instances Using Commands

Prerequisites

You are logged on to the SAP system host as user <sapsid>adm.

Context

The `startsap` and `stopsap` commands are deprecated. SAP recommends that you do not use them any longer. For more information, see SAP Notes 1763593 and 809477.

This section only lists the basic commands how to start or stop an SAP system. You can find a detailed list of all `SAPControl` options and features in the command line help, which you can call as follows:

```
/usr/sap/hostctrl/exe/sapcontrol --help
```

Procedure

- Starting an SAP System or Instance
  - Starting an SAP System:
    You can start an SAP system by executing the following commands from the command line:
    `<Instance_Number>` can be the number of any instance of the SAP system):
    `#/usr/sap/hostctrl/exe/sapcontrol -nr <instance_number> -function StartSystem`
  - Starting an SAP System Instance
    You can start an SAP system instance by executing the following commands from the command line:
    `/usr/sap/hostctrl/exe/sapcontrol -nr <instance_number> -function StartSystem`
For remote instances, the syntax is slightly different, because you also have to apply the `-host` and `-user` parameters:

```
/usr/sap/hostctrl/exe/sapcontrol -nr <instance_number> -host <remote host> -user <sapsid>adm <password> -function Start
```

- **Stopping an SAP System or Instance**
  - **Stopping an SAP System**
    You can stop an SAP system by executing the following commands from the command line (`<Instance_Number>` can be the number of any instance of the SAP system):
    ```
    /usr/sap/hostctrl/exe/sapcontrol -nr <instance_number> -function StopSystem
    ```
  - **Stopping an SAP System Instance**
    You can stop an SAP system instance by executing the following commands from the command line:
    ```
    /usr/sap/hostctrl/exe/sapcontrol -nr <instance_number> -function Stop
    ```
    For remote instances, the syntax is slightly different, because you also have to apply the `-host` and `-user` parameters:
    ```
    /usr/sap/hostctrl/exe/sapcontrol -nr <instance_number> -host <remote host> -user <sapsid>adm <password> -function Stop
    ```

- **Note**
  The database is not stopped by these commands. You have to stop the database using database-specific tools or commands.

- **Checking System Instance and Processes**
  - With the following command you get a list of system instances, their status, and the ports used by them (`<Instance_Number>` can be the number of any instance of the SAP system):
    ```
    /usr/sap/hostctrl/exe/sapcontrol -nr <instance_number> -host <remote host> -user <sapsid>adm <password> -function GetSystemInstanceList
    ```
  - With the following command you get a list of instance processes and their status:
    ```
    /usr/sap/hostctrl/exe/sapcontrol -nr <instance_number> -host <remote host> -user <sapsid>adm <password> -function GetProcessList
    ```

- **Troubleshooting**
  If you get an error like "FAIL: NIECONN_REFUSED", execute `sapcontrol -nr <Instance_Number> -function StartService <SAPSID>` to ensure that `sapstartsrv` is running. Then execute again the start or stop command.
7.13 Minimizing the Database Size After the Installation

Use

Even if you have installed your SAP system without selecting the options *Use Db2’s Data Compression* and *Use Deferred Table Creation*, you can still minimize the database size at a later point in time as follows:

- **Compress existing tables and indexes.**
  You can use the *Compression Candidates* screen in the DBA Cockpit to identify candidates for compression and to compress tables and indexes.

- **Activate the global compression option.**
  If the global compression option is set to *YES*, compression is enabled for all tables that are created during the productive use of the database. Up to IBM Db2 10.1, static row compression is used as a default. As of IBM Db2 10.5, adaptive compression is used.

- **Activate deferred table creation.**

- **Use additional features for minimizing the database size** (as of IBM Db2 10.1 only).

Procedure

Compressing Existing Tables and Indexes Using the DBA Cockpit

**i Note**

The following steps apply if the database collection framework has been set up correctly as described in the separate document *Database Administration Using the DBA Cockpit: IBM Db2 for Linux, UNIX, and Windows*.

In your SAP system, call transaction *DBACOCKPIT* and choose *Space Tables and Indexes Compression Candidates* on the *Database* tab page of the DBA Cockpit. On the *Compression Candidates* screen, you can identify tables that are candidates for compression (or recompression) based on selection criteria that you can specify.

For more information, see the section *Compression Candidates* in the document *Database Administration Using the DBA Cockpit: IBM Db2 for Linux, UNIX, and Windows*.

Activating the Global Compression Option

**i Note**

The following steps apply if the database collection framework has been set up correctly as described in the separate document *Database Administration Using the DBA Cockpit: IBM Db2 for Linux, UNIX, and Windows*.

If you do not want to use the DBA Cockpit, you can follow the instructions in SAP Note 1690077 instead.

1. In your SAP system, call transaction *DBACOCKPIT* and choose *Space Compression Status* on the *Database* tab page of the DBA Cockpit.
2. Set the compression option that suits your system best.

For more information, see the section Compression Status in the document Database Administration Using the DBA Cockpit: IBM Db2 for Linux, UNIX, and Windows.

Activating Deferred Table Creation

⚠️ Caution

Before you use this function, make sure that you read SAP Note 1151343.

The following tables are excluded from the conversion to virtual tables:
- Volatile tables
- MDC tables
- Partitioned tables

1. In your SAP system, call transaction DBACOCKPIT and choose Space Virtual Tables on the Database tab page of the DBA Cockpit.

2. On the Virtual Tables screen, choose the Candidates for Virtualization tab page.
   A list of tables that are candidates for being dropped and re-created as virtual tables is displayed.

3. Choose the Convert Empty Tables pushbutton.
   A job is scheduled that checks a background job is scheduled that checks each table if it is:
   - Empty
   - Not volatile
   - Does not have a partitioning key
   - Not using MDC tables
   Tables that meet these conditions are dropped and re-created as virtual tables.

ℹ️ Note

To materialize tables again, that is, to create the empty tables that have not yet been created after the installation, select one or more tables from the list on the Virtual Tables tab page and choose the Materialize pushbutton.

Using Additional Features for Compression and Space Reclamation

As of IBM Db2 10.1, additional features for database compression and space reclamation are available:
- Insert time clustering tables (ITC tables)
- Compression of log files
- More compact indexes (new registry variable DB2_INDEX_PCTFREE_DEFAULT=0)
- Automatic reclamation of index space

For more information, see SAP Note 1700631.

More Information

Database Administration Using the DBA Cockpit: IBM Db2 for Linux, UNIX, and Windows (see Online Information from SAP [page 245])
7.14 Deleting an SAP System or Single Instances

This section describes how to delete a complete SAP system or single SAP instances with the Uninstall option of the installer.

Prerequisites

- You have installed your SAP system with standard SAP tools according to the installation documentation.
- You are logged on as a user with root permissions.

⚠️ Caution
Do not use the <sapsid>adm user to delete the SAP system.

- Make sure that the SAP system, or single instance, or standalone engine, or optional standalone unit to be deleted is down and that you are not logged on as one of the SAP system users. Also check that all SAP-related processes are stopped. If there is a lock on one of the SAP system objects, the uninstall fails.

ℹ️ Note
You do not have to stop the SAP Host Agent. The SAP Host Agent is stopped automatically during the uninstall process.

- When starting the uninstall, make sure that there are no SAP system user sessions still open.

Context

Note the following when deleting an SAP system or single instances:

- We strongly recommend that you delete an SAP system or single instances using the installer. However, you can also delete an SAP system or single instance manually. For more information, see SAP Note 1259982.
- When you uninstall an SAP system, the database content is also deleted.
- You cannot delete an SAP system remotely.
- During the uninstall process, all file systems and subdirectories of the selected SAP system or single instance are deleted. Before you start uninstalling, check that you have saved a copy of all files and directories that you want to keep to a secure location.
- The uninstall process is designed to remove as much as possible of the SAP system to be deleted. If an item cannot be removed, a message informs you that you have to remove this item manually. You can do this either at once or after the uninstall process has finished. As soon as you confirm the message, the uninstall process continues.
Procedure

1. Start the installer as described in Running the Installer [page 147].
2. On the Welcome screen, choose:
   ![Generic Installation Options] <Database> Uninstall | Uninstall SAP Systems or Single Instances
3. Follow the instructions on the installer screens to delete a complete SAP system or single instances.

**Note**
To find more information on each parameter during the Define Parameters phase, position the cursor on the required parameter input field, and choose either F1 or the HELP tab. Then the available help text is displayed in the HELP tab.

The following table provides information about deleting a complete system or single instances with the installer.

<table>
<thead>
<tr>
<th>Deletion of</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard system</td>
<td>You can delete a standard system (where all instances reside on the same host) in one installer run.</td>
</tr>
</tbody>
</table>
### Deletion of Distributed or high-availability system

If you want to delete a distributed or high-availability system, you have to run the installer to delete the required instances **locally** on each of the hosts belonging to the SAP system in the following sequence:

1. Additional application server instances, if there are any

   **Caution**

   Do **not** select checkbox *Uninstall all instances of the SAP system from this host* if you do **not** want to uninstall the complete SAP system or standalone engine. For example, do not select this checkbox if you only want to uninstall an additional application server instance of an existing SAP system distributed over several hosts. Otherwise the contents of mounted global directories under `/<sapmnt>//<SAPSID>`, such as instance profiles and kernel executables, are also deleted.

2. Primary application server instance

3. Database instance

   Since the installer only stops local instances automatically, make sure that before deleting the database instance of a distributed system, you stop all remaining instances. You must stop the instance with the message server only after having entered all installer parameters for the deletion of the database instance. To delete the database instance or one or more database schemas, choose one of the following options:
   - *Drop database*
     Select this option if you want to drop the database.
   - *Select the database schema that you want to delete*
     Select this option if you are running multiple components on one database (MCOD) and you **only** want to delete the database schema of the corresponding component to be deleted.

4. ABAP Central services instance (ASCS)

   **Note**

   To delete system directories mounted from an NFS server, you have to run the installer on the NFS server.

### Additional application server

If you want to delete additional application server instances of an existing SAP system, you have to run the installer to delete them **locally** on each additional application server instance host.

### Caution

If you are running multiple components on one database (MCOD), do **not** delete the database.
Deletion of

<table>
<thead>
<tr>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>The SAP Host Agent is automatically uninstalled from a host together with the last remaining SAP system instance. If you want to uninstall a standalone SAP Host Agent, deselect Profiles Available and select Uninstall Standalone SAP Host Agent on the General SAP System Parameters screen.</td>
</tr>
</tbody>
</table>

4. When you have finished, delete the relevant directory structure on the global host.

5. If you created the directories /usr/sap/<SAPSID> and /<sapmnt>//<SAPSID> as mount points, but not as directories on the local file system, you have to remove them manually.

6. To remove obsolete SLD data, see the following document: https://wiki.scn.sap.com/wiki/display/SL/More+on+System+Landscape+Directory - Duplicate System Entries

7.15 Deleting a Database Instance, the Database Software, or a Database Schema Manually

The software provisioning manager allows you to delete database instances and database software. If you cannot use the uninstall functions of the software provisioning manager, delete the database instance and database software manually as described in the following instructions.

In addition, this section also contains information how to delete a single database schema (not a database) in an MCOD scenario, for example.

7.15.1 Deleting the Database and the Db2 Instance Manually

You use this procedure to manually delete the database and the Db2 instance of a complete SAP system.

⚠️ Caution

Do not delete the database in one of the following situations:

- You are running multiple components on one database (MCOD) and you only want to delete one or more of your components but not the complete system
- You only want to delete the Java part of an SAP system (ABAP+Java or Java Add-In).

In this case you delete the corresponding database schema as described in Deleting a Database Schema Manually [page 242].
Prerequisites

Before deleting the database, stop and delete all SAP instances belonging to the database.

Procedure

1. To delete the database, proceed as follows:
   1. Log on as user `db2<dbsid>`.
   2. To start the database, enter the following command:
      ```
      db2start
      ```
   3. To delete the database `<DBSID>`, enter the following command:
      ```
      db2 drop database <DBSID>
      ```
   4. To stop the database, enter the following command:
      ```
      db2stop
      ```
2. To delete the Db2 instance, log on as user `root`.
3. Enter the following command:
   ```
   %DB2PATH%/instance/db2idrop db2<dbsid>
   ```
4. Remove user `db2<dbsid>` from group `db<dbsid>adm` (if the group `db<dbsid>adm` is now empty, remove it also).
5. Delete user `db2<dbsid>`.
6. To remove the home directory of `db2<dbsid>` and all subdirectories, enter the following command.
   ```
   rm -rf /db2/db2<dbsid>
   ```
7. Unmount and delete the following file systems (if they exist):
   ```
   /db2/<DBSID>/log_dir
   /db2/<DBSID>/db2dump
   /db2/<DBSID>/sapdata<n>
   /db2/<DBSID>/sapdata/sapdata<n>
   /db2/<SAPSID>/sapdata/sapdata<n>
   /db2/<DBSID>/saptmp<n>
   /db2/<DBSID>/saptmp/saptmp<n>
   /db2/<SAPSID>/saptmp<n>
   /db2/<SAPSID>/saptmp/saptmp<n>
   /db2/<DBSID>
   ```
8. Remove the connect user from group `db<dbsid>mon` (if the group `db<dbsid>mon` is now empty, remove it, too).

   **iNote**
   
   The standard connect user for ABAP is `sap<sapsid>`.

   Note that you might have a different connect user name if you have changed the standard name during installation.

9. Delete the connect user, its home directory, and all subdirectories of this directory.
10. If they are empty and not longer required, delete the groups `db<dbsid>adm, db<dbsid>mon, db<dbsid>ctl`. 
11. Delete the `/etc/services` entries for `sapdb<DBSID>`. In other words, delete the lines starting with `sapdb<DBSID>`.

7.15.2 Deleting the Db2 Software Installation Manually

1. Check that no Db2 instance exists by entering the following command:
   ```
   %DB2PATH%/instance/db2ilist
   ```
   
   **Note**
   
   If no instance is listed, you can continue with step 2. If any instance is listed, you must delete this instance before you can delete the database software. For more information, see Deleting the Database and Db2 Instance Manually (page 240).

2. Log on as user with root authority.

3. Enter the following command:
   ```
   %DB2PATH%/install/db2_deinstall -a
   ```

7.15.3 Deleting a Database Schema Manually

You can generate and use the following scripts to delete a database schema manually (not the complete database). During the manual deletion, you must delete all tables and indexes, modules, views, functions, procedures, variables, and tablespaces belonging to the schema.

**Prerequisites**

- Make sure that any instance that uses the schema is stopped.
- The database must be up and running.

**Context**

You delete a database schema in the following situation: You are running multiple components on one database (MCOD) and you only want to delete the database schema of the corresponding component to be deleted.

You also delete a database schema if you want to delete the Java part of an SAP system (ABAP+Java or Java Add-In).
Procedure

1. Log on to the database server as `db2<dbsid>` and open a command prompt.

2. To delete all tables of the database schema, proceed as follows:
   a. Enter the following SQL statement to create a script:
      ```sql
      db2 "SELECT 'DROP TABLE ' || CHR(34) || VARCHAR(tabschema) || CHR(34) || '.'
      "|| CHR(34) || tabname || CHR(34) || ';' FROM syscat.tables WHERE
tabschema='<SAP_SYSTEM_SCHEMA>' AND TYPE in ('T','G') " | grep "DROP" >
drop_<sap_system_schema>_tables.txt
      
      where `<SAP_SYSTEM_SCHEMA>` is the name of the database schema.
   b. To delete all tables, run this script using the following command:
      ```
      db2 —tvf drop_<sap_system_schema>_tables.txt
      ```

3. To delete all views of the database schema, proceed as follows:
   a. Enter the following SQL statement to create a script:
      ```sql
      db2 " SELECT 'DROP VIEW ' || CHR(34) || VARCHAR(tabschema) || CHR(34) || '.'
      "|| CHR(34) || tabname || CHR(34) || ';' FROM syscat.tables WHERE
tabschema='<SAP_SYSTEM_SCHEMA>' AND TYPE='V' " | grep "DROP" >
drop_<sap_system_schema>_views.txt
      
      where `<SAP_SYSTEM_SCHEMA>` is the name of the database schema.
   b. To delete all views, run this script using the following command:
      ```
      db2 —tvf drop_<sap_system_schema>_views.txt
      ```

4. To delete all modules of the database schema, proceed as follows:
   a. Enter the following SQL statement to create a script:
      ```sql
      db2 " SELECT 'DROP MODULE ' || CHR(34) || VARCHAR(moduleschema) || CHR(34) || '.'
      "|| CHR(34) || modulename || CHR(34) || ';' FROM syscat.modules WHERE
moduleschema='<SAP_SYSTEM_SCHEMA>' " | grep "DROP" >
drop_<sap_system_schema>_modules.txt
      
      where `<SAP_SYSTEM_SCHEMA>` is the name of the database schema.
   b. To delete all modules, run this script using the following command:
      ```
      db2 —tvf drop_<sap_system_schema>_modules.txt
      ```

5. To delete all functions of the database schema, proceed as follows:
   a. Enter the following SQL statement to create a script:
      ```sql
      db2 " SELECT 'DROP SPECIFIC FUNCTION ' || CHR(34) || VARCHAR(funcschema) ||
      CHR(34) || '.' || CHR(34) || specificname || CHR(34) || ';' FROM
syscat.functions WHERE funcschema='<SAP_SYSTEM_SCHEMA>' " | grep "DROP" >
drop_<sap_system_schema>_functions.txt
      
      where `<SAP_SYSTEM_SCHEMA>` is the name of the database schema.
   b. To delete all functions, run this script using the following command:
      ```
      db2 —tvf drop_<sap_system_schema>_functions.txt
      ```

6. To delete all procedures of the database schema, proceed as follows:
a. Enter the following SQL statement to create a script:

```
  db2 "SELECT 'DROP SPECIFIC PROCEDURE ' || CHR(34) || VARCHAR(routineschema)
  ||CHR(34) || '.' || CHR(34) || specificname || CHR(34) || ';' FROM
  syscat.routines WHERE routineschema='"SAP_SYSTEM_SCHEMA' " | grep "DROP" >
  drop_<sap_system_schema>_procedures.txt
```

where `<SAP_SYSTEM_SCHEMA>` is the name of the database schema.

b. To delete all procedures, run this script using the following command:

```
db2 -tvf drop_<sap_system_schema>_procedures.txt
```

7. To delete all variables of the database schema, proceed as follows:

a. Enter the following SQL statement to create a script:

```
  db2 "SELECT 'DROP VARIABLE ' || CHR(34) || VARCHAR(varschema) ||CHR(34) ||
  '.' || CHR(34) || varname || CHR(34) || ';' FROM syscat.variables WHERE
  varschema='"SAP_SYSTEM_SCHEMA' " | grep "DROP" >
  drop_<sap_system_schema>_variables.txt
```

where `<SAP_SYSTEM_SCHEMA>` is the name of the database schema.

b. To delete all variables, run this script using the following command:

```
db2 -tvf drop_<sap_system_schema>_variables.txt
```

8. Drop the database schema using the following command:

```
db2 drop schema <SAP_SYSTEM_SCHEMA> restrict
```

9. Delete all tablespaces by performing the following steps:

a. To see an overview, list all tablespaces using the following command:

```
db2 list tablespaces
```

b. When you delete the Java part of an SAP system (ABAP+Java or Java Add-In), delete only the Java
tablespaces, that is `<SAPSID>#DBD` and `<SAPSID>#DBI`.

c. In an ABAP-only or Java-only system, delete all tablespaces starting with `<SAPSID>`. 

d. To delete the relevant tablespaces, enter the following command:

```
db2 drop tablespace <tablespace_name>
```
A Appendix

A.1 Online Information from SAP

More information is available online as follows:

<table>
<thead>
<tr>
<th>Titel</th>
<th>Internet Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central access to all guides for SAP on IBM Db2</td>
<td><a href="https://help.sap.com/viewer/p/DB6">https://help.sap.com/viewer/p/DB6</a></td>
</tr>
<tr>
<td>Running an SAP System on IBM Db2 with the Db2</td>
<td></td>
</tr>
<tr>
<td>pureScale Feature</td>
<td>IBM Db2 11.1: <a href="https://help.sap.com/viewer/db6_purescale_11_1">https://help.sap.com/viewer/db6_purescale_11_1</a></td>
</tr>
<tr>
<td></td>
<td>IBM Db2 10.5: <a href="https://help.sap.com/viewer/db6_purescale_10_5">https://help.sap.com/viewer/db6_purescale_10_5</a></td>
</tr>
<tr>
<td></td>
<td>IBM Db2 10.1: <a href="https://help.sap.com/viewer/db6_purescale_10_1">https://help.sap.com/viewer/db6_purescale_10_1</a></td>
</tr>
<tr>
<td>IBM Db2 High Availability Solution: IBM Tivoli</td>
<td><a href="https://help.sap.com/viewer/db6_samp">https://help.sap.com/viewer/db6_samp</a></td>
</tr>
<tr>
<td>System Automation for Multiplatforms</td>
<td></td>
</tr>
<tr>
<td>for Linux, UNIX, and Windows</td>
<td></td>
</tr>
<tr>
<td>Database Administration Using the DBA Cockpit:</td>
<td><a href="https://help.sap.com/viewer/db6_dbacockpit">https://help.sap.com/viewer/db6_dbacockpit</a> (English)</td>
</tr>
<tr>
<td>IBM Db2 for Linux, UNIX, and Windows</td>
<td><a href="https://help.sap.com/viewer/db6_dbacockpit_de">https://help.sap.com/viewer/db6_dbacockpit_de</a> (German)</td>
</tr>
<tr>
<td>SAP Business Warehouse on IBM Db2 for Linux,</td>
<td></td>
</tr>
<tr>
<td>UNIX, and Windows: Administration Tasks</td>
<td>Db2 10.5 and higher: <a href="https://help.sap.com/viewer/db6_bw">https://help.sap.com/viewer/db6_bw</a></td>
</tr>
<tr>
<td></td>
<td>Db2 10.1 and lower: <a href="https://help.sap.com/viewer/db6_bw_10_1">https://help.sap.com/viewer/db6_bw_10_1</a></td>
</tr>
<tr>
<td>IBM Db2 for Linux, UNIX, and Windows as Near-Line</td>
<td></td>
</tr>
<tr>
<td>Storage (NLS)</td>
<td></td>
</tr>
<tr>
<td>SAP on Db2 for Linux, UNIX, and Windows Community</td>
<td><a href="https://www.sap.com/community/topic/db2-for-linux-unix-and-windows.html">https://www.sap.com/community/topic/db2-for-linux-unix-and-windows.html</a></td>
</tr>
</tbody>
</table>

A.2 Online Information from IBM

You can use the following IBM Knowledge Center welcome page as a starting point to all kinds of documentation for your IBM Db2 for Linux, UNIX, and Windows version: http://www.ibm.com/support/knowledgecenter/en/SSEPGG
The following tables provide direct links to IBM Db2 online documentation and manuals, listed by database version:

### IBM Db2 Knowledge Center

<table>
<thead>
<tr>
<th>Database Version</th>
<th>Internet Address</th>
</tr>
</thead>
</table>

### IBM Manuals

<table>
<thead>
<tr>
<th>Database Version</th>
<th>Internet Address</th>
</tr>
</thead>
</table>

### A.3 Disclaimer: Links to IBM Documentation

By following links to IBM Documentation you are leaving the SAP product documentation and entering a site that is not hosted by SAP. By using the link, YOU AGREE that unless expressly stated otherwise in your agreements with SAP you are about to access an external webpage which is not part of SAP’s offering:

(i) the content of the linked-to site and any further external site is not product documentation and you may not infer any product documentation claims against SAP based on this information;

(ii) the fact that SAP provides links to external sites does not imply that SAP agrees or disagrees with the contents and information provided on such sites. SAP does not guarantee the correctness of the information provided.

(iii) SAP DOES NOT GIVE ANY REPRESENTATION REGARDING THE QUALITY, SAFETY, SUITABILITY, ACCURACY OR RELIABILITY OF ANY EXTERNAL WEBPAGE OR ANY OF INFORMATION, CONTENT AND MATERIALS PROVIDED THEREON;

(iv) YOU VISIT THOSE EXTERNAL WEBPAGES ENTIRELY AT YOUR OWN RISK. SAP SHALL NOT BE DIRECTLY OR INDIRECTLY RESPONSIBLE OR LIABLE FOR ANY DAMAGE OR LOSS CAUSED OR ALLEGED TO BE
CAUSED BY OR IN CONNECTION WITH YOUR USE OF OR RELIANCE ON ANY CONTENT, GOODS OR SERVICES AVAILABLE ON OR THROUGH ANY SUCH LINKED WEBPAGE.
Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.

About the icons:

- Links with the icon 🌐: You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your agreements with SAP) to this:
  - The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
  - SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any damages caused by the use of such content unless damages have been caused by SAP’s gross negligence or willful misconduct.
- Links with the icon 🚫: You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this information.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of example code unless damages have been caused by SAP’s gross negligence or willful misconduct.

Gender-Related Language

We try not to use gender-specific word forms and formulations. As appropriate for context and readability, SAP may use masculine word forms to refer to all genders.